# Contents

**Part I Quickstart** .............................................................................................7

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Introduction</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>About this manual</td>
<td>9</td>
</tr>
<tr>
<td>1.2</td>
<td>System support</td>
<td>9</td>
</tr>
<tr>
<td>1.3</td>
<td>Conventions</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 2</th>
<th>Quickstart</th>
<th>13</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>Plotting in TOPSPIN</td>
<td>13</td>
</tr>
<tr>
<td>2.2</td>
<td>Plotting the active TOPSPIN data window</td>
<td>16</td>
</tr>
<tr>
<td>2.3</td>
<td>Interactive plotting using layouts</td>
<td>19</td>
</tr>
<tr>
<td>2.4</td>
<td>Handling datasets and portfolios</td>
<td>38</td>
</tr>
<tr>
<td>2.5</td>
<td>Plotting in automation using layouts</td>
<td>40</td>
</tr>
<tr>
<td>2.6</td>
<td>Import/Export</td>
<td>46</td>
</tr>
<tr>
<td>2.7</td>
<td>Setting the target printer</td>
<td>48</td>
</tr>
<tr>
<td>2.8</td>
<td>Creating PDF and other file formats out of TOPSPIN main window</td>
<td>48</td>
</tr>
</tbody>
</table>

**Part II Reference** ..........................................................................................51

<table>
<thead>
<tr>
<th>Chapter 3</th>
<th>The Plot Editor</th>
<th>53</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>Introduction</td>
<td>53</td>
</tr>
<tr>
<td>3.2</td>
<td>Starting the Plot Editor</td>
<td>54</td>
</tr>
<tr>
<td>3.3</td>
<td>The Plot Editor interface</td>
<td>60</td>
</tr>
<tr>
<td>3.4</td>
<td>The Menu Bar</td>
<td>67</td>
</tr>
<tr>
<td>3.5</td>
<td>The popup menu</td>
<td>74</td>
</tr>
<tr>
<td>3.6</td>
<td>Setting the target printer</td>
<td>77</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 4</th>
<th>Datasets/Portfolios</th>
<th>79</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.1</td>
<td>Dataset structure</td>
<td>79</td>
</tr>
<tr>
<td>4.2</td>
<td>Dataset handling</td>
<td>80</td>
</tr>
<tr>
<td>4.3</td>
<td>Portfolios</td>
<td>81</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 5</th>
<th>Handling Objects</th>
<th>93</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1</td>
<td>Marking/unmarking objects</td>
<td>93</td>
</tr>
<tr>
<td>5.2</td>
<td>Deleting objects</td>
<td>95</td>
</tr>
<tr>
<td>5.3</td>
<td>Copying/Duplicating objects</td>
<td>95</td>
</tr>
<tr>
<td>5.4</td>
<td>Manipulating objects</td>
<td>96</td>
</tr>
<tr>
<td>5.5</td>
<td>Creating new objects</td>
<td>100</td>
</tr>
<tr>
<td>5.6</td>
<td>Setting Object Attributes</td>
<td>101</td>
</tr>
<tr>
<td>5.7</td>
<td>Display functions of NMR spectrum objects (1D/2D-Edit)</td>
<td>104</td>
</tr>
<tr>
<td>5.8</td>
<td>Edit NMR and Standard object properties</td>
<td>109</td>
</tr>
<tr>
<td>5.9</td>
<td>Reset Actions of NMR Spectrum objects</td>
<td>129</td>
</tr>
<tr>
<td>5.10</td>
<td>Axis tick settings of NMR Spectrum objects</td>
<td>130</td>
</tr>
<tr>
<td>Chapter</td>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>6</td>
<td>Handling Layouts</td>
<td>131</td>
</tr>
<tr>
<td>6.1</td>
<td>Selecting a layout</td>
<td>131</td>
</tr>
<tr>
<td>6.2</td>
<td>Layout Storage Directories</td>
<td>132</td>
</tr>
<tr>
<td>6.3</td>
<td>Using predefined layouts</td>
<td>135</td>
</tr>
<tr>
<td>6.4</td>
<td>Saving modified layouts</td>
<td>136</td>
</tr>
<tr>
<td>6.5</td>
<td>Creating New Layouts</td>
<td>138</td>
</tr>
<tr>
<td>6.6</td>
<td>Modify an existing layout</td>
<td>141</td>
</tr>
<tr>
<td>6.7</td>
<td>Printing the current layout</td>
<td>141</td>
</tr>
<tr>
<td>6.8</td>
<td>Exporting the current layout</td>
<td>142</td>
</tr>
<tr>
<td>7</td>
<td>Plotting in Automation</td>
<td>143</td>
</tr>
<tr>
<td>7.1</td>
<td>ICON-NMR automation flow</td>
<td>143</td>
</tr>
<tr>
<td>7.2</td>
<td>User defined layouts in automation</td>
<td>146</td>
</tr>
<tr>
<td>7.3</td>
<td>AU macros for plotting</td>
<td>148</td>
</tr>
<tr>
<td>7.4</td>
<td>Plotting from AU programs</td>
<td>149</td>
</tr>
<tr>
<td>7.5</td>
<td>Plotting from AU programs to Postscript or PDF</td>
<td>151</td>
</tr>
<tr>
<td>7.6</td>
<td>Preventing an AU program from plotting</td>
<td>152</td>
</tr>
<tr>
<td>7.7</td>
<td>Setting the target printer</td>
<td>152</td>
</tr>
<tr>
<td>7.8</td>
<td>Printing individually scaled integral regions (plotx)</td>
<td>153</td>
</tr>
<tr>
<td>7.9</td>
<td>Creating layouts from AU programs</td>
<td>155</td>
</tr>
<tr>
<td>8</td>
<td>Reset Actions</td>
<td>159</td>
</tr>
<tr>
<td>8.1</td>
<td>What are Reset Actions</td>
<td>159</td>
</tr>
<tr>
<td>8.2</td>
<td>Reset actions on 1D spectra</td>
<td>160</td>
</tr>
<tr>
<td>8.3</td>
<td>Performing Reset actions</td>
<td>168</td>
</tr>
<tr>
<td>8.4</td>
<td>Reset actions on stacked plots</td>
<td>169</td>
</tr>
<tr>
<td>8.5</td>
<td>Reset actions on 2D spectra</td>
<td>171</td>
</tr>
<tr>
<td>8.6</td>
<td>Reset actions on FIDs</td>
<td>172</td>
</tr>
<tr>
<td>8.7</td>
<td>Reset actions on T1/T2 objects</td>
<td>173</td>
</tr>
<tr>
<td>9</td>
<td>Preparations</td>
<td>175</td>
</tr>
<tr>
<td>9.1</td>
<td>1D data</td>
<td>175</td>
</tr>
<tr>
<td>9.2</td>
<td>2D data</td>
<td>177</td>
</tr>
<tr>
<td>10</td>
<td>Import/Export Graphics</td>
<td>179</td>
</tr>
<tr>
<td>10.1</td>
<td>Importing graphics</td>
<td>179</td>
</tr>
<tr>
<td>10.2</td>
<td>Exporting Graphics under Windows</td>
<td>185</td>
</tr>
<tr>
<td>11</td>
<td>Plot Editor under Linux</td>
<td>191</td>
</tr>
<tr>
<td>11.1</td>
<td>The menu Window does not exist</td>
<td>191</td>
</tr>
<tr>
<td>11.2</td>
<td>Edit dialogs under Linux</td>
<td>191</td>
</tr>
<tr>
<td>11.3</td>
<td>Global Setup</td>
<td>193</td>
</tr>
<tr>
<td>11.4</td>
<td>Printer Setup</td>
<td>194</td>
</tr>
<tr>
<td>11.5</td>
<td>Standard EPSI object</td>
<td>197</td>
</tr>
<tr>
<td>11.6</td>
<td>Miscellaneous</td>
<td>198</td>
</tr>
<tr>
<td>Part III</td>
<td>Questions and Answers</td>
<td>199</td>
</tr>
<tr>
<td>12</td>
<td>Questions and Answers</td>
<td>201</td>
</tr>
<tr>
<td>12.1</td>
<td>Questions about the Plot Interface</td>
<td>201</td>
</tr>
<tr>
<td>Chapter 13</td>
<td>Appendix A</td>
<td>215</td>
</tr>
<tr>
<td>-----------</td>
<td>------------</td>
<td>-----</td>
</tr>
<tr>
<td>Chapter 14</td>
<td>Appendix B</td>
<td>217</td>
</tr>
<tr>
<td>12.2</td>
<td>Questions about plot procedures</td>
<td>206</td>
</tr>
<tr>
<td>13.1</td>
<td>Shortcuts</td>
<td>215</td>
</tr>
<tr>
<td>14.1</td>
<td>Plot command list</td>
<td>217</td>
</tr>
<tr>
<td>14.2</td>
<td>Command line arguments for plot</td>
<td>218</td>
</tr>
<tr>
<td>14.3</td>
<td>Command line arguments for autoplot</td>
<td>219</td>
</tr>
<tr>
<td>14.4</td>
<td>Parameters used for plotting</td>
<td>221</td>
</tr>
</tbody>
</table>
Part I
Quickstart
Chapter 1

Introduction

1.1 About this manual

This manual is a guide for TOPSPIN plotting and printing. It describes the complete TOPSPIN print/plot functionality, both interactive and automated.

This manual consists of three parts:

- Part I: Quickstart
  Gives an overview of plotting in Topspin in general and the Plot Editor in particular.

- Part II: Plot Editor Reference
  Describes the entire Plot Editor in detail.

- Part III: Questions & Answers
  Describes frequently used plotting procedures.

1.2 System support

TOPSPIN runs on Windows and Linux systems. The elements involved in plotting like datasets, portfolios and plot layouts are interchangeable between the two platforms. The description and screenshots in this docu-
mentation are taken on a Windows computer. Differences in interface and functionality between Windows and Linux are described in Chapter 11.

Note, that imported WMF graphics in a layout created under Windows, will not be displayed or printed on Linux systems. Vice versa, imported EPSI graphics, in a layout created under Linux, will not be displayed or printed on Windows systems.

1.3 Conventions

Font conventions

Various font styles are used to represent different types of information.

- **plot** - TOPSPIN command line commands are in courier bold italic
- **Zoom in** - menus or buttons to be clicked in the TOPSPIN window or the Plot Editor window are in times bold italic
- **Curve** - Dialog sections are in times bold
- **layout.xwp** - filenames are in courier
- **name** - any name which is not a filename is in times italic

File/directory conventions

- **<tshome>**
  the TOPSPIN home directory (default C:\Bruker\topspin\) under English Windows XP and /opt/topspin under Linux

- **<userhome>**
  the user home directory (default C:\Documents and Settings\<username> under English Windows XP and /home/<username> under Linux)

- **<dir>/data/<user>/nmr/<name>/<expno>/pdata/<procno>**
  data directory where:
  - **<dir>** = top level data directory

1) If C is the default drive.
<user> = user part of the data directory

<name> = data name: name part of the data directory

<expno> = data experiment number: expno part of the data directory

<procno> = data processing number: procno part of the data directory
2.1 Plotting in TOPSPIN

Plotting/printing in TOPSPIN starts, as in most other applications, by clicking the menu:

+ *File → Print [Ctrl+p]*

which is equivalent to entering `print` on the command line.

This will open the dialog shown in Figure 2.1, which shows you the 3 basic methods for printing NMR data in TOPSPIN.

These methods (Options) are:

- *Print active window [prnt]*

This option will print the current dataset as you see it in the TOPSPIN data window, including the displayed region, intensity scaling and displayed components like *title, parameters, integrals, peak labels* etc. The *Required parameters* section of the dialog is disabled, no plot layout are used and you will be prompted for the target printer.
• **Print with layout - start Plot Editor [plot]**

This option will start the Plot Editor, the interactive program for viewing or designing plot layouts. The current dataset is displayed, according to the *LAYOUT, Plot Limits, Dataset List* and *Plotter* set in the **Required Parameters** section.

• **Print with layout - plot directly [autoplot]**

This option will print the data, according to the *LAYOUT, Plot Limits, Dataset List* and *Plotter* set in the **Required Parameters** section.

The first option (command `print`) is the simplest way to plot your data. It is useful for plotting a single dataset as you see it on the screen. This option is further described in paragraph 2.2.

The second option (command `plot`) is interesting for using or designing more sophisticated plots. It allows you to create Plot Editor layouts in which you can freely add, delete and manipulate *Standard* and *NMR* graphical objects.
The third option (command *autoplot*) is mainly used in automation. It uses predefined Plot Editor layouts, which can be standard Bruker layouts or user defined layouts.

All three commands can be entered on the command line:

- to *plot* the current dataset as you see it on the screen:
  
  enter `prnt`

- to *preview* the current plot layout or *create* a new plot layout:
  
  enter `plot`

- to *plot* the current dataset according to the current plot layout:
  
  enter `autoplot`

When entered without arguments:

- *plot* will use the plot limits from the screen

- *autoplot* will set the plot limits according to the automation reset actions

Both commands will use the layout defined by the processing parameter LAYOUT. This parameter can be set by entering `layout` on the command line. Note that the layout can be specified as a full pathname or by using one of the following abbreviations (see also Figure 2.1):

- `+` : the standard layout directory `<tshome>/plot/layouts/`

- `~` : the user home directory

- `#` : current processed data directory (PROCNO)

Note that the LAYOUT parameter can specify multiple layouts, separated by semicolons, e.g.:

```
+/1D_H.xwp;+/1D_H+int.xwp
```

This feature is especially used in automation.

The behavior of *plot* and *autoplot* can be manipulated with command line arguments. For example:

---

1) Because it is mainly used in automation.

2) *autoplot* prints all layouts specified in LAYOUT, whereas *plot* only opens the first layout.
**autoplot -f -c -i**

will print the dataset(s) in the default portfolio (-i), on the printer defined by CURPLOT (-c), using the plot limits from screen (-f).

The command line arguments are displayed at the top of the print dialog (see Figure 2.2). Just enter `print`, try out different Required Parameter settings and look at the corresponding command and arguments.

![Print dialog](image)

**Figure 2.2**

The main part of this manual consists of a detailed description of the second and third option, the interactive and automated part of the Plot Editor, respectively.

### 2.2 Plotting the active TOPSPIN data window

The easiest way to plot a dataset is to print the current TOPSPIN data window. To do that:

+ enter `prnt` on the command line

select the Printer and Paper Size and Orientation as requested and click OK.
The current dataset will be plotted exactly as you see it on the screen, including:

- the selected region and intensity scaling
- displayed components on the screen like title, integrals, peaks labels etc.
- multiple display (if the data window is in this mode)
- display of overview spectrum (if switched on). See Figure 2.3.
As such, you must set up the TOPSPIN data window according to your needs, before you start printing. Exercise 1 is an example of how to do that.
Exercise 1

1. Open a 1D dataset.

2. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.

3. Adjust the vertical scaling. To do that click-hold the button of the toolbar and move the mouse.

4. Display the desired dataset components like title, parameters, integrals etc. To do that right-click in the data window, choose Spectra Display Preferences, enable the desired components and click OK.

5. Enter prnt on the command line, choose the printer from the appearing dialog, click OK, select the paper size and orientation and click OK.

The spectrum will be plotted and should be an exact representation of the data window.

The command prnt can be used for data of every processing status and data dimensionality, e.g. it can be used for raw or processed 1D, 2D and 3D data. Note that the command prnt can also be started from the print dialog, which is opened by Ctrl+p or print.

2.3 Interactive plotting using layouts

Whereas the command prnt can be used for simply printing the current data window, the command plot is far more versatile. It opens the Plot Editor, an interactive object-oriented editor in which you can preview, modify or create sophisticated plot layouts. This allows you to determine the exact size and position of the plot components, add graphics, plot multiple spectra on one paper and many other things.

Plot Editor can basically be used to:

- preview the current plot layout before plotting
- modify an existing layout to your needs
- create a new layout from scratch

This is described in the paragraphs below.
There are two possibilities to use the comfort of the Plot Editor:

The quick and easy way is to click the Plot tab of the data window. The plot window will be opened and display the current dataset formatted with the layout that has been set by the parameter LAYOUT. It is possible to choose existing layouts if necessary but changes within the layouts are not allowed. (see Chapter 2.3.1 ff)

To modify existing layout or create new ones it is necessary to use the Plot Editor itself. With this program the layouts are fully editable and it is much more comprehensive. (see Chapter 2.3.2 ff)

### 2.3.1 Plotting from the plot window of the active data window

By clicking on the Plot tab the plot window will be displayed. It contains its own button bar and shows the current spectrum of the data window formatted with the layout that has been set by the parameter LAYOUT. The name of the active layout is shown to the right of the button bar of this window.

According to the selected layout the spectrum is displayed with parameter, title etc. In contrary to the Plot Editor here only some changes concerning spectrum appearance are possible.

The following icons of the icon bar from the TOPSPIN main window are also active in the plot window:

- Larger by factor 8
- Smaller by factor 8
- Larger by factor 2
- Smaller by factor 2
- Smaller/larger (drag mouse)
- Reset intensity scale
- Smooth zoom (drag mouse)
- Zoom in
- Zoom out
- Show last zoom
• show full spectrum, leave intensity scale
• show full spectrum, reset intensity scale
• shift to left end of spectrum
• shift to right end of spectrum
• shift spectrum left
• shift spectrum right
• shift spectrum left and right while pressing left mouse button

With these icons the appearance of the spectrum can be adjusted directly in the plot window if necessary or desired.

The button bar of the plot window contains the following buttons:

• The first one opens a window showing information about the layout, data set, target printer, paper size and the data set list.
• The second button opens the layout dialog (see also Figure 2.7) in Chapter 2.3.2). Here it is possible to choose one of the predefined plot layout files. The current layout is also shown at the end of the button bar.
• The third button toggles on/off the limits/scalings by automation settings. If it is applied, the button is orange coloured, otherwise it is light blue.
• The fourth button toggles the ‘use multiple display information’ on/off. Again it is orange coloured when it is applied.
• The last button allows to open the plot editor and modify the layout as described in chapter 2.3.2 ff.
• Next to this last button the name of the current layout in use is shown.

To print a spectrum type `prnt` in the command line or click the print button from the main menu bar of TOPSPIN. The following popup window is dis-
played:

![Print dialog box](image)

**Figure 2.4**

After selecting a suitable printer click OK. A printout exactly like it is displayed on the screen is archived.

### 2.3.1.1 The layout in the plot window

When entering the plot window by clicking on the Plot tab of the data window, the parameter LAYOUT for the current data set is read and the current spectrum is displayed with these values.

A certain layout can be chosen by typing `layout` in the command line of the TOPSPIN data window. The chosen layout will be maintained in the plot window.

Clicking the second button in the button bar opens the same layout window and a different layout can be chosen if necessary.

### 2.3.1.2 The ‘Auto’ button of the Plot window

The ‘Auto’ button toggles the limits/scaling mode. By default the plot limits
and scalings can be modified interactively. If enabled, automation settings are used instead, no interactive changes are possible then.

For example it allows to plot a certain part of a spectrum, a low-field plot layout or just a specific part to zoom in, together with the whole spectrum.

**Exercise 2**

- Open a 1D dataset
- Adjust the vertical scaling. To do that click-hold the button of the toolbar and move the mouse.
- Type layout in the command line and check if the plot layout is suitable for this spectrum type (for example +/1D_H.xwp for a proton spectrum)
- Select the part of the spectrum you want to zoom by click-hold in the data window and drag the cursor line along the desired region.
- Type layout in the command line and select +/1D_H+zoom.xwp
- Click the Plot tab to switch to the plot window. The selected part of the spectrum you want to zoom in is displayed in two separated fields with axis.
- Now click the ‘Auto’ button. The now orange color of the button indicates that ‘Auto’ is toggled on. In the lower spectrum now the whole one is displayed. The upper one shows the region selected to zoom in (see Figure 2.5)
Figure 2.5

If the spectrum regions to be plotted are well prepared this is a fast way to plot several regions of a spectrum without using the plot editor.

Besides zooming out parts of the spectrum, it is the easiest way to plot parts of a spectrum which are far away from the rest of the spectrum (for example strong down shifted parts of a 13C spectrum)

2.3.1.3 The ‘Use multiple display information’ button of the Plot window

Data sets selected in the multiple display mode can be conveniently plotted using plot layouts. By clicking the button in the plot window this can be achieved. The multiple display must be prepared in the TOPSPIN main window as usually.

Exercise 3

- Open a 1D dataset, for example 1H Proton data set
• Switch to the multiple display window by clicking the button of the toolbar
• Select the additional data sets
• Select a certain spectral region. To do so, click-hold in the data window and drag the cursor line along the desired region.
• Leave the multiple display window by clicking the ‘return’ button of the toolbar
• Switch from the data window to the plot window by clicking the ‘Plot’ tab. The first of the selected spectra will be displayed with the standard layout +/1D_H.xwp.
• Click the button of the toolbar. It will change its colour to orange to indicate that the ‘use multiple display information’ is toggled on. In the toolbar the chosen layout changes to +layouts.multidisp/1D_3.xwp (3 spectra are loaded in the example) and the spectra are displayed as they were prepared before (see Figure 2.5)
The layouts are automatically chosen from a range of layouts that have been prepared by Bruker.

Another more flexible and more advanced way to prepare such a plot is to open the Plot Editor and compose a layout manually.

Please note that, for your convenience, you could click the ‘Open Plot Editor’ button just now (see next paragraph). The currently used layout is fully editable here and can be changed to your needs.

2.3.1.4 The ‘Open Plot Editor and modify layout’ button of the Plot window

Clicking the last button of the toolbar in the plot window, the button, opens the Plot Editor. The data set and its layout shown in the plot window are now displayed in the Plot Editor. The layout is now fully editable and can be modified.

More detailed descriptions and examples can be found in the next paragraphs (Chapter 2.3.2 ff).

2.3.2 Preview and plot

The simplest way to use the interactive Plot Editor is to preview the plot of the current dataset and then print it. The exercise below is an example of this.

Exercise 4

1. Start TOPSPIN and open the dataset exam1d_1H/1/1.

2. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.

3. Enter layout on the command line. In the appearing dialog, select the standard layout 1D_H.xwp (if it is not already selected, see Fig-
4. Enter `plot`. The Plot Editor interface will appear, showing the selected spectral region according to the layout 1D_H.xwp (see Figure 2.8).

5. In the Plot Editor interface ¹):
   a) Click `File` → `Print` ([Ctrl]+[p]) (see Figure 2.9), select the desired printer in the appearing dialog and click `Print`.

¹) Not the TOPSPIN interface
The plot on the paper should be the same as the white area in the Plot Editor interface.

b) Click File ’ Exit to leave the Plot Editor.

Note that the chosen plot layout (1D_H.xwp) does not show the peak labels. To include the peak labels, repeat the above exercise, choosing the layout 1D_H+pp.xwp.

In this paragraph, we simply took the chosen layout as it is, and used the Plot Editor to preview and print the data. In the next paragraph we will see how to modify a layout and then print it.

2.3.3 Modify a layout and print it

In this paragraph we will have a closer look at a plot layout, make a few basic modifications and then print it.

Exercise 5

1. Start TOPSPIN and open the dataset exam1d_1H/1/1.
2. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.
3. Enter layout on the command line. In the appearing dialog, select the standard layout 1D_H.xwp (if it is not already selected).
4. Enter plot. The Plot Editor interface will appear, showing the dataset according to the layout 1D_H.xwp (see Figure 2.10).

This layout contains 4 objects:

- a Spectrum object at the lower left
- a Parameters object at the right (marked in Figure 2.10)
- a Title object at the upper left
5. Just move the blue crosshair cursor around in the layout window and see how each object is surrounded by a bounding box when the cursor is inside of it (in Figure 2.10 this is the Spectrum object).

![Figure 2.10](image)

6. Now let’s perform some basic operations with these objects:

- **Mark an object:**
  Click the *Mark Complete* button:

  ![Mark Complete button](image)

  at the upper left of the Plot Editor interface, then click the object. The object will be surrounded by green markers (see the *Parameters* object in Figure 2.10).

- **Move an object:**
  Click-hold the object, move the mouse and release it at the desired position.

- **Resize an object:**
  Mark the object (see above), click-hold one of the green markers, move the mouse and release it when the desired size has been reached.
• **Delete an object**
Mark the object (see above) and click the **Delete** button in the command bar or press the **Delete** key on the keyboard.

• **Undo last operation(s)**
Click the button **Undo** at the right of the command bar or press **Ctrl+z**. Repeat this action if you want to undo multiple operations.

In the step 6 we have performed some operations on an object as a whole. In the next steps we will take a more detailed look into an NMR object, like a *Spectrum*, *Parameters* or *Title* object and modify aspects of it.

7. First we’ll expand the spectrum and play around the expanded area.
   a) Click the following icon:

   ![Expand Icon]
   to switch to expansion mode (see how the **Mode** field at the left of the Plot Editor interface is updated).

   b) Click-hold in the **Spectrum** object, drag the cursor to create a box around the desired spectral area and release the mouse. See how the chosen area is expanded.

   c) Click the **Undo** button in the command bar to undo the expansion.

Note that the **Expand** icon is only applicable to *Spectrum* or *FID* objects, whereas the **Zoom** icon applies to the entire layout area. A spectrum can also be expanded from the 1D/2D-Edit or Edit dialog (see step 8 and 9).

8. Right-click in the **Spectrum** object and choose **1D/2D-Edit** from the popup menu. This will open the dialog shown in Figure 2.11. In the upper part of this dialog, you can set the **Scope** of dialog functions, *Spectrum*, *Integral* or both.

   a) Use the icons in the upper part of the dialog to move or expand the spectrum. Note that some icons must be clicked to perform the corresponding action, whereas for other icons you have to click-hold and move the mouse. Observe the effect of each action on the **Spectrum** object.

   b) Click the various check buttons in the middle part of the dialog to select/deselect *axes*, *grids*, *peaks* and/or *integrals*. Observe the effect of each action on the **Spectrum** object.
c) Click *Close* to close the dialog.

![Edit Display Object dialog](image)

**Figure 2.11**

9. Right-click in the *Spectrum* object and choose *Edit* from the popup menu. This will open the dialog shown in Figure 2.12. At the top of the dialog you see several tabs with the *Graph* tab selected. Each tab
gives access to the corresponding dialog pane.

![Figure 2.12](image1.png)

a) Expand the spectrum by entering the exact limits of a certain spectral region, in the fields Xmin/Xmax of the Plot section of the dialog.

b) Click OK to store the changes and close the Edit dialog.

Note that the Edit dialog allows you to set various other things, like axis units, peak and integral labels (1D Spectrum pane), the dataset (Dataset pane) and the object position and dimension (Basic pane).

Whereas in the previous steps, we worked with the Spectrum object of the plot layout, we will now go to the Parameters object, which is a text object.

10. Right-click in the Parameters object of the layout and choose Edit from the popup menu. This will open the dialog shown in Figure 2.13. As you see the Text pane is selected.

![Figure 2.13](image2.png)

a) Click the Edit... button in the Text section. A text editor will appear showing the list of parameters. Just add, delete or modify any parameters you wish¹. Click the Close button to store the changes and close the dialog.
Quickstart

b) Select the Basic pane. The dialog will now show the object position and dimension (see Figure 2.14). Enter the desired X and Y position and dimension of the object in, cm, relative to the plot area origin (the lower left corner of the gray dashed box).

![Figure 2.14](image)

c) Click OK to store the changes and close the Edit dialog.

Note that the Edit dialog offers different tabs for different objects. All objects, however, NMR and Standard, offer the tab Basic and all NMR objects offer the tab Data Set.

u Click Undo (repeatedly) to undo any undesired changes in the layout.

Now let’s plot the layout that we have opened and modified.

11. Click File ’ Print [Ctrl+p] to print the layout. The printout on paper should be exactly the same as the white area in the layout area.

12. Now save the new layout for later usage: click File ’ Save As... enter a filename and click Save.

13. Click File ’ Exit to leave the Plot Editor.

In this paragraph we have opened, modified, printed an existing 1D layout, and stored it under a new name. In the next paragraph, we will not use an existing layout but create a new one from scratch.

1) Note that function of the Plot Editor is to display/plot datasets, not to modify them. This means changes in parameters are not transferred to the TOPSPIN data window nor are they stored in the layout or dataset. The original parameters are restored if you update the data from the dataset (menu TOPSPIN).
2.3.4 Create a new layout

In this paragraph we will create a new Plot Editor layout from scratch. We’ll start with an blank layout area, insert NMR and Standard objects and, finally, print the layout.

Exercise 6

1. Start TOPSPIN and open the dataset exam1d_1H/1/1.
2. Enter plot. The Plot Editor interface will appear, showing whatever layout is defined by the parameter LAYOUT.
3. Click File ’ New
   A new empty layout will appear.  
4. Enable radio button NMR at the left of the Plot Editor interface (if it is not already enabled, see Figure 2.15).

[Figure 2.15]

Now we’ll start filling the layout with objects using the icons at the left of the Plot Editor interface.

5. Click the 1D Spectrum icon:
   Place the cursor in the layout area at the desired position. Click-hold and move the mouse to draw the Spectrum object and release the mouse.

6. Click the Title icon:
   Place the cursor in the layout area at the desired position and click the mouse to create the Title object.

7. Click the Parameters icon:

1) Note that the original layout is, under a Windows operating system, still available under the Window menu. Under Linux, the original layout is replaced by the new layout.
Place the cursor in the layout area at the desired position and click the mouse to create the *Parameters* object.

8. Enable the radio button *Standard* at the left of the Plot Editor interface (if it is not already enabled, see Figure 2.15).

9. Click the *Circle* icon:

   Place the cursor in the layout area at the desired position. Click-hold and move the mouse to draw the *circle* object and release the mouse.

10. Click *File* ‘*Print*’ [*Ctrl+P*] to print the layout. The printout on paper should be exactly the same as the white area in the layout area.

11. Now save the new layout for later usage: click *File* ‘*Save As*...’, enter a filename with the extension *.xwp* and click *Save*.

12. Click *File* ‘*Exit*’ to leave the Plot Editor.

### 2.3.5 2D Data

The interactive creation of a 2D plot is basically the same as the creation of a 1D plot. The Plot Editor uses the Topspin data window plot limits and contour levels.

**Exercise 7**

1. Start TOPSPIN and open the 2D dataset exam2d_HH/1/1.

2. Select a certain spectral region. To do that, click-hold in the data window and drag the mouse to draw a box around the desired region.

3. Adjust the contour levels. To do that click-hold the button and move the mouse. Click the button to save the contour levels.

4. Click the toolbar button to display the projections (if these are not displayed yet).

5. Right-click in the data window, inside the F1-projection area, choose *External Projection* from the popup and specify the dataset exam1d_1H/1/1 as external projection. Repeat this action for the F2-projection area.

6. Enter *layout* on the command line. In the appearing dialog, select the standard layout 2D_inv.xwp (if it is not already selected).
7. Enter `plot`. The Plot Editor interface will appear, showing the layout 2D_inv.xwp with four objects (see Figure 2.16).

As you see, the 2D `Spectrum` object is displayed with one projection only, the horizontal one at the top. As a first step to modify the plot layout, we’ll add the vertical projection at the left.

8. Right-click in the 2D `Spectrum` object and choose `Edit` from the popup.
In the appearing dialog (see Figure 2.17):

![Figure 2.17](image)

a) Click the **2D projections** tab.

b) In the section **Data Sets**, select the entry **Left** and click the **Select...** button to the right of this entry. This will open the Data Set Selector.

c) In the Data Set Selector: click the 1D dataset to be used as vertical projection.

d) Click **OK** to close the Data Set Selector and click **OK** to close the **Edit** dialog.

9. Resize the 2D Spectrum object such that the left projection fits within the plot area, (the gray dashed bounding box).

Note this was just an exercise. The result, a layout with a 2D Spectrum object with 2 projections, is available as the standard layout 2D_hom.xwp.

Now let’s expand the spectrum and play around with the expanded area.

10. Click the **Expand** icon at the upper left of the Plot Editor interface:

    ![Expand](image)

    click-hold in the 2D Spectrum object and drag the mouse to create a box around the desired spectral area.

11. Right-click in the 2D Spectrum object and choose **1D/2D-Edit**. Try out the various display toggles and buttons in the appearing dialog. For example:

    a) Click-hold the following button:
and move the mouse up/down and left/right to shift the expanded area.

b) Click-hold the following button:

and move the mouse to change the contour levels.

c) Click Close to close the 1D/2D-Edit dialog.

12. Click File \textasciitilde Print [Ctrl+p] to print the layout. The printout on paper should be exactly the same as the white area in the layout area.

13. Now save the new layout for later usage: click File \textasciitilde Save As..., enter a filename with the extension \texttt{xwp} and click Save.

14. Click File \textasciitilde Exit to leave the Plot Editor.

### 2.4 Handling datasets and portfolios

Plot Editor organizes NMR data in datasets and organizes datasets in portfolios. A Portfolio consists of a list of available data directories and a list of selected datasets, in those directories. The dataset list is also called the Data Set Selector. The following exercise allows you to familiarize yourself with the main aspects of the Portfolio and Data Set Selector.

**Exercise 8**

1. Start Topspin and open the dataset exam1d_1H/1/1.

2. Enter \texttt{wrp 2, wrp 3 and wrp 4} to copy the data to PROCNO’s 2, 3 and 4.

3. Enter \texttt{nm} to negate dataset exam1d_1H/1/1 (just to be able to distinguish it from PROCNO 2,3 and 4)

4. Enter \texttt{edc2} and specify procno 2 and 3 as the second and third dataset, respectively.

5. Enter \texttt{layout} on the command line. In the appearing dialog, select the standard layout 1D+1D+1D.xwp.

6. Enter \texttt{plot}. The Plot Editor interface will appear, showing three 1D Spectrum objects above each other.
Quickstart

7. Move the cursor through the three 1D \textit{Spectrum} objects and look at the status line to see which object holds which dataset.

\begin{itemize}
\item Each object holds a number that refers to a position in the Data Set Selector
\end{itemize}

8. Click the \textit{Data} button of the command bar to open the Data Set selector (see Figure 2.18).

\begin{itemize}
\item The current dataset fills/replaces entry 1 in the Data Set Selector
\item The 2\textsuperscript{nd}/3\textsuperscript{rd} dataset (if defined) fill/replace entry 2/3 in the Data Set Selector
\end{itemize}

9. Click \textit{Edit} in the Data Set Selector dialog to open the Portfolio Editor.

![Figure 2.18](image)

10. In the Portfolio Editor:
\begin{itemize}
\item a) Select dataset exam1d\_1H\_1\_4, click \textit{Append} to add it to the Portfolio field.
\item b) Click \textit{File} ‘\textit{Save as…}, enter a filename in the appearing dialog and click \textit{Save} to store the portfolio.
\end{itemize}

11. Click \textit{Apply} to load the Portfolio list to the Data Set Selector.

\textit{Note that the Data Set Selector now contains at least 4 dataset entries.}
12. Mark the lower *Spectrum* object, click the entry of dataset exam1d_1H/1/4 in the Data Set Selector and click *Set*.

13. Move the cursor through the tree *Spectrum* objects and see how the dataset in the lower object has been replaced by exam1d_1H/1/4.

14. Click *File* ’ *Save Layout/Portfolio To Dataset*.

15. Click *File* ’ *Exit* to leave the Plot Editor.

*In step 14, both the current layout and portfolio are saved in the current dataset PROCNO 1).*

16. In TOPSPIN window, right-click in the data window and choose *Files..* from the popup menu.

17. Select the file Portfolio.por and click *Open* to see the contents of the file.

Note that during startup, *plot* first loads the default portfolio and then replaces this with the portfolio in the current dataset PROCNO (if it exists). The latter allows you to have all required information available to reproduce the same plot later.

### 2.5 Plotting in automation using layouts

NMR data are often acquired, processed and plotted in automation, with AU programs or with the program Icon-nmr. Plotting in automation uses the same plot layouts and portfolios used by the interactive Plot Editor. Layouts can be standard Bruker or user-defined layouts.

#### 2.5.1 Plotting in Icon-nmr

Icon-nmr is the standard program for automated spectroscopy. It uses predefined experiments (parameter sets) to measure data of series of samples. Furthermore, it uses AU programs to acquire, process and plot these experiments. Processing and plotting are executed by the same AU program. An example of such an AU program is *proc_1d*, which is used in many 1D experiments. AU programs plot data by executing plot macros, the main one being *autoplot*. This macro executes the *autoplot* com-

1) In fact, they are stored in the dataset specified at the first entry of the Data Set Selector.
mand which plots the current dataset according to the current plot layout. The AU program and layout used for plotting are defined by the experiment parameters AUNMP and LAYOUT, respectively.

In the following exercise we’ll manually step through the processing/plotting part of ICON-NMR from the TOPSPIN command line. We’ll start with an acquired dataset containing raw data.

**Exercise 9**

1. Open the dataset exam1d_1H/1/1.

2. Enter `aunmp`. This will show you the value of the parameter AUNMP, the AU program used for processing/plotting (normally `proc_1d`). Click **Cancel** to close the dialog.

3. Enter `layout`. This will show you the value of the parameter LAYOUT, the layout that is used for plotting (normally 1D-H.xwp). Click **Cancel** to close the dialog.

4. Enter `edau proc_1d` to open the AU program. Just scroll through the text and see the processing macros like EF, APKS etc., and, at the end the plot macro, AUTOPLOT.

5. Click **File → Close** to close the AU program.

6. Enter `proc_1d` to execute this AU program.

   Watch the TOPSPIN status line to see the successive processing commands being executed. The last command is `autoplot`, as executed by the AU macro AUTOPLOT, which plots the dataset.

Note that in ICON-NMR automation, all of this is done automatically. Furthermore, ICON-NMR allows you to control plotting in the following ways:

- Disable plotting (see ICON-NMR Configuration).
- Create PDF or Postscript output in the dataset PROCNO directory, in addition to a hardcopy printout (see ICON-NMR Configuration).
- Use your own layouts with your own experiments (see ICON-NMR Setup Manual).
- Use your own layouts with Bruker Experiments, by setting the layout search path (see also paragraph 7.2)
2.5.2 Reset actions

As we saw in the previous paragraphs, interactive plotting is performed by the command `plot` and automated plotting by `autoplot` (in form of the AU macro AUTOPLOT). Both commands use a Plot Editor layouts but there is one important difference:

- `plot` uses the plot region and intensity scaling of the Topspin data window (parameters F1P/ F2P and CY) for all `Spectrum` objects in the layout 1).

- `autoplot` performs the so-called Reset Actions; a set of rules, which control the plot region, intensity scaling and baseline position of individual `Spectrum` objects.

Note that this behaviour can be manipulated with arguments: `plot -r` performs Reset Actions and `autoplot -f` does not perform Reset Actions. Furthermore, after opening the Plot Editor interface with `plot`, you can reset individual objects by right-clicking in the object and choosing `Reset Object`.

Reset actions control Expansion, Intensity scaling and Baseline offsets

Reset Actions either use or overrule experiment parameters. Let's see how this works.

**Exercise 10**

1. Open the 1D dataset exam1d_1H/1/1.
2. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.
3. Enter `layout` on the command line. In the appearing dialog, select the standard layout 1D_H+zoom.xwp.
4. Enter `autoplot` to plot the spectrum with Reset Actions.
5. Enter `autoplot -f` to plot the spectrum without Reset Actions.

The effect of the Reset Actions is clear from the difference between Figure 2.19 and Figure 2.20. The lower object in Figure 2.20 shows the full spectrum instead of the selected region, the intensity of the upper object is

1) Note that one layout can have multiple `Spectrum` objects.
To understand how this works, we will look at and perform the Reset

**Figure 2.19** Output of `autoplot -f` (no Reset Actions)

**Figure 2.20** Output of `autoplot` (Reset Actions)

To understand how this works, we will look at and perform the Reset
Actions for each object separately.

6. Enter `plot` to show to open the Plot Editor without Reset Actions. The layout looks like the output of `autoplot -f` (see Figure 2.19).

7. Right-click in the upper `Spectrum` object and choose `Automation` to look at the Reset Actions: note that `size of biggest peak` is set to 100% (see Figure 2.21). Click `OK` to close the Automation dialog.

![Figure 2.21](Image)

8. Right-click in the upper `Spectrum` object again and choose `Reset Object` to execute the Reset Actions on this object. See how the intensity is scaled down 1) (see the upper part of Figure 2.20).

9. Right-click in the lower `Spectrum` object and choose `Automation` to look at the Reset Actions: note that `Xmin/Xmax` is set to minimum/maximum (see Figure 2.21). Click `OK` to close the Automation dialog.

![Figure 2.22](Image)

10. Right-click in the lower `Spectrum` object again and choose `Reset Object` to execute the Reset Actions on this object. See how the displayed region changes to full spectrum 2) (see the lower part Figure 2.20).

Note that in this exercise only one Reset Action is considered for each object. All other Reset Actions in the `Automation` dialog are also executed but do not change the object.

---

1) Without Reset Actions, the biggest peak defaults to the value of CY.
2) Without Reset Actions Xmin/Xmax defaults to F1P/F2P
### 2.5.3 Plotting in AU programs

Plotting in an AU program is performed with the macro AUTOPLOT, which calls the command `autoplot`.

**Exercise 11**

1. Open the 1D dataset exam1d_1H/1/1.
2. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.
3. Enter `layout` on the command line. In the appearing dialog, select the standard layout 1D_H.xwp (if it is not already selected).
4. Enter `edau my_plot_au`
5. In the appearing editor, enter the following two lines:

   ```
   AUTOPLOT
   QUIT
   ```

   save and quit the editor.
6. Enter `my_plot_au`

   The AU program is compiled \(^1\) and then executed, plotting the current dataset according to the chosen layout.

Note that this is a trivial example of an AU-program, which does the same as entering the command `autoplot` ion the command line.

Bruker AU programs use the AUTOPLOT and various other macros to plot data. Please look at the AU programs `proc_1d` or `proc_2dinv` for more examples.

### 2.6 Import/Export

**PLOT EDITOR** supports full import and export of graphics. Graphics can be imported into the Plot Editor in certain graphic formats (PNG, MOL, EMF/WMF, EPSI). Graphics can be exported to graphics formats such as EMF, PS, PNG, PDF etc. and to the Clipboard. Export can be performed, interactively, from the Plot Editor interface or, automatically, from the command line or from an AU program.

\(^1\) An AU program is automatically compiled on first usage.
2.6.1 Importing graphics and text

Graphics can be imported as a reference to an external graphics file or as an internal graphics object. In the first case, you need to create a graphics file object in your layout. Then double-click the object, to open the Edit dialog, and browse for the graphics file which needs to be in either PNG, MOL, WMF/EMF (Windows only), or EPSI (Linux only) format. In the second case, you first have to open the graphics file (with any graphics program), copy it to the clipboard and then paste it to the Plot Editor.

2.6.2 Importing text

To import text from a text file to a plot layout, you have to create an NMR Text object. Then double-click the object to open the Edit dialog and browse for the text file. Alternatively, you can import text by copying it from any application to the clipboard and then paste it to the Plot Editor.

2.6.3 Exporting Graphics under Windows

PLOT EDITOR allows you to export the layout area to various graphics formats like EMF, PS, PDF and PNG as well as copy it to the Clipboard. Exported files can be imported by other applications. PNG is usually a good choice for these applications. Copying to the Clipboard allows you to copy single objects as opposed to the entire layout area.

PNG format is highly recommended for exporting Plot Editor graphics

PDF can be used to print the graphics on computers on which Plot Editor is not installed.

A plot Editor layout can be exported in several ways.

From the Plot Editor Interface:

- Click File > Export, enter the filename, format and (if requested) the sampling rate (default 360).
- Click File > Send to send the layout by email.
- Enter Ctrl+a, Ctrl+c to copy all objects to the clipboard. Then paste them to any other application.

From the TOPSPIN command line:
• Enter `autoplot -e <pathname>`. For example:

```
autoplot -e C:\TEMP\my_plot.png. 1)
```

• Write an AU program (with `edau`) containing the following statement:

```
AUTOPlot_TO_FILE("<pathname>")
```

## 2.7 Setting the target printer

By default, the commands `plot` and `autoplot` use the printer defined in the layout or, if this printer does not exist, the system default printer. You can, however, override this with the printer defined by the processing parameter CURPLOT by using the `-c` argument, i.e. entering `plot -c` or `autoplot -c`.

## 2.8 Creating PDF and other file formats out of TOPSPIN main window

TOPSPIN is able to create PDF and other file formats from the main window. Clicking the ‘Publish’ tab from the main tab bar offers the various PDF selections. Clicking the tab will open the following popup menu.

---

1) Note that the format of the graphics output file is determined by the file extension.
The display of every window in TOPSPIN can easily saved to a file as listed above.

For the PDF and PNG file format it is possible to save them directly to the data directory of the active spectrum on the display, but choosing another directory is possible as well.

‘Other formats’ allows to save the displayed spectrum as png, jpg, jpeg, bmp or pdf file to the desired destination.

For all formats the name of the file to be created can be freely chosen.
Part II
Reference
Chapter 3

The Plot Editor

3.1 Introduction

TOPSPIN PLOT EDITOR is a fully object-oriented, interactive WYSIWYG\(^1\) plot editor for high quality printouts of your data. It resembles other well-known drawing programs in many ways and, as such, it is easy to use.

Before we describe the Plot Editor functionality, let’s define a few things.

Interface

The Plot Editor interface is a window which consists of a layout area, a menu bar, an icon bar, a toolbar, a command bar and a status line. The interface is opened with the command `plot`. From here, you can view, display, modify or create plot layouts, fill them with spectral data and print them.

Layout

A layout is a template, which defines a number graphical objects which can be Standard graphics or NMR objects. One layout can be used for different datasets, and, vice versa, a dataset can be plotted with differ-

\(^1\) “What You See Is What You Get”
ent layouts. A layout is defined by the processing parameter LAYOUT, which can be set by clicking the Procpars tab or entering edp and then select Automation, or by entering layout on the command line. Layouts are stored in files with the extension .xwp. TOPSPIN is delivered with a large set of layouts for various standard 1D and 2D experiments. User-defined layouts can be created and stored for later usage. A layout does not contain spectral data.

**Objects**

An object is a graphical element of a layout. Objects can be NMR objects like Spectrum, FID, Parameters, Title etc. or Standard objects like lines, squares, curves etc. Each object has its own position, size, attributes and properties. Each NMR object has its own Reset Actions.

**Datasets**

A dataset holds the actual NMR data, i.e. the FID and/or spectrum. It is defined by a directory with several files, each of which contains a part of the dataset like the fid, the spectrum, the parameters, the title etc. Plot Editor displays each part of the dataset in a separate NMR object.

**Portfolios**

A Portfolio consists of a list of available data directories and a list of selected datasets in those directories. The dataset list is also called the Data Set Selector. It allows you to assign datasets to NMR objects. The current Portfolio can be made the default portfolio and it can be stored with the current dataset.

The use of objects, layouts and portfolios make Plot Editor a flexible and versatile tool. One layout can be used with different portfolios to create the same view/plot of different datasets. Similarly, one portfolio can be used with different layouts to create different views/plots of the same dataset(s).

### 3.2 Starting the Plot Editor

The Plot Editor is started with the command plot. This command:

- uses the layout defined by the parameter LAYOUT
uses the expansion (limits) and intensity scaling of the data window
shows the current dataset

This is what happens if plot is entered without arguments, and LAYOUT defines a layout for one dataset only, like 1D_H.xwp.

However, the command plot takes various arguments, and layouts can define multiple datasets. These features are described below.

3.2.1 Layout handling

The command plot opens the plot Editor interface according to the current layout as defined by the parameter LAYOUT.

In order to use a different layout, use one of the methods below:

+ Enter layout on the command line, select the desired layout, click OK. Then enter plot.

or

+ Enter plot <layout>

where <layout> is the pathname of the layout file.

3.2.2 Expansion and intensity scaling

The Plot Editor can be started with or without Reset Actions to control expansions, intensity scaling and baseline positions.

To start the Plot Editor using the dataset window settings:

+ enter plot

Expansion limits and intensity scaling are taken from the TOPSPIN data window (parameter F1P/F2P and CY).

To start the Plot Editor with Reset Actions:

+ enter plot -r

Expansion limits and intensity scaling are set according to the reset action as defined in the layout for each individual object.

1) Note that the command plot stores the displayed region in the parameters F1P/F2P.
To start the Plot Editor as defined in the layout:

+ enter `plot -n`

Expansion limits and intensity scaling are taken from the layout for each Spectrum object.

### 3.2.3 Portfolio handling

Although the Plot Editor normally shows a layout with one dataset, the current dataset, it can do much more than that. Plot Editor can use layouts defining multiple datasets, which are organized in a portfolio. Here is what actually happens when you enter the command `plot`.

1. Plot Editor loads the default portfolio, which is the portfolio last saved from the Portfolio Editor with `File’ Save As Default`. If this has never been done, Plot Editor uses the same default portfolio as the Topspin browser.

2. Plot Editor replaces the portfolio loaded in step 1 by the portfolio in the current dataset PROCNO, if this exists ¹).

3. Plot Editor replaces the first entry in the Portfolio Data Set Selector with the path of the current dataset.

4. Plot Editor replaces the second and third entry in the Portfolio Data Set Selector with the path of the second and third dataset, respectively, if these are defined (e.g. with the commands `edc2` or `projd`).

5. Plot Editor connects each NMR object in the layout with the associated dataset. Note that each object has a number which corresponds with a position in the Portfolio Data Set Selector.

This may look a little complicated but normally it is very simple; Plot Editor shows the current dataset according to the current layout. The above portfolio handling only plays a role for layouts that define multiple datasets like the 1D layouts `1D+1D+pp.xwp` and `1D+1D+1D.xwp` and the 2D layouts `2D_hom.xwp` and `2D_inv.xwp`.

To open the **Data Set Selector**:

---

¹) It can be stored from the Plot Editor with `File’ Save Layout/Portfolio to Dataset`. 
To open the Portfolio Editor:

+ click **Edit** in the **Data Set Selector** dialog (see Figure 3.1)

The use of portfolios can be further controlled with command line arguments:

```
plot -i
```

Ignore a possible portfolio in the dataset PROCNO (see step 2 above)

```
plot -p <portfolio>
```

Starts the Plot Editor with the specified portfolio, e.g.:

```
plot -p C:\pf\mypf.port
```

### 3.2.4 Startup for 2D data

On 2D datasets, Plot Editor is usually started in the same way as on a 1D dataset, with the command `plot`. Besides the 2D spectrum, the plot layout also shows projections which must be defined first, as separate 1D datasets.

**Exercise 12**

1. Open a 2D dataset.
2. Enter the command `projd`. In the appearing dialog select *Display 1D spectra along with the 2D spectrum* and specify the 1D spectra to be plotted as projections.

3. Enter `layout` on the command line. In the appearing dialog, select an appropriate 2D layout.

4. Enter `plot`.

5. In the Plot Editor interface, right-click in the 2D *Spectrum* object and choose *Edit* from the popup menu.

6. In the appearing dialog (see Figure 3.2)

![Figure 3.2](image)

   **Figure 3.2**

   a) Click the *2D projections* tab.

   b) In the section *Datasets*, enable the entry *Left* and click the *Select...* button to the right of this entry. This will open the Data Set Selector (see Figure 3.3).
c) In the Data Set Selector: select the dataset to be used as vertical projection. Click OK to close the Data Set Selector and click OK to close the Edit dialog.

![Data Set Selector](image)

**Figure 3.3**

Note that you can also use the command `edc2` to define the second and third dataset in the Data Set Selector, before you start the Plot Editor.
3.3 The Plot Editor interface

The Plot Editor interface is opened by the command `plot`. All Plot Editor operations, like, storing and printing layouts are done from here.

The Plot Editor interface consists of the following parts:

- **Layout Area**: the largest part of the interface, containing all the objects to be printed. The white part of the layout area corresponds to the paper sheet. The grey dashed bounding box indicates the plot area.
• **Tools Area**: at the left, with the *Selection* and *Expand* icons, the *Standard/NMR* radio buttons, the Graphics creation icons and the *Mode* field.

• **Menu**: Standard pull-down menus like *File*, *Edit* etc.

• **Command Bar**: frequently used object and other commands

• **Toolbar**: frequently used layout and other commands

• **Status line**: shows the cursor position and, for *NMR* objects, the associated dataset

### 3.3.1 The Layout Area

The *Layout Area* contains all the objects to be printed. The white part corresponds to the paper sheet. By zooming in or out, using the *Zoom in* and *Zoom out* buttons of the command bar, the white part can become larger or smaller than the layout area. If you zoom in far enough, the white part will exceed the window size and scroll bars will appear at the right and at the bottom, allowing you to scroll to any part of the layout.

The gray dashed box indicates the plot area of the current paper format (see Figure 3.4). Objects that are completely outside of this box will be not be printed. Objects that are partially outside of the bounding box will be clipped.

Right-clicking any object in the layout area opens a popup menu with several functions.

### 3.3.2 The Tools Area

The *Tools Area* contains the creation and control icons for creating and manipulating objects, respectively. Furthermore, it contains two radio buttons, which allow you to toggle between *Standard* and *NMR* object icons. Figure 3.5 shows the creation icons for *Standard* graphical objects. To create a *Standard* object, just click the respective icon, move the mouse into the layout area and click at the desired position. For some objects, you have to left-click-hold and move the mouse to draw the object (see also paragraph 5.5).
Figure 3.6 shows the creation icons for NMR objects. To create an NMR object, just click the respective icon, move the mouse into the layout area and click at the desired position. The required dataset is read from the Data Set Selector (Command Button *Data*). The graphics attributes are read from the Attributes selector (Command button *Attributes*).
At the top of the tools area, you find the following icons:

- Line
- Polyline
- Open Bezier
- Text
- Metafile

**Figure 3.5**

- Square
- Polygon
- Closed Bezier
- Circle

**Figure 3.6**

- Title
- 1D spectrum
- 2D Spectrum
- Plot
- Parameters
- Fid
- NMR Text
- T1/T2 Relaxation

Switch to Expansion mode. In this mode, you can expand a part of the spectrum.
To do that, click-hold in the spectrum object and draw a box around the desired region. You can manipulate the expansion by drawing the box while pressing a on of the following modifier keys:

- **Shift** - only the X-expansion is changed while the Y expansion remains the same
- **Ctrl** - only the Y-expansion is changed while the X expansion remains the same
- **Alt** - blow up the region inside the box, according the Global Preferences in the *Options* menu (see Figure 3.7).

![Figure 3.7](image)

Switch to Zoom mode. In this mode, you can zoom in on any part of the layout.

To do that, click-hold in the layout area and draw a box around the desired part of it. To display the full layout area, click the *Full* button of the command bar.

Switch to *Mark Complete* mode. Individual base point positions
of marked objects cannot be changed, only the dimensions.

Switch to Mark Points mode. Individual base points positions of marked objects can be changed.

To mark one object:
+ click the object

To mark multiple objects:
+ click the objects to be marked while pressing the Shift key

To mark all objects:
+ Press Ctrl+a

(see also paragraph 5.1 for more information on marking objects).

Figure 3.8 shows the Mode field which shows the current creation or control mode.

![Figure 3.8](image)

The Mode field is adjusted when you click any of the icons in the Creation Area.

### 3.3.3 The Command Bar

The Plot Editor command bar (see Figure 3.9) consists of a number of large buttons for frequently used data, object and layout commands. Note that only relevant buttons are active, e.g. the *Group* button is only
active if two or more objects are marked.

---

**Figure 3.9**

The functions of the individual buttons are:

- **Data** - Open the Data Set Selector/Portfolio
- **Attributes** - Open the Attributes dialog
- **Zoom in** - Zoom in the entire layout
- **Zoom out** - Zoom out the entire layout
- **Full** - Reset zoom; show the entire layout
- **Delete** - Delete the marked object(s). Only active when one or more objects are marked.
- **Group** - Group the marked objects. Only active when two or more objects are marked.
- **Ungroup** - Ungroup the marked object(s). Only active when the marked object is a grouped object.
- **Rotate** - Rotate the marked object(s) 90° counterclockwise.
- **Edit** - Open the Edit dialog of the marked object, showing various objects properties. Equivalent to double-clicking that object.
- **1D/2D-Edit** - Open the NMR edit dialog. Only active for NMR data objects like 1D Spectrum, 2D Spectrum and FID.
- **Undo** - Undo the last operation. Can be used repeatedly to undo multiple operations. Only active when at least one operation has been done. Equivalent to `ctrl+z`. *Undo* only works for actions that change the layout. It does not work on actions like changing the input mode or changing attributes for new objects to be created.
3.3.4 The Toolbar

The Plot Editor toolbar (see Figure 3.10) consists of a number of buttons for frequently used layout and other commands.

![Figure 3.10]

The functions of the individual buttons are listed below. Most functions can also executed with control keys.

- Create a new layout \([Ctrl+n]\)
- Open a layout \([Ctrl+o]\)
- Save the current layout \([Ctrl+s]\)
- Save the current layout as...
- Cut the marked object(s) \([Ctrl+x]\)
- Print the current layout \([Ctrl+p]\)
- Multiprint
- Copy the marked object(s) to the clipboard \([Ctrl+c]\)
- Paste the clipboard contents to a new meta object \([Ctrl+v]\)
- Open the Help index

3.4 The Menu Bar

The Plot Editor menu bar (see Figure 3.11) consists of a number of pull-down menus with all Plot Editor commands as well as Help documents.

![Figure 3.11]
The following menus are available:

**File**
Layout file related commands like *new, open, save, export, send* and *print*. Furthermore, commands for saving/opening the portfolio in the current dataset.

**Edit**
Object related commands like *delete, cut, copy, paste, duplicate, mark, reset, raise* and *rotate* but also *edit properties* and *tick settings*. Furthermore, the *undo* command.

**Topspin**
Commands to get or update the current dataset or run Topspin commands.

**Options**
Commands to set marker size, expand options and snap-in distance.

**Window**
Commands to arrange multiple layouts. Only useful if you have two or more layouts open (Windows only).

**Help**
The Plot editor manual, Tips and Version info.
3.4.1 The File menu

The *File* menu (see Figure 3.12) offers standard layout file related commands like new, open, save, export, send and print.

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>View</th>
<th>TOPSPIN</th>
<th>Options</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save As...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abandon</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Layout/Portfolio From Dataset...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save Layout/Portfolio To Dataset...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export ...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send ...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Multi-Print ...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Setup...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 3.12**

Furthermore, the *File* menu contains the following functions:

*Abandon*  Restore the last saved layout, discarding all changes.

*Close*: close the current layout, leaving the Plot Editor open including possible other layouts.

*Open Layout/Portfolio From Dataset*: Open the layout and portfolio stored in the current dataset PROCNO (if it exists).

*Save Layout/Portfolio To Dataset*: Store the current layout and portfolio in the current dataset PROCNO.

*Close*: close the current layout, leaving the Plot Editor open including possible other layouts.

*Multi-Print*: Print multiple datasets with all open layouts.

*Page-Setup*: set up the paper size paper orientation etc.

*Exit*: exit the Plot Editor. You will be prompted to save open layouts.
3.4.2 The Edit menu

The *Edit* menu (see Figure 3.13) offers standard object related commands like delete, duplicate, cut, copy, paste, mark, reset, raise and rotate.

<table>
<thead>
<tr>
<th>Edit</th>
<th>View</th>
<th>TOPPIN</th>
<th>Options</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group</td>
<td>Ctrl+G</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ungroup</td>
<td>Ctrl+Shift+G</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Raise</td>
<td>Ctrl+R</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lower</td>
<td>Ctrl+L</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rotate</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mark All</td>
<td>Ctrl+A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unmark All</td>
<td>Ctrl+M</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Marked Objects</td>
<td>Ctrl+T</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset All Objects</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object Properties ...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Automation Parameters ...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Axis Tick Settings ...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 3.13**

Furthermore, it contains the following functions:

*Reset Marked Objects*: Perform Automation Reset Actions on all marked objects.

*Reset All Objects*: Perform Automation Reset Actions on all objects.

*Object Properties ...*: Open the *Edit* dialog for the marked object. (same as double-clicking this object, see paragraph 5.8)

*Automation Parameters ...*: Open the *Automation Reset Action* dialog for the marked object (see Chapter 8).

*Axis Tick Settings ...*: Open the *Axis Tick Settings* dialog for the marked object (see paragraph 5.10).
3.4.3 The TOPSPIN menu

The *TOPSPIN* menu (see Figure 3.14) offers *TOPSPIN* interface related commands.

![TOPSPIN menu](image)

**Figure 3.14**

Here are the functions:

**Get Current Data Set**: Get the dataset from the current (active) *TOPSPIN* dataset window). ¹)

**Get Current Data Set + Reset**: Get the dataset from the current (active) *TOPSPIN* dataset window) and perform Reset Actions.

**Get Current Data Set + Reset + Print**: Get the dataset from the current (active) *TOPSPIN* dataset window) perform Reset Actions and print.

**TOPSPIN Command Interface**: Open a dialog that shows the datasets in the Data Set Selector and allows you to run *TOPSPIN* command on them.

**Update Data from Data Set**: Update all NMR objects from the *TOPSPIN* dataset window(s) ²).

**View error messages**: view error messages since Plot Editor startup.

---

¹) Dataset is read to the spectrum object associated with the first entry of the Data Set Selector
²) Useful if data have been manipulated from the *TOPSPIN* data window after the Plot Editor was opened.
3.4.4 The Options menu

The **Options** menu (see Figure 3.15) offers a few setup commands.

![Options menu](image)

**Figure 3.15**

**Global Setup ...**: Open a dialog where you can change setting for all objects (see Figure 3.16).

![Global Preferences dialog](image)

**Figure 3.16**

The following functions are available:

- **Marker**: Move the slider to set the size of the (green) markers of marked objects.

- **Blowup Offset**: Set the offset of the Alt-Expand function; the distance between spectrum and expanded region (in cm)

- **Blowup Expansion**: Set the Expansion factor of the Alt-Expand function.

- **Show Expansion Label**: Enable/disable display of the expansion factor with the expanded region created with the Alt Expand function.

For more information on the Alt-Expand function, see paragraph 3.3.2.
Layout Setup ...: Open a dialog where you can set the Snap-In distance. (see Figure 3.17)

![Layout Setup dialog](image)

Figure 3.17

Now objects can only be placed/moved to fixed grid positions at the specified distance. This allows you to exactly align objects. When the Snap-In distance is set to none, you can smoothly move objects to any position in the layout.

3.4.5 The Window menu

The Window menu (see Figure 3.18) offers a few layout window related commands

![Window menu](image)

Figure 3.18

The following functions are available:

*New Window:* Open a new layout window.

*Cascade:* Arrange existing layouts in cascade.

*Tile:* Arrange existing layouts in tile.

*Arrange icons:*
3.4.6 The Help menu

The Help menu (see Figure 3.19) offers tips and help related entries.

![Help Menu](image)

**Figure 3.19**

The following entries are available:

- **Tip of the Day...** : Show the Tip of the Day (can be set to appear during Plot Editor startup).
- **Plot Editor Manual...** The manual you are currently reading.
- **About TOPSPIN Plot Editor...** Version and license info.

3.5 The popup menu

Frequently used object related commands are available in a right-click popup menu for quick access. If you right-click an object in the layout area, the object is automatically selected and a popup menu appears (see Figure 3.20). ¹)

The functions of the right-click popup menu are:

- **Edit**
  Open the **Edit** dialog with various objects properties. Equivalent to clicking the **Edit** button or double-clicking the object.

- **1D/2D-Edit**
  Open the NMR Edit dialog. Only active for NMR data objects like 1D Spectrum, 2D Spectrum and FID. Equivalent to clicking **1D/2D-Edit** button.

- **Automation**

¹) On many Linux systems the popup menu will not work as long as the NUMLOCK state is activated on your keyboard. Press the NUMLOCK key to deactivate it.
Open the Automation Reset Actions dialog 1). Allows you to change the Reset Actions for the current object. Requires a **Reset Object** for changes to take effect (see below).

**Axis Tick Settings**
Open the **Axis Tick Settings** dialog. Allows you to change the axis tick settings for the current object.

**Attributes**
Open the Attributes dialog. Equivalent to clicking the **Attributes** button.

**Cut**
Cut marked object(s) and place them on the Clipboard. Equivalent to **Ctrl+x**.

**Copy**
Copy marked object(s) to the clipboard. Equivalent to **Ctrl+c**.

**Paste**
Paste object from the clipboard. Equivalent to **Ctrl+v**.

---

1) Only active for NMR data objects like 1D Spectrum, 2D Spectrum and FID.
Delete
Delete the selected object. Equivalent to clicking the Delete button or pressing the Delete key.

Duplicate
Duplicate the selected object. A copy of the object will appear slightly shifted from the original one.

Raise
Raise the selected object to foreground. Equivalent to Ctrl+r.

Lower
Lower the selected object to background. Equivalent to Ctrl+l.

Rotate
Rotate the selected object 90°, counterclockwise.

Reset Object
Apply changes in the Automation Reset Actions on the selected object.

Please note that:

• functions where no equivalent is mentioned, like Automation and Raise are also available from the Edit menu.
• the right-click popup menus only work on the selected (clicked) object, whereas the command bar buttons and pulldown menus work on all marked objects.

3.5.1 The Status Line

At the bottom of the Plot Editor interface, you find the status line (see Figure 3.21). In the middle of the status line, you see the cursor position, and, if the cursor is in an NMR object, the dataset associated with that object. In the right part of the status line, you see the current creation or control mode, which corresponds to the Mode field at the left of the Plot Editor interface. At the extreme right, the status line shows the current zoom factor.

Position: 16.70, 9.20 (C:/ts16/data/guest/nmr/exam1d_1H/1/pdata/1)

Create parameter object
Zoom: 70%

Figure 3.21
3.6 Setting the target printer

By default, the commands `plot` and `autoplot` use the printer defined in the layout. If, however, this printer does not exist, the system default printer is used. This means that if you are using Bruker layouts such as `1D_H.xwp` or `2D_hom.xwp`, the system default printer will normally be used because the Bruker defined printer in the layout does not exist on your system.

If you have more than one printer connected to your system, and do not want to use the default one, you can use `plot` or `autoplot` with the `-c` argument. In that case, the printer defined by the processing parameter CURPLOT will be used.

Exercise 13

1. Start TOPSPIN and open a 1D dataset of a proton spectrum.
2. Enter `layout` on the command line. In the appearing dialog, select the standard layout `1D_H.xwp` (if it is not already selected).
3. Enter `curplot` on the command line. In the appearing dialog, select the desired printer.
4. Enter `plot -c`. The Plot Editor interface will appear.
5. Click `File’ Print`
   The printer that is selected in the print dialog is the one defined in step 3.
6. Click the `Print` button in the dialog to print the layout.
7. Click `File’ Exit` to close the Plot Editor interface.
8. Enter `autoplot -c` to print the current dataset again on the selected printer.

Note that the target printer can also be selected from the print dialog opened by the TOPSPIN command `print [Ctrl+p]`.

The `-c` argument is suitable for occasional usage of a printer other than the default one. If you do this regularly or want to print your data on two or more printers, you might want to store you own set of layouts with the desired printer defined. The follow exercise is an example of you how can do that.
Exercise 14

1. Start TOPSPIN and open a 1D dataset of a proton spectrum.
2. Enter `layout` on the command line. In the appearing dialog, select the standard layout 1D_H.xwp (if it is not already selected).
3. Enter `curplot` on the command line. In the appearing dialog, select the desired printer.
4. Enter `plot -c`. The Plot Editor interface will appear.
5. Click `File` → `Save as...` and select or enter the desired layout name, e.g. 1D_H_LJ4000.xwp.
6. Click `File` → `Exit` to close the Plot Editor interface.
7. Enter `layout` on the command line. In the appearing dialog, select the layout that you stored in step 5.
8. Enter `autoplot` to print the current dataset on the printer stored in the selected layout.

As such, you can define your own set of layouts for printing on any printer connected to your system. Note that you can also store your own layouts under their original names but in a different directory (see paragraph 6.2).

For more information on setting the target printer in automation and on Linux systems, see paragraph 7.7 and 11.4, respectively.
Chapter 4
Datasets/Portfolios

TOPSPIN and Plot Editor organize NMR data in datasets and organizes datasets in portfolios. A dataset consists of a directory tree with various files, which contain data components. A Portfolio consists of a list of available data directories and a list of selected datasets in those directories. This way of organizing data makes the Plot Editor very flexible and versatile.

4.1 Dataset structure

A dataset holds the actual NMR data, i.e. the FID and/or spectrum, parameter files and various other information. A dataset is defined by the following directory tree:

<dir>/data/<user>/nmr/<name>/<expno>/pdata/<procno>

where
<dir> = top level data directory
<user> = user; a character string
<name> = data name; a character string
<expno> = data experiment number: an integer number
<procno> = data processing number: an integer number
for example:

/bio/data/guest/exam1d_1H/1/pdata/1

The EXPNO and PROCNO directories contain several files, each of which holds a dataset component like $FID$, $Spectrum$, $Parameters$, $Title$ etc. The Plot Editor shows these components in the respective objects, i.e. the $FID$-object, the $Spectrum$ object, the $Parameters$ object etc.

### 4.2 Dataset handling

When you start the Plot Editor with the `plot` the current TOPSPIN dataset will be shown with the current layout. From the Plot Editor interface, you can open a different dataset, with the `Data` command button or from the `TOPSPIN` menu.

**Exercise 15**

1. Start TOPSPIN and open a 1D dataset of a proton spectrum.
2. Enter `layout` on the command line. In the appearing dialog, select the standard layout 1D_H.xwp (if it is not already selected).
3. Enter `plot`. The Plot Editor interface will appear.
4. Move the cursor around in the layout area through the different objects. Whenever the cursor is located in an $NMR$ object, the status line will show the dataset associated with that object, e.g.

   Position: 11.50,13.70 (C:/bio/data/guest/nmr/exam1d_1H/1/pdata/1)

Note that in this example, all $NMR$ objects like $Spectrum$, $Title$, $Parameters$ are associated with the same dataset, the dataset Plot Editor was started with.

5. Click `File` > `Print` [Ctrl+p], select the printer in the appearing dialog and click `Print`.

6. Go to the TOPSPIN interface and open a different 1D proton spectrum.
7. Go to the Plot Editor interface and click `TOPSPIN` > `Get Current Dataset`.

   See how all NMR objects now show the new dataset.
8. Click `File` > `Print` [Ctrl+p], select the printer in the appearing dialog
and click *Print*.

Steps 6, 7 and 8 can be repeated to print a series of datasets with the same layout. Usually, Reset Actions (see also Chapter 8) are required, in which case step 7 and 8 can be replaced by:

1. Click *TOPSPIN ’ Get Current Dataset + Reset + Print*

Instead of getting a new dataset from the *TOPSPIN* menu, where you have to switch between the *TOPSPIN* and Plot Editor interface, you can also use the *Data* command button, which opens the Data Set Selector/Portfolio (see paragraph 4.3).

In the exercise above, we used the layout 1D_H.xwp, which holds one dataset only. This is the case for most Bruker 1D layouts. More complex layouts can hold multiple *Spectrum* objects associated with different datasets (see paragraph 4.3)

### 4.3 Portfolios

#### 4.3.1 Using portfolios

The Plot Editor organizes datasets in portfolios. A portfolio consists of a:

- **Directory list:**
  A list of top level data directories 1). This list can be set up in the *Portfolio Editor*.

- **Dataset list:**
  A list of selected datasets in the top level directories. This list can be set up in the Portfolio Editor and will be displayed in the *Data Set Selector*.

To open the *Data Set Selector*:

1) The top level directory is the <dir> part of a datapath.
To open the Portfolio Editor:

+ click the **Edit** button in the *Data Set Selector* dialog (see Figure 4.2).

Let's see how this works by creating a plot layout with multiple 1D datasets.

**Exercise 16**

1. Start **TOPSPIN** and open the datasets `exam1d_13C/1/1`, `exam1d_13C/2/1` and `exam1d_13C/3/1` in three different data windows ¹). Click in the data window of `exam1d_13C/1/1` to make it the current dataset.

2. Enter `layout` on the command line. In the appearing dialog, select the standard layout `1D+1D+1D.xwp`.

3. Enter `plot`. The Plot Editor interface will appear.

¹) Make sure these datasets are processed.
The layout will show three 1D Spectrum objects above each other. Only the upper one contains a spectrum.

**The Data Set Selector positions are stored in the layout, not the datapaths**

4. Move the cursor through the three 1D Spectrum objects and look at the status line. For the upper object the status line shows the current dataset, for the other two objects it shows nothing.

   The reason for the lower objects to be empty is their association with the entries 2 and 3 in the Data Set Selector, which have not been defined yet.

5. Click the **Data** button of the command bar to open the Data Set Selector.

   This shows only one entry, consisting of a number and a datapath (see Figure 4.2).

**The first entry in the Data Set Selector is, by default, the current dataset.**

6. Click **Edit** in the Data Set Selector dialog to open the Portfolio Editor (see Figure 4.3).

7. Select dataset exam1d_13C/2/1 by clicking the respective entries in the sections Directory, User, Name, Expno and Procno. Then click the **Append** button. Repeat this for dataset exam1d_13C/3/1. The Portfolio section of the dialog will now show three datasets (see Figure 4.3).

8. Click **Apply**. This will close the Portfolio Editor, update the Data Set Selector (see Figure 4.4) and fill the second and third Spectrum object with data.
9. If you do not see a spectrum in object 2 and 3, please do the following:
   a) Right-click in the object and choose 1D/2D-Edit from the popup menu.
   b) In the 1D/2D-Edit dialog, click the following icon:

   ![Icon to reset the vertical and horizontal position of the spectrum]

   to reset the vertical and horizontal position of the spectrum.

10. Move the cursor through the objects and see how the respective datapaths appear in the status line.
Each NMR object is associated with an entry (number) in the Data Set Selector.

Now let’s play around with the object-dataset association.

11. Mark the upper Spectrum object (associated with the first entry).
12. Click the entry number 2 in the Data Set Selector.
13. Click the Set button.
14. Move the cursor into the upper Spectrum object and check the datapath in the status line. The object is now associated with the dataset at entry 2.
15. Repeat step 11 to 14 for the upper Parameters object.

Note that clicking Set, also selects the dataset for new NMR objects.

Important:
- the positions (numbers), not the datapaths, are stored in the layout

Note that the dataset that is associated with an object can also be changed from the Edit dialog as demonstrated in the next exercise.

Figure 4.4
Exercise 17

1. Right-click a Spectrum object and choose Edit from the popup menu.
2. Click the Data Set tab in the Edit dialog (see Figure 4.5).
3. Click the Select... button.

![Figure 4.5 Edit dialog of a 1D Spectrum object](image)

The Data Set Selector will appear.

4. Select the desired dataset in the Data Set Selector and click OK.
5. Close the Edit dialog by clicking OK.
6. Move the cursor into the respective object and see in the status line that it is now associated with the selected dataset.
7. Repeat step 1 to 5 for the Parameters object.

A complex layout with multiple datasets, can be created once and used repeatedly, with different portfolios.

One layout can be used with multiple portfolios, interactively or automatically

4.3.2 Portfolio Editor functions

The Portfolio Editor allows you to load, modify and save portfolios. Note that a portfolio consist of a directory list (shown in the Directory field) and a dataset list (shown in the Portfolio section, see Figure 4.3).

The Portfolio Editor offers:

- The menus File and Edit with functions to load, modify and save a directory list.
• The fields Directory, User, Name, Expno and Procno showing the available datasets and allowing you to select a dataset to be appended to the dataset list.

• The Portfolio field, showing the current dataset list.

• The buttons Append, Insert and Remove to modify the dataset list.

• The buttons Apply and Close to close the Portfolio Editor, with or without save, respectively.

The buttons at the bottom of the Portfolio Editor have the following functions:

Append
Add the selected (highlighted) dataset to the end of the list. Equivalent to double-clicking the dataset.

Insert
Insert the selected (highlighted) dataset before the selected entry in the Portfolio field.

Remove
Delete the selected (highlighted) dataset from the Portfolio field.

Apply
Apply all changes, update the Data Set Selector and close the Portfolio Editor.

Close
Close the Portfolio Editor, without updating the Data Set Selector.

The File menu of the dialog provides the following commands:

Load...
Open a dialog to select and load a portfolio.

Append...
Open a dialog to select a portfolio and append it to the current portfolio.

Save as...
Save the current dataset list to the specified portfolio.

Save as default..
Save the current portfolio as the default portfolio. It is stored in the di-
rectory <userhome>/topspin-<hostname>/default.por. If this action has never been performed, the default portfolio contains the TOPSPIN browser directory list and an empty dataset list.

**Reset**
Reset to the default portfolio, discarding any changes.

**Close**
Close the Portfolio Editor.

The *Edit* menu offers the following options:

**Sort Ascending**
Sort the dataset list in ascending order

**Sort Descending**
Sort the dataset list in descending order

**Clear**
Remove all selections from the Portfolio field.

**Edit Directory List**
Specify the top level data directories that contain TOPSPIN data. Top level directories are valid data directories if they contain a subdirectory data with TOPSPIN data. The directory list dialog displays all currently valid directories in a list box (Figure 4.6). Data directories can be added to this list by specifying their names in the *Directory* text field and clicking the *Add* button. To remove one or more directories from the directory list, select them and click the *Remove* button. The current directory list will be accepted by the *Portfolio Editor* after clicking *Apply*.

### 4.3.3 Using the Portfolio Editor to set up a stacked plot

A stacked plot is a plot of a series of 1D spectra, which are plotted with increasing offset. The spectra are taken from the Data Set Selector, in ascending order. By default, the Data Set Selector only contains the current dataset and, if these are defined, the second and third dataset. So normally, you have to fill the Data Set Selector with the datasets to be included in the stacked plot, before you create a stacked plot object.

**Exercise 18**
1. Open the first spectrum to be included in the stacked plot.
2. Enter `plot`. The Plot Editor interface will appear, showing the current dataset.

3. Click the **Data** button of the command bar to open the Data Set selector. It will show an entry with the current dataset.

4. Click **Edit** in the Data Set Selector dialog to open the Portfolio Editor.

5. In the Portfolio Editor:
   
a) Select the additional datasets to be included in the stacked plot. For each dataset, click the **Append** button to add it to the Portfolio list.

b) If you want to display the spectra in descending order:
   
   + click **Edit > Sort Descending**

   c) Click **Apply** to load the Portfolio list to the Data Set Selector.

6. Click **OK** to close the Data Set Selector.

7. Right-click in the **Stacked Plot** object and choose **Edit** from the popup.
Datasets/Portfolios

menu.

8. In the appearing dialog:
   a) Click the Stacked tab.
   b) Enter the number of spectra
   c) Enter the horizontal and vertical offset or accept the default values.
   d) If you want the white washed effect (only foreground curves visible):
      + enable the checkbox Set curve attributes to “White Washed” on OK
   e) Click OK.

Note that the White Washed checkbox defines a one time action on OK. It is always disabled on opening the Edit dialog. To undo the white washed effect, you must do the following.

1. Right-click in the Stacked Plot object.
2. Click the Attributes button in the Curve section.
3. In the appearing dialog, click the Default button, then click OK.

When creating stacked plots, it is useful to choose dataset names that allow easy sorting, ascending or descending. For example, temperature dependent measurements, where the stacked plot shows the effect of rising or falling temperatures, dataset names might contain the acquisition temperature.

Note that the standard AU program stack1d automatically creates a stacked plot of a series of 1D spectra in consecutive EXPNO’s or PROCNO’s. For more details on stacked plot objects, see paragraph 5.8.7.

4.3.4 Portfolio handling during Plot Editor startup

When you start the Plot Editor, it normally shows the current dataset. However, the dataset handling during startup can be highly manipulated by using portfolios. The following happens during startup.

1. The default portfolio is loaded.
2. The file portfolio.por in the processing directory (PROCNO) of
the current dataset is loaded, if it exists. It overrides the default portfolio.

3. The first entry of the portfolio dataset list is replaced by the current TOPSPIN dataset.

4. The second and third entry of the dataset list are replaced with the second and third TOPSPIN dataset, if they are defined (e.g. with edc2 or projd).

The result of these steps is shown in the Data Set Selector, which can be opened by clicking the Data button of the command bar. Most standard layouts, e.g. 1D_H.xwp only use the first dataset in the Dataset Selector. Some layouts, e.g. 1D+1D+1D.xwp use the first three datasets.

The use of Portfolios during Plot Editor startup can be manipulated with command line arguments:

```
plot -i
```

Ignore a possible portfolio in the dataset PROCNO (see step 2 in paragraph 4.3.4)

```
plot -p <portfolio>
```

Starts the Plot Editor with the specified portfolio, e.g.:

```
plot -p C:\pf\mypf.port
```

### 4.3.5 Portfolio handling in automated plotting

The command `autoplot` prints data according to the current layout. It uses portfolios in the same way the command `plot` does. This means it loads the default portfolios, overrides it with the portfolio in the dataset PROCNO (if it exists) and replaces the first entry with current dataset. As such, portfolios can be created/modified and saved from the interactive Plot Editor (command `plot`) and used for command line plotting (command `autoplot`) and automation (macro AUTOPLLOT). Furthermore, `autoplot` supports the following arguments to manipulate portfolio handling:

```
-p portfolio.por     Loads the portfolio portfolio.por
-a portfolio.por     Appends portfolio.por to current portfolio
```
-d <datapath> Adds dataset <datapath> to current portfolio
-r <datapath> Removes dataset <datapath> from portfolio
-sa Sorts portfolio in ascending order
-sd Sorts portfolio in descending order

`autoplot` can take multiple portfolio arguments, which are evaluated left to right.
An object is a graphical element of a layout. Objects can be *NMR* objects like *Spectrum, FID, Parameters, Title* etc. or *Standard* objects like *lines, squares, curves* etc. Each object has its own position, size, attributes and properties. Each *NMR* object has its own Reset Actions.

### 5.1 Marking/unmarking objects

In order to manipulate an object, it often must be marked (selected) first. To mark an object, click one of the following icons:

![Mark an object as a whole.](image)

Mark an object as a whole.

![Mark an object by individual points.](image)

Mark an object by individual points.

Then click the object to be marked.
Marked objects are indicated by green markers around them. For most objects there is no difference between the two marking modes. For some, however, there is a difference, like for polylines and polygons curves (see Figure 5.1).

![Polyline object, marked by its points (above) and as a whole (below).](image)

Figure 5.1 Polyline object, marked by its points (above) and as a whole (below).

When marking such an object by its individual points, the position of each base point can be individually changed using the mouse. This results in the object changing its form, i.e. the form of its bounding box. When an object is marked as a whole, only the objects dimensions can be changed, but not its individual point positions.

Note that if you right-click an object and choose any of the functions in the popup menu, the object is implicitly marked.

**To mark multiple objects:**

- Click each object with the left mouse button while pressing the `Shift` modifier key on the keyboard.

  or

- Put the mouse cursor outside of all objects to be marked, left-click-hold and move the mouse to draw a box around all objects. On releasing the mouse button, all objects inside the box will be marked.

**To mark all objects:**

- Click *Edit* > *Mark All* `Ctrl+a`

**To unmark** an object:

- Left-click in the marked object

  or

- Mark a different object
Handling Objects

To **unmark all objects**:
+ Click *Edit ’ Unmark All* [Ctrl+m]

### 5.2 Deleting objects

To **delete one or more objects**:
+ Mark the object(s) and click the *Delete* button of the command bar.

To quickly **delete one object**:
+ Right-click the object and choose *Delete* from the popup menu.

To **delete all objects**:
+ Press *Ctrl+a* and click the *Delete* button

Note that instead of clicking the *Delete* button, you can also click the menu *Edit ’ Delete* or press the *Delete* key on the keyboard.

If you accidentally deleted an object, you can easily bring it back by undoing the last operation(s) (press *Ctrl+z*).

### 5.3 Copying/Duplicating objects

Plot Editor supports duplicating objects in the current layout and copying objects to other layouts and other applications.

#### 5.3.1 Duplicating objects

If you duplicate an object, it is copied and the copy is placed in the same layout, at a slight offset from the original object.

To **duplicate one or more objects**:
+ Mark the object(s) and click *Edit ’ Duplicate*

To quickly **duplicate one object**:
+ Right-click the object and choose *Duplicate* from the popup menu.

To **duplicate all objects**:
+ Press *Ctrl+a* and click *Edit ’ Duplicate*
5.3.2 Copying objects

If you copy an object, it is placed on the clipboard and can be pasted to any Plot Editor layout or any other application.

To copy one or more objects:

+ Mark the object(s) and click Edit ’ Copy [Ctrl+c]

To quickly copy one object:

+ Right-click the object and choose Copy from the popup menu.

To copy all objects:

+ Press Ctrl+a and click Edit ’ Copy [Ctrl+c]

Copied objects can be pasted to the same or to a different Plot Editor layout by clicking Edit ’ Paste [Ctrl+v]. Pasted objects appear at the same position as the original objects.

5.4 Manipulating objects

5.4.1 Moving an object

In order to move an object:

+ Click-hold the object, move the mouse and release it at the desired position.

You don’t need to mark an object in order to move it.

5.4.2 Resizing an object

Objects can be resized graphically or numerically.

To resize an object graphically:

+ Mark the object as a whole (see above), click-hold one of the green markers, move the mouse and release it when the desired size has been reached.

To resize an object numerically:
1. Right-click in the object and choose \textit{Edit} from the popup menu.

\begin{figure}[h]
\centering
\includegraphics[width=0.7\textwidth]{edit_dialog}
\caption{Figure 5.2}
\end{figure}

2. In the appearing dialog (see Figure 5.2):
   \begin{enumerate}
   \item Select the \textit{Basic} tab \footnote{Under Linux, Tabs do not exist, all dialog parts are shown simultaneously (see chapter 12)}
   \item Specify the \textit{Dimension} for \textit{x} and \textit{y} in the respective fields.
   \item Click \textit{OK}.
   \end{enumerate}

Note that the object will be resized with respect to the lower left corner of the object (specified as the \textit{x} and \textit{y Position} in the \textit{Edit} dialog).

5.4.3 \textbf{Grouping/ungrouping objects}

Sometimes operations like moving or scaling have to be applied to a number of objects, for example if these objects are related. In this case it is useful to group the objects and then perform the action to the group.

To \textbf{group objects}:
\begin{itemize}
\item Mark the desired objects and click the \textit{Group} button.
\end{itemize}

Instead of clicking the \textit{Group} button, you can also click the menu \textit{Edit \rightarrow Group} or press \texttt{Ctrl+g}.

To \textbf{quickly group all objects}:
\begin{itemize}
\item Press \texttt{Ctrl+a} and press \texttt{Ctrl+g}.
\end{itemize}

To \textbf{ungroup objects}:
+ Mark the grouped object and click the *Ungroup* button.

Instead of clicking the *Ungroup* button, you can also click the menu *Edit ’ Ungroup* or press *Ctrl+Shift+g*.

Note that the *Group* button is only enabled if two or more objects are marked and the *Ungroup* button is only enabled if a grouped object exists and is marked.

### 5.4.4 Rotating objects

Marked objects can be rotated counterclockwise in steps of 90°.

**To rotate one or more objects:**

+ Mark the object(s) and click the *Rotate* button.

**To quickly rotate one object:**

+ Right-click the object and choose *Rotate* from the popup menu.

**To rotate all objects:**

+ Press *Ctrl+a* and click the *Rotate* button.

Instead of clicking the *Rotate* button, you can also click the menu *Edit ’ Rotate*.

Note that clicking *Rotate* several times rotates marked objects by 90°, 180°, 270°, etc.

Rotation can not be performed on imported Windows Metafile Graphics. You can rotate the *Meta* object but the imported graphics will keep the original orientation. The same counts for EPSI objects under Linux.

### 5.4.5 Raising and lowering objects

Raising or lowering an object means bringing it to foreground or background, respectively. This is sometimes necessary when objects are overlapping.

**To raise one or more objects:**

+ Mark the object(s) and click *Edit ’ Raise* [*Ctrl+r*].

**To quickly raise one object:**
Handling Objects

- Right-click the object and choose \textit{Raise} from the popup menu.

To \textbf{lower one or more objects}:
- Mark the object(s) and click \textit{Edit} \textasciitilde \textit{Lower} \texttt{[Ctrl+1]}.

To quickly \textbf{lower one object}:
- Right-click the object and choose \textit{Lower} from the popup menu.

Note that objects are always raised or lowered with respect to other objects. Raising or lowering all objects has no effect.

\subsection*{5.4.6 Using a spectrum or FID as clipping window}

If you move a \textit{Spectrum} object, the spectrum curve moves along with the bounding box, keeping the displayed spectral area the same. However, you can also move a \textit{Spectrum} object, keeping the X and/or Y position of the curve the same, thereby changing the displayed part of the spectrum. As such, you use the \textit{Spectrum} object as a clipping window. To do this:
- Click-hold the object and move the mouse while holding down one of the following keys:
  - \textit{Shift} to keep the X-position of the spectrum curve.
  - \textit{Ctrl} to keep the Y-position of the spectrum curve.
  - \textit{Alt} to keep both the X and Y-position of the spectrum curve.

The same procedure can be used for an FID object.

\subsection*{5.4.7 Undo last operation(s)}

Plot Editor operations can easily be undone and you can undo as many operations as you want.

To \textbf{undo an operation}
- Click the button \textit{Undo} at the upper right of the Plot Editor interface
  - or
- press \texttt{Ctrl+z}

Repeat this action if you want to undo multiple operations. Note that \textit{Undo} only works for actions that actually change the layout. It does not work for actions like changing the input mode or changing attributes for objects to
be created.

5.5 Creating new objects

New objects can be created simply by clicking the respective icon at the left of the Plot Editor interface and then clicking at the desired position in the layout area.

Create an NMR object

To create an *NMR* object, take the following steps:

1. Enable the radio button *NMR* at the left of the Plot Editor interface (if it is not already enabled).
2. Click the desired object icon, e.g. *Title* or *1D Spectrum*. Note that the *Mode* field now indicates that object.
3. Place the cursor in the layout area at the desired position.
4. For some objects, e.g. *1D Spectrum* or *FID* you have to left-click-hold and move the mouse to draw the object. For other objects, like *Title* and *Parameters*, you only have to left-click at the desired position.

Create a Standard object

To create a *Standard* object, take the following steps:

1. Enable the radio button *Standard* at the left of the Plot Editor interface (if it is not already enabled).
2. Click the desired object icon, e.g. *Line* or *Square*.
3. Place the cursor in the layout area at the desired position.
4. For some objects, e.g. *Line*, *Square* and *Circle*, you have to left-click-hold and move the mouse to draw the object. For other objects, like *Bezier curves* etc., you must left-click multiple times while moving the mouse to draw the object and, finally, middle-click to finish.

More information on creating new objects, as well as importing graphics can be found in paragraph 6.5.
5.6 Setting Object Attributes

Plot Editor allows you to set various graphical attributes such as colors, fonts, line styles etc. You can change the attributes of existing objects in the layout or set attributes for new objects to be created.

To change attributes of an existing object:
+ Right-click the object and choose Attributes from the popup menu.

To change attributes of all existing objects:
+ Press Ctrl+a and click the Attributes button of the command bar.

To set attributes for new objects only:
+ Press Ctrl+m \(^1\) and click the Attributes button of the command bar.

Clicking the Attributes popup menu or button will open the Attributes dialog where you can set the colors, fonts, line styles etc. (see Figure 5.3). Make any desired changes and click OK to apply them and close the dialog.

Further details on setting attributes are described in the paragraphs below.

\(^1\) To deselect any existing objects.
5.6.1 Setting Color Attributes

The graphical attributes **Line Color** and **Fill Color** can be set from the Attributes dialog, in two different ways:

+ Click one of the 16 displayed standard colors.

*or*

1. Click the *Change*... button.
2. In the appearing dialog, select one of 48 basic colors or add your own custom color.
3. Click *OK* to save and close the dialog.
4. Click the **RGB Color** field to actually select the new color.

The way you can add custom colors (see step 2 above) depends on the operating system and may involve moving sliders or entering RGBH or HSL values.

If the number of available colors is exhausted ¹), the color shades shown in the **Color** field may not reflect the true values indicated by the contents of the text fields or by the slider positions. However, this does not affect the colors as they appear on a printout.

The settings for **Line** and **Fill** color can be changed independently. You can switch between them by selecting the corresponding radio button (see Figure 5.3).

5.6.2 Setting Font Attributes

The *Attributes* dialog allows you to set the font for any object that contains characters like *Spectrum* (the axis units), *Title* or *Parameters*.

To change the **Font Type**:  
+ Click in the **Font Selection** field and select a font type.

To change the **Font Size**:  
+ Click the right part of the **Size** field and select a font unit (Pt, cm or inch), then click the left part of the **Size** field and enter or select the font size.

¹) The maximum number of different colors depends on the display hardware.
5.6.3 Applying/Setting Attributes

When you have set all the desired attributes, you can use the following buttons to apply the changes:

- *Apply* to apply attributes (disabled if no object is marked or exists)
- *OK* to apply attributes and close the dialog
- *Default* to reset the attributes to default

Note that both *Apply* and *OK* apply the changes to marked objects and set them for new objects.

5.6.4 Which attributes apply to which objects

Table 5.1 shows a list of attributes and the objects they apply to.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>NMR Objects</th>
<th>Standard Objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line Color</td>
<td>All (including text objects)</td>
<td>All (including text objects)</td>
</tr>
<tr>
<td>Fill color</td>
<td>1D Spectrum, 2D Spectrum, Fid, Stacked, T1/T2</td>
<td>Circle, Square, Polygon, Closed Bezier</td>
</tr>
<tr>
<td>Line Style/Width</td>
<td>1D Spectrum, 2D Spectrum, Fid, Stacked, T1/T2</td>
<td>Line, Square, Circle, Polyline, Polygon, Open/Closed Bezier</td>
</tr>
<tr>
<td>Fill Style</td>
<td>Closed <em>Standard</em> objects and <em>NMR graphical</em> objects like.</td>
<td>Circle, Square, Polygon, Closed Bezier</td>
</tr>
<tr>
<td>Font Style/Size</td>
<td>Title, Parameters, 1D Spectrum, 2D Spectrum, Fid, Stacked, T1/T2</td>
<td>Text</td>
</tr>
</tbody>
</table>

Table 5.1

5.6.5 Saving/opening a set of attributes

A set of attributes can be saved from the attributes dialog as follows:

- Click *File > Save As* to save the current attributes under a new name.

+ Click *File > Save As Default*
to save the current attributes as default. 1)

+ Click *File* > *Open*

  to open a new set of attributes.

### 5.7 Display functions of NMR spectrum objects (1D/2D-Edit)

The Plot Editor offers an easy to use dialog, the **1D/2D-Editor**, for graphical NMR objects like 1D and 2D spectra and FID’s. It allows you to expand, scale and shift a spectrum interactively, as well as enable/disable axes, grids and peak- and integral labels.

#### 5.7.1 1D spectra

To open the **1D/2D-Editor** dialog:

+ Right-click an *1D Spectrum* object and choose **1D/2D-Edit**

The buttons at the upper part of the dialog (see Figure 5.4) allow you to shift and scale the spectrum.

![Figure 5.4](image)

Click-hold this button and move the mouse left/right to shift the spectrum horizontally.

Click-hold this button and move the mouse up/down to shift the spectrum vertically.

1) Default attributes are stored in `<userhome>/topspin-<hostname>/default.att`
Handling Objects

Click-hold this button and move the mouse in any direction to shift the spectrum accordingly.

Click-hold this button and move the mouse left/right to smoothly expand the spectrum (1D objects only).

Click-hold this button and move the mouse up/down to smoothly scale the spectrum intensity up/down.

Click-hold this button and move the mouse up/down to expand/contract the spectrum, horizontally and vertically.

Click this button to increase the intensity by a factor of 2.

Click this button to decrease the intensity by a factor of 2.

Click this button to increase the intensity by a factor of 8.

Click this button to decrease the intensity by a factor of 8.

Click this button to fit the left limit of the spectrum to the left edge of the object bounding box.

Click this button to fit the right limit of the spectrum to the right edge of the object bounding box.

Click this button to fit the upper limit of the spectrum to the upper edge of the object bounding box.

Click this button to fit the lower limit of the spectrum to the lower edge of the object bounding box.

Click this button to reset the expansion and position to default, showing the full spectrum.

The scope of the above buttons can be set, at the top of the dialog, to Spectrum, and/or Integral (see Figure 5.5).
Note that the scope *Integral* is only relevant if the integral labels are actually displayed, i.e. the *Integrals* checkbox is enabled. Furthermore, horizontal scaling or shifting is always applied to spectrum and integrals, independent of the selected scope.

Below these push buttons, you find a number of check buttons (see Figure 5.6) which allow you to enable/disable:

- axes at the top/bottom/left/right of the spectrum
- an X- and/or Y-grid
- integral and/or peak labels

In Figure 5.6 only the axis at the bottom and the peak labels are enabled.

Note that the check buttons *Peaks* and *Integrals* are available for 1D *Spectrum* objects, but not for *FID* objects or 2D *Spectrum* objects.

In some cases, it is useful to exactly define the relationship between the frequency scale and a spectrum’s width, for example if you want to compare spectra or analyze coupling patterns. For this purpose, the *1D/2D-Edit* dialog offers the fields shown in Figure 5.7.

Here you can numerically set:

- the axis unit and scaling value
- the offset position and value

The buttons *Get Values* and *Use Values* allow you to get the current values from the object or use the specified values for the object, respectively.
Note that these fields and buttons are available for 1D Spectrum objects but not for FID or 2D Spectrum objects.

5.7.2 2D spectra

To open the 1D/2D-Editor:

+ Right-click a 2D Spectrum object and choose 1D/2D-Edit

The upper part of the dialog (see Figure 5.8) is basically the same as for 1D Spectrum objects (see above). The middle part offers buttons for scaling and shifting the projections at the Top, Bottom, Left and Right of the 2D spectrum. The lower part of the dialog allows you to set the 2D contour levels.

To add a contour level:

+ Enter a level in the Value field and click Add

To remove a contour level:

+ Select a level and click Remove

To edit all levels:

1. Click Edit
2. In the appearing dialog (see Figure 5.9)
   + Enter the positive and negative base levels, the total number of levels and the increment (multiplication factor) and click OK.

To set/change the color of one or more levels:

1. Select the level(s)
2. Click the desired color in the color table, or click the RGB color field 1).
3. Click Apply.

1) To change the RGB Color, click the RGB ... button.
To create a color flow between 2 contour levels:

1. Select the lowest contour level to be included in the color flow, select its color and click **Apply**.

2. Select the highest contour level to be included in the color flow, select its color and click **Apply**.

3. Select the lowest contour level to be included in the color flow while keeping the **Ctrl** key pressed. Now both the lowest and highest
level are selected.

4. Click the button *Create Color Flow*.

Note that the *Create Color Flow* button is only active if 2 or more contour levels are selected.

![Dialog](image)

**Figure 5.9**

### 5.8 Edit NMR and Standard object properties

Besides attributes and display properties (*1D/2D-Edit*), there is a third way to manipulate spectrum objects; by editing object properties. You can do that for both *Standard* and *NMR* objects.

In order to edit object properties:

+ Right-click the object and choose *Edit* from the popup menu

*or*

+ Double-click the object

Alternatively, you can mark the object and click the *Edit* button of the command bar or click the menu *Edit > Object Properties ...* Note that you can only edit one object at a time. As such, the *Edit* button of the command bar is disabled, if multiple objects are marked.

A dialog will appear showing several tabs which allow you to select the corresponding dialog panes. Note, however, that under Linux, all panes are shown simultaneously and tabs do not exist (see Chapter 12). Under Win-
Handling Objects

dows, the number and type of the tabs/panes, depend on the object being edited. The leftmost tab is selected by default. Table 5.1 shows a list of all tabs/panes, the options/functions they offer and the objects to which they apply.

<table>
<thead>
<tr>
<th>Tab/Pane</th>
<th>Functions</th>
<th>Available for Object</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic</strong></td>
<td>Set object position, dimension and, for some objects, attributes.</td>
<td><strong>NMR</strong>: all</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Standard</strong>: all</td>
</tr>
<tr>
<td><strong>Dataset</strong></td>
<td>Select a dataset from the Data Set Selector/Portfolio.</td>
<td><strong>NMR</strong>: all</td>
</tr>
<tr>
<td></td>
<td>Set limits, axes, grids, bounding box and attributes.</td>
<td></td>
</tr>
<tr>
<td><strong>Graph</strong></td>
<td></td>
<td><strong>NMR</strong>: 1D Spectrum, FID, 2D spectrum, Stacked Plot and T1/T2</td>
</tr>
<tr>
<td><strong>1D Spectrum</strong></td>
<td>Set axis units, peaks/integral settings, X-axis scaling info.</td>
<td><strong>NMR</strong>: 1D Spectrum</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Edit text and set resize and alignment options.</td>
<td><strong>NMR</strong>: Title, Parameters, Text</td>
</tr>
<tr>
<td><strong>Parameter</strong></td>
<td>Set electronic signature options.</td>
<td><strong>Standard</strong>: Text (ABC)</td>
</tr>
<tr>
<td><strong>NMR Text</strong></td>
<td>Select the NMR Text file.</td>
<td><strong>NMR</strong>: NMR Text</td>
</tr>
<tr>
<td><strong>Metafile object</strong></td>
<td>Select metafile and set resize and dimension options.</td>
<td><strong>Standard</strong>: Metafile object</td>
</tr>
<tr>
<td><strong>2D Spectrum</strong></td>
<td>Set axis units and contour level attributes.</td>
<td><strong>NMR</strong>: 2D Spectrum</td>
</tr>
<tr>
<td><strong>2D Projection</strong></td>
<td>Select projection dataset, set projection size.</td>
<td><strong>NMR</strong>: 2D Spectrum</td>
</tr>
<tr>
<td><strong>T1/T2</strong></td>
<td>Set tags and annotations.</td>
<td><strong>NMR</strong>: T1/T2 data</td>
</tr>
<tr>
<td><strong>Arrow</strong></td>
<td>Set arrow style, direction and size.</td>
<td><strong>Standard</strong>: Line, Polyline and Open Bezier Curve</td>
</tr>
</tbody>
</table>

**Table 5.1** Tabs in Edit dialog of various objects
5.8.1 Edit 1D-Spectrum properties

To edit the properties of a 1D Spectrum object:

+ Right-click in the object and choose Edit from the popup menu.

The 1D Spectrum Edit dialog will appear, with the Graph tab selected (see Figure 5.10). Three further tabs 1D Spectrum, Data Set and Basic are available.

---

The Graph pane

The Graph pane of the Edit dialog shows four sections: Plot, Axes, Grids and Curve, offering various options/functions (see Figure 5.10).

Plot section: limits and bounding box properties.
• **Xmin / Xmax**: X-direction limits of the object. For a 1D spectrum, these determine the displayed spectral region.

• **Ymin / Ymax**: the Y-direction limits of the object. For a 1D spectrum these determine the minimum and maximum intensity.

• **Scale bounding box** (unchecked by default): when checked, the bounding box, which determines the logical position and dimension of the object, includes the axes, peak labels and integral labels. It should be checked when grouping a *Spectrum* object with a frame and unchecked when grouping a *Spectrum* object with an annotation (text and line object).

• **Draw Box around curve** (unchecked by default): when checked, a box is drawn around the curve object.

### Axes section

• **Top, Bottom, Left, Right**: check buttons to show/hide the respective axes. By default, only the bottom axis (X-axis) is shown.

• **Attributes**: axis attributes like line color/style and font style/size.

• **X-Axis offset, Y-axis offset**: sliders to set the distance (in cm) between the axes and the spectrum.

### Grids section

• **X axis, Y axis**: check buttons to switch on/off the respective grids. Switched off by default.

• **Attributes**: grid attributes like line color/style.

Note that the *Graph* pane is only available in the *Edit* dialog of objects that support axes and grids, like the *NMR* objects 1D *Spectrum*, 2D *Spectrum* and *Stacked Plot*.

### The 1D Spectrum pane

The *1D spectrum* pane of the Edit dialog shows four sections: **Units**, **Peaks, Integrals** and **Scaling Info**, offering various options/functions (see Figure 5.11).

#### Units section

• **X-Axes**: radio buttons to select the axis units: *ppm, Hz* or *Points*
• **Peak Labels**: radio buttons to select the peak label units: ppm, Hz or Points

![Figure 5.11](image)

**Peaks** section

- **Show Peak Marks**: check button to show/hide peak marks
- **Show Peak Labels**: check button to show/hide peak labels
- **Text Format**: text field to specify the peak label text format. This is a C-language format identifier. Default is “%.3f”, which is a double with a 3-digits decimal part. Here you can change the number of decimals show for the peak labels.
- **Attributes**: peak label attributes like line color/style and font color/style/size

- **Show Peak Positions and/or Annotations** \(^1\): radio button to show peak positions and/or annotations

**Integrals** section

- **Show Integrals**: check button to show/hide integrals traces

- **Ymin / Ymax**: the Y-direction limits of the integrals

- **Show Integral Labels**: check button to show/hide integrals labels

- **Text Format**: text field to specify peak label text format. This is a C-language format identifier. Default is “%.3f”, which is a double with a 3-digits decimal part. Here you can change the number of decimals show for the peak labels.

- **Labels above X axis**: check button to place the integral labels above (checked) or below (unchecked) the axis.

- **Attributes**: integral label attributes like line color/style and font color/style/size

**Scaling Info** section

- **Show Scaling Information for X axis**: check button to show/hide the Scale: \( ppm/cm \) and \( Hz/cm \), below the X-axis (see Figure 5.12).

\(^1\) Only implemented in TOPSPIN 2.1 and newer.
This information is immediately updated whenever the X-axis scaling changes, e.g. when the spectrum is expanded or compressed or when the object dimension is changed. This counts for both interactive plotting and in automation.

**The Data Set pane**

The *Data Set* pane shows one section allowing you to select the associated dataset (see Figure 5.13). The pathname of the dataset is shown in the *Data* field. To change the dataset, click the *Select* button. This will open the Data Set Selector dialog where you can select a new dataset. If the desired dataset is not listed here, click the *Edit* button to open the Portfolio Editor, select and append the dataset and click *Apply* to update the Data Set Selector.

![Figure 5.13](image)

**The Basic pane**

The *Basic* pane shows one section with the object position and dimension (see Figure 5.14). Here you can set the X and Y positions (in cm) with respect to the plot area origin as indicated by the faint dashed square.
Furthermore, you can set the object dimension (in cm) in X and Y.

![Figure 5.14](image)

**5.8.2 Edit Title properties**

To edit the properties of a *Title* object:

1. Right-click in the object and choose *Edit* from the popup menu.

The *Title* Edit dialog will appear, with the *Text* tab selected showing the corresponding pane (see Figure 5.15).

The tabs/panes *Data Set* and *Basic* are the same as for a 1D *Spectrum* object (see paragraph 5.8.1).
The **Text pane**

The **Text** pane show three sections, **Text**, **Alignment** and a ‘**General**’ section:

**Text** section

- **Allow automatic font resize**
  Check button to enable/disable automatic adjustment of the font size when the object is resized.

- **Edit**
  Push button to open an editor where you can edit the text content of the object (see Figure 5.15). For the *Title* object, this allows you to change the plot title 1).

---

1) Note that these changes are only valid for the current Plot Editor session. They are not transferred to the TOPSPIN data window nor are they stored in the layout or dataset. The original title is restored if you update the data from the dataset (menu **TOP-SPIN**).
The dialog offers the following buttons:

**Load Text**

Opens a browser where you can select or enter a text file to be loaded.

**Paste**

Pastes the text currently on the Clipboard to the *Edit* text dialog.

**Character Map**

Opens a character chart, with standard and special characters (characters not available on the keyboard).

![Character Map](image)

**Figure 5.16**

To insert one or more characters into the text:

a) In the *Character Map* dialog: double-click the desired character(s)
b) In the *Edit text* dialog: click *Paste* and then *Close*

c) In the *Edit* dialog: click *Apply* or *OK*

The character(s) will be inserted in the current text at the cursor position.

**Alignment** section

- *Alignment - Vertical / Horizontal*
  Radiobuttons to select vertical and horizontal text alignment.

‘General’ section

- *Do not change ’hotpoint’ if alignment changes* (unchecked by default)
  Check button to enable/disable keeping the same hot point (anchor point) when changing the alignment.

- *Recalculate object dimensions* (checked by default)
  Check button to enable/disable recalculation of the object dimensions to fit the text. Useful after changing the text content, i.e. the plot title.

The check buttons in the ‘General’ section are one time actions, performed on clicking *OK* or *Apply*. Their settings are not stored (like the check button *Allow automatic font resize*) so the next time you open the *Edit* dialog, their default settings appear.

Note that the title displayed in the *Title* object, is normally defined in ICON-NMR automation or, manually, by clicking the *Title* tab of the TOPSPIN data window.

5.8.3 **Edit Parameters** Object properties

To edit the properties of a *Parameters* object:

+ Right-click in the object and choose *Edit* from the popup menu.

The *Parameters Edit* dialog will appear, with the *Text* tab selected showing the corresponding pane. The dialog is the same as for the *Title* object (see paragraph 5.8.2), except for the additional *Parameter* tab/pane (see Figure [1]).

---

1) Stored in the file *title* in the dataset PROCNO directory.
5.17)

This pane shows one section for setting electronic signature options.

If the check button *Include electronic signature information* is enabled, the information entered with the Topspin command *esign* will be displayed in the *Parameters* object. e.g.:

Electronic Signature:
USER ID     james
USER NAME   James Evans
MEANING     review
COMMENT     Spectrum quality is ok!

If *Warn if signature is missing* is enabled and no electronic signature has been created, the entry:

Electronic Signature:Not signed

will be displayed in the *Parameters* object.

If *Warn if signature is invalid* is enabled and the electronic signature has been modified outside of TOPSPIN, the entry:
5.8.4 Edit FID object properties

To edit the properties of an FID object:

+ Right-click in the object and choose Edit from the popup menu.

The FID Edit dialog will appear, with the Graph tab selected showing the corresponding pane. The dialog is exactly the same as for a 1D Spectrum object, except that it has no 1D Spectrum tab/pane.

5.8.5 Edit NMR Text object properties

The NMR text object can be used to include dataset specific information. This is usually an external text file stored in the dataset PROCNO directory. TOPSPIN 2.1 and newer also support to include the sample information specified under the TOPSPIN data window tab Sample.

To edit the properties of an NMR Text object:

+ Right-click in the object and choose Edit from the popup menu.

The NMR Text Edit dialog will appear, with the Text tab selected showing the corresponding pane. The dialog is the same as for the Title object (see paragraph 5.8.2), except for the additional NMR Text pane (see Figure 5.18). In the field Text File, you can specify the pathname of a text file to be included in the plot. Here, you have the following options:

- Specify absolute pathname, e.g.:
  
  C:/TEMP/my_nmr_info.txt

- Specify a file in the user home directory, e.g.:

  ~/my_nmr_info.txt

- Specify a file in the dataset PROCNO, e.g.:

  +/my_nmr_info.prop

- Specify a file in the dataset EXPNO, e.g. the sample information file:

  +/../../sample_info.prop

Alternatively, you can click the Browse button and specify or enter the text
file in the appearing browser.

5.8.6 Edit 2D-Spectrum properties

To edit the properties of a 2D Spectrum object:

+ Right-click in the object and choose Edit from the popup menu.

The 2D Spectrum Edit dialog will appear, with the Graph tab selected.

The tabs/panes Graph, Data Set and Basic are the same as for a 1D Spectrum object. Furthermore, the tabs 2D Spectrum and 2D Projections are available.

The 2D Spectrum pane

The 2D spectrum pane of the Edit dialog shows two sections: Units and Levels.

Units section
• **X-Axes**: radio buttons to select the X-axis units: *ppm, Hz, Points or Sec*

• **Y-Axes**: radio buttons to select the Y-axis units: *ppm, Hz, Points or Sec*

---

**Figure 5.19**

**Levels** section

- **Attributes**: attributes like line color/style and fill color/style for **Negative** and **Positive** levels.  

---

1) Note that you can also assign different colors to individual levels (see paragraph 5.7.2)
The 2D Projections pane

The 2D Projections pane of the Edit dialog shows two sections: Data Sets and Curves (see Figure 5.20).

Data Sets section

- **Top, Bottom, Left, Right**: checkbuttons to enable/disable corresponding projections.

  For each orientation, the following options are available:
  - **Size**: projection spectrum height in cm.
  - **Select...** pushbutton to open the Data Set Selector where you can select the dataset to be shown as projection.

Curves section

- **Attributes**: projection attributes like line color/style and fill color/style.
A stacked plot is a plot of a series of 1D spectra, which are plotted at a certain offset. The spectra are taken from the Data Set Selector, in ascending order.

To edit the properties of a Stacked Plot object:

- Right-click in the object and choose Edit from the popup menu

The Stacked Plot Edit dialog will appear, with the Graph tab selected showing the corresponding pane. The tabs/panes Graph, 1D Spectrum, Data Set and Basic are the same as for a 1D Spectrum object. Furthermore, the tab Stacked is available.
The Stacked tab

Clicking the **Stacked** tab opens the dialog shown in Figure 5.21. Here you can set the following options/functions:

**Number of Stacked Spectra**
The number of 1D spectra to be shown in the **Stacked plot** object. Note that at least this number of spectra must be available in the Data Set Selector.

**Spectra Offset**
Horizontal and vertical distance between the spectra in the **Stacked plot** object.
Set curve attributes to “White Wash” on OK
Checkbox to enable/disable the White Wash effect. Note that in the Curve Attributes (Graph pane), Fill Style must be set to Solid to see the effect.

Note that the checkbox Set curve attributes to “White Wash” on OK defines a one time action on OK. It is always disabled on opening the Edit dialog.

Figure 5.22 shows an example of a white washed stacked plot.

Figure 5.22 shows an example of a white washed stacked plot.

The spectra included in a stacked plot may differ in sweep width and/or chemical shift offset. The X-limits of the stacked plot are set such that the full sweep width of each spectrum is displayed. For example, if a stacked plot includes the following two spectra:

   Spectrum 1: 100 - 50 ppm
   Spectrum 2: 80 - 0 ppm

the X-axis of the stacked plot will run from 0 to 100 ppm. The reference
peak for intensity scaling will be the highest peak of all spectra displayed in the stacked plot (see also paragraph 8.4).

5.8.8 Edit \textit{T1/T2} Object properties

To edit the properties of an \textit{T1/T2} object:

+ Right-click in the object and choose \textit{Edit} from the popup menu.

The \textit{T1/T2} Edit dialog will appear (see Figure 5.23). It shows the tabs/panes \textit{Graph, Data Set} and \textit{Basic}, which are the same as for a 1D \textit{Spectrum} object. Additionally, it shows the tab \textit{T1/T2}, which allows you to set tags and annotations.
5.8.9 Edit Line and Polyline properties

To edit the properties of a Standard Line or Polyline object:

+ Right-click in the object and choose Edit from the popup menu.

The Line Edit dialog will appear. It shows the Basic tab, which is the same as in all other objects, allowing you to set the object’s position, dimension and attributes. Additionally, it shows the Arrow tab, which allows you to select the arrow type and set the arrow tip width (see Figure 5.24)

![Figure 5.24](image)

5.9 Reset Actions of NMR Spectrum objects

NMR Spectrum objects define the so-called Reset Actions; a set of rules, which control the plot region, intensity scaling and baseline position.

Reset Actions can be set as follows:

+ Right-click in a spectrum object and choose Automation from the popup menu.

Reset Actions can be executed as follows:

+ Right-click in a spectrum object and choose Reset Object from the popup menu.
Reset actions are discussed in detail in Chapter 8

### 5.10 Axis tick settings of NMR Spectrum objects

NMR Spectrum objects contain a set of *Axis Tick Settings*. These can be set as follows:

1. Right-click in a spectrum object and choose *Axis Tick Settings...* from the popup menu.

2. In the appearing dialog:

   ![Axis Tick Settings Window](image)

   **Figure 5.25**

   a) Click one of the radio buttons *Calculate axis ticks automatically* or *Fixed settings*.

   b) If you chose *Fixed settings*, enter the distance for the axis labels, the # of minor ticks and the # of decimals, for both X- and Y-axis.

   c) Click *OK* to save the changes and close the dialog.
Chapter 6
Handling Layouts

The Plot Editor is based on the concept of layouts. A layout is a template, which defines a number graphical objects, which can be Standard graphics or NMR objects. One layout can be used for different datasets and, vice versa, one dataset can be plotted with different layouts. TOPSPIN is delivered with a large set of layouts for plotting various standard 1D and 2D experiments. Bruker layouts can be modified to your needs and new layouts can be created, both for interactive usage and automation.

6.1 Selecting a layout

The plot layout, used by the commands plot and autoplot, is defined by the processing parameter LAYOUT. To check or set the current layout, enter layout on the command line. This will open a dialog, showing the current value of the LAYOUT parameter, the name of the currently used
layout file (see Figure 6.1).

![Figure 6.1](image)

Note that the layout filename is prepended with the characters “+/”. This indicates that the file is located in the layout search path (see paragraph 6.2).

The parameter LAYOUT may specify multiple layouts, separated by semicolons (see Figure 6.2). The command `autoplot` creates as many plots as there are layouts specified in LAYOUT. This feature is especially used in automation, for example to plot data on two different printers. The command `plot` only interprets the first layout specified by the parameter LAYOUT.

![Figure 6.2](image)

Note that the LAYOUT parameter can also be set by clicking the `ProcPars` tab of the data window, selecting the `Automation` section.

### 6.2 Layout Storage Directories

Standard plot layouts, delivered with TOPSPIN, are stored in the directory:

```
<tshome>/plot/layouts
```

The layout search path consists, by default, of this directory only. You can extend the search path (see paragraph 6.2.1). Furthermore, you can spec-
ify the layout directory when setting the LAYOUT parameter (see para-

6.2.1 Extending the layout search path

dographs 6.2.2).

TOPSPIN 2.0 and newer allow you to extend the layout search path. This is, for example, interesting if you want to change Bruker layouts, store them under the same name and use them with standard Bruker experiments.

To extend the layout search path:

1. Click Options ’ Preferences.
2. In the appearing User Preferences dialog:
   a) Click Directory Path Names in the left part of the dialog.
   b) Click the Change button for the item Global search path for plot lay-
      outs.
   c) Enter the Administrator password as requested.
   d) Enter the search path in the appearing dialog (see Figure 6.3).
   e) Click OK to close the dialog
   f) Click OK to close the User Preferences dialog

Now, the commands plot and autoplot, as well as ICON-NMR automation will use the search path for locating the layout specified by the LAYOUT parameter.

6.2.2 Alternative layout directories

Although layouts are normally stored in the directories of the global search
path, they can be stored in and read from any directory. Typical examples are the dataset PROCNO or the user home directory.

To specify the layout directory, you can use the abbreviations "+", "~" or "]":

- +: the standard layout directory e.g.:
  
  
  `/1D_H+lf.xwp`

  stands for `<tshome>/plot/layouts/1D_H+lf.xwp`  

- ~: the user home directory, e.g.:

  `/my_layouts/layout1.xwp`

  stands for `<userhome>/mylayouts/layout1.xwp`

- # : current processed data directory (see Figure 6.4), e.g.:

  `/layout.xwp`

  stands for:

  `<dir>/data/<user>/nmr/<name>/expno/pdata/procno/layout.xwp`

Furthermore, you can specify the full layout pathname, e.g.

`C:\TEMP\my_layout.xwp`

The commands `plot` and `autoplot` can be forced to use a different layout then specified by the parameter LAYOUT, by using command line arguments. Here you can use the same abbreviations as described above, e.g.:

![Layout dialog box](image)

**Figure 6.4**

Furthermore, you can specify the full layout pathname, e.g.

```
C:\TEMP\my_layout.xwp
```

1) or the extended layout search path as set in the User Preferences.

2) where `<userhome>` stands for the user home directory (default C:\Documents and Settings\<username> under Windows XP and /home/<username> under Linux.
plot C:\TEMP\my_layout.xwp
Open the Plot Editor using layout C:\TEMP\my_layout.xwp

plot ~/my_layouts/layout1.xwp
Open the Plot Editor using layout <userhome>/my_layouts/
layout1.xwp

autoplot ~/my_layouts/layout1.xwp
Plot the current dataset using layout <user_home>/my_layouts/
layout1.xwp

Note that if the specified layout does not exist, plot will prompt you to create
a new layout by that name or abort. The command autoplot, however, will plot the data anyway, using the layout specified by the parameter
LAYOUT. The reason is that autoplot is used in automation.

6.3 Using predefined layouts

Let’s start by opening the Plot Editor with an existing layout and then read a
new layout from the Plot Editor interface.

Exercise 19

1. Open the 1D dataset exam1d_1H/1/1.

2. Enter layout on the command line. In the appearing dialog, select
the standard layout 1D_H.xwp (if it is not already selected).

3. Enter plot. The Plot Editor interface will appear, showing the spec-
trum according to the layout 1D_H.xwp (see Figure 6.5).

Now let’s look at the same dataset with a different layout.

4. Click File ’ Open [Ctrl+o ]

5. In the appearing dialog:
   a) Navigate to the layout directory <tshome>/plot/layouts 1)
   b) Select or enter the layout 1D_H+pp.xwp.

1) <tshome> is the TOPSPIN home directory (default C:\Bruker\TOPSPIN under Windows
and and /opt/topspin under Linux).
6. In the Plot Editor interface:
   a) Click *File* → *Print* \([Ctrl]+p\), select the printer in the appearing dialog and click *Print*.
   b) Click *File* → *Exit* to close the Plot Editor.

The plot on the paper should be the same as the white area in the Plot Editor interface.

### 6.4 Saving modified layouts

If you have modified an existing layout or created a new layout, you can save it for later usage. Modified Bruker layout can be saved, under a different name or under the same name, in a different directory.
6.4.1 Saving a Bruker layout

Bruker layouts are write protected. Modified Bruker layout can be saved under a different name or in a different directory.

To save a Bruker layout under a different name:

7. Click *File* ’ *Save as*...
8. In the appearing dialog:
   a) Specify or select a layout filename.
   b) Click *Save*.

To save a Bruker layout under the same name, in a different directory:

1. Click *File* ’ *Save as*...
2. In the appearing dialog:
   a) Navigate to the desired directory
   b) Click *Save*.

The second possibility allows you to easily run ICON-NMR with your own layouts, e.g. with your company logo, using Bruker experiments. Note that you need to set the layout search path to do this (see paragraph 6.2.1).

6.4.2 Saving a User defined layout

User-defined layouts are writable for the user who created them. You can save your own layouts as follows:

+ Click *File* ’ *Save* [*Ctrl+s*] to save the layout under the same name, overwriting the current file.

*or*

+ Click *File* ’ *Save as*.... to save the layout under a new name.

In the appearing dialog:
   a) Navigate to the desired directory.
   b) Click *Save*.

1) This directory must be added to the layout search path in User Preferences (command *set*)
If you exit the Plot Editor without having saved a modified layout, you will be prompted to save it first.

### 6.4.3 Saving a Bruker or User-defined Layout in the Dataset

Plot Editor allows you to store the layout used on a particular dataset, in that dataset. As such you can to archive your data with the used layout or copy them to another user or computer.

To save the layout to the dataset:

1. Click **File’ Save Layout/Portfolio to Dataset**.
2. In the appearing dialog:
   
   a) Enter a filename or accept the default name `layout.xwp`.
   
   b) Click **Save**

Note that this will not only save the layout but also the current portfolio under the filename `portfolio.por`.

The default storage directory is the PROCNO subdirectory of the current dataset (the first dataset in the Data Set Selector). You can however, navigate to any directory and store the layout and portfolio there.

### 6.5 Creating New Layouts

In this paragraph we will create a new layout from scratch. So we’ll start with a blank layout area and insert *NMR* and *Standard* objects.

**Exercise 20**

1. Open the 1D dataset `exam1d_1H/1/1`
2. Enter `plot`. The Plot Editor interface will appear.
3. Click **File’ New**
   
   A new empty layout will appear.  

4. Make sure the radio button *NMR* at the left of the Plot Editor interface

---

1) On a Windows computer, the original layout is still available in the **Window** menu.
is enabled (see Figure 6.6).

![Figure 6.6](image_url)

5. Create NMR objects as follows:
   a) Click the 1D Spectrum icon:

   ![1D Spectrum icon](image_url)

   Place the cursor somewhere in the lower left part of the layout area. Click-hold and move the mouse to draw the Spectrum object and release the mouse.

   a) Click the 1D FID icon:

   ![1D FID icon](image_url)

   Place the cursor in the layout area somewhere above the Spectrum object. Click-hold and move the mouse to draw the FID object and release the mouse.

   b) Click the Title icon:

   ![Title icon](image_url)

   Place the cursor in the layout area, click-hold and move the mouse to position the Title object, e.g. in the upper left corner, and release the mouse.

   c) Click the Parameters icon:

   ![Parameters icon](image_url)

   Place the cursor in the layout area, click-hold and move the mouse to position the Parameters object, e.g. in the lower right corner, and release the mouse.

   You can click-hold any object and move the mouse to change its position.

6. Click the radio button Standard at the left of the Plot Editor interface (see Figure 6.6).

   d) Click the Text icon:

   ![Text icon](image_url)

   Place the cursor in the layout area at a position near the Spectrum object. Left-click and enter any text string as annotation. Move the mouse to adjust the object position (if necessary) and left-click to fix it.
e) Click the *Lines* icon:

Place the cursor in the layout area, just below the annotation *Text* object. Click-hold and move the mouse to draw a *line* object. Double-click the *Line* object, select the upper-right (arrow) **Type** and click **OK** to turn the line into an arrow.

f) Click the *Meta* icon:

Place the cursor in the upper right corner of the layout area. Double-click the *Meta* object ¹), click the **Browse** button in the appearing dialog and select the file `<tshome>/plot/layout/meta/bruker.wmf` ²) or any other `.wmf` or `.emf` file and click **OK**.

7. Click *File ’ Print [Ctrl+p]* to print the layout. The printout on paper should be exactly the same as the white area in the layout area.

8. Now save the new layout for later usage: click *File ’ Save As...* enter a filename with the extension `.xwp` and click **Save**.

---

¹) On Linux systems, click the EPSI icon and browse for an EPSI file (see also Chapter 11).
²) `<tshome>` is the TOPSPIN home directory (default C:\Bruker\TOPSPIN under Windows and `/opt/topspin` under Linux).
Handling Layouts

9. Click File → Exit to leave the Plot Editor.

6.6 Modify an existing layout

Layouts can be modified by adding, manipulating or removing objects as described in Chapter 5.

6.7 Printing the current layout

The graphics created by the PLOT EDITOR can be printed from the Plot Editor interface of from the TOPSPIN command line.

Printing a Layout from the Plot Editor interface

1. Click File → Print [Ctrl+p].
2. In the appearing dialog:
   a) Select the printer.
   b) Optionally: click To File, if you want to store the output into a file 1) rather than send it to the printer.
c) Click *Print*

**Printing a Layout from the TOPSPIN command line**

1. Enter `layout`. In the appearing dialog, select the desired layout.
2. Enter `autoplot`.

### 6.8 Exporting the current layout

**PLOT EDITOR** allows you to export the layout area to various graphics formats like EMF, PS, PDF and PNG. Exported files can be imported by other applications like Word, Coreldraw, Powerpoint etc. To export the current layout:

1. Click *File ’Export*.
2. Select or enter the name and type of the export file in the appearing dialog and click *Save*.

Details on exporting graphics can be found in Chapter 10.

---

1) The plot is saved in the natural printer format according to the printer setup.
Chapter 7
Plotting in Automation

NMR data are often acquired, processed and plotted in automation, using ICON-NMR and/or Python or AU programs. Plotting in automation uses the same plot layouts and portfolios used for the interactive Plot Editor. Furthermore, plotting in automation uses the so called Reset Actions to control plot regions, intensity scaling and baseline positions.

7.1 ICON-NMR automation flow

To fully understand how plotting in automation works, we’ll briefly look into the ICON-NMR automation flow. ICON-NMR allows you to measure a series of samples, defining one or more Experiments for each sample. Experiments are defined by parameter sets, which contain acquisition and processing parameters. For each experiment, ICON-NMR runs two AU programs; one for acquisition and one processing/plotting. Let’s first define a few things:

Experiments

Experiments are parameter sets, which define the experiment to be performed. They contain parameters for acquisition and parameters for processing/plotting. The parameters used for plotting in automation are:

- AUNMP - the AU program used for processing and plotting
• F1P/F2P - the plot limits defining the region to be displayed/plot-
ted
• CY - the intensity scaling factor (cm)
• LAYOUT - the plot editor layout to be used for plotting

Examples of frequently used Bruker experiments are PROTON for 1D experiments and COSY45SW for 2D experiments. For each experiment, ICON-NMR creates a dataset directory with the acquisition and processing/plotting parameter files.

AU programs

AU programs are automation programs executed to acquire or process/plot data. The AU program that acquires the raw data is defined by the parameter AUNM. The AU program that processes and plots the data is defined by the parameter AUNMP. Examples of frequently used Bruker AU programs are au_zg for acquisition, proc_1d for 1D processing/plotting and proc_2dsym for 2D processing/plotting. AU programs can be viewed/edited with the command edau.

AU macros

AU macros are AU program statements. Bruker AU programs for processing/plotting contains processing macros like EF and APK and plot macros like AUTOPLOT. Further plot macros are AUTOPLOT_WITH_PORTFOLIO and ADD_TO_PORTFOLIO. TOPSPIN 2.0 and newer also contain macros for automatic creation of layouts (see Help’ Manuals’ Programming manuals’ Plot Layout Programming)

Plot layouts

A plot layout is a template defining graphical objects, used for interactive and automated plotting. ICON-NMR plots a dataset according to the layout defined by the parameter LAYOUT. Examples of frequently used layouts are 1D_H.xwp for 1D data and 2D_hom.xwp for 2D data.

The interaction between these elements involved in plotting in automation is shown in Figure 7.1.
ICONNMR

Experiments (parametersets)

**PROTON**
- AUNM = au_zg
- AUNMP = proc_1d
- LAYOUT = 1D_H.xwp

**COSY45SW**
- AUNM = au_getlcosy
- AUNMP = proc_2dsym
- LAYOUT = 2D_hom.xwp

Processing AU programs

- proc_1d
- proc_2dsym
- EF
- XFB

AU macros

AUTOPLOT

Plot layouts

Figure 7.1
7.2 User defined layouts in automation

In TOPSPIN 2.0 and newer, the commands `plot` and `autoplot` use a configurable search path to locate the specified layout.

This feature has important advantages. It allows you to:

- store layouts on a central server in the network
- use Bruker standard experiments and plot with your own layouts

Suppose you want to use the standard Bruker experiments, but use modified plot layouts, e.g. with your company logo. Now you can simply modify Bruker layouts, store them, under the same name in a different directory. The storage directory must be added to the search path in the User Preferences (command `set`). If the layout specified by the parameter LAYOUT exists in this directory, it is used, otherwise the standard Bruker layout is used.

Exercise 21

1. Enter `new`, define a new (dummy) dataset in the appearing dialog and click `OK` to create it.

2. Make a list of Bruker experiments (parameters sets) that you will use in ICON-NMR (enter `rpar` to get a list of all experiments).

3. For each experiment, find out which Bruker layout it uses for plotting. To do that:
   a) Enter `rpar <experiment_name> all`
   b) Enter `layout`

   Probably many experiments will use the same plot layout.

Now perform step 4 to 7 for each layout.

4. Enter `layout` on the command line. In the appearing dialog, select the chosen layout.

5. Enter `plot` to open the Plot Editor interface.

6. Modify the Bruker layout according to your wished (see Chapter 5).

7. Click `File > Save` and store the modified layout in a directory different from `<tshome>/plot/layouts`, e.g. C:\plot_layouts.

8. Click `File > Exit` to close Plot Editor.
9. Run ICON-NMR experiments. The data will be plotted with the modified layouts.

10. Note that layout search path may contain multiple directories, e.g.:

    **Under Windows** C:\plot_layouts;D:\2D_layouts

    **Under Linux:** /opt/topspin/layouts:/home/nmr/my_layouts
### 7.3 AU macros for plotting

#### Plot macros

<table>
<thead>
<tr>
<th>Macro Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTOPLOT</td>
<td>Plot the current data according to the layout defined by LAYOUT.</td>
</tr>
<tr>
<td>AUTOPLOT_TO_FILE</td>
<td>Plot the current data to a file according to the layout defined by LAYOUT.</td>
</tr>
<tr>
<td>AUTOPLOT_WITH_PORTFOLIO</td>
<td>Plot the data in the portfolio created by CREATE_PORTFOLIO.</td>
</tr>
<tr>
<td>AUTOPLOT_WITH_PORTFOLIO_TO_FILE</td>
<td>Plot the data in the portfolio, created with CREATE_PORTFOLIO, to a file.</td>
</tr>
</tbody>
</table>

#### Portfolio macros

<table>
<thead>
<tr>
<th>Macro Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CREATE_PORTFOLIO(pathname)</td>
<td>Create and activate the portfolio specified by the pathname.</td>
</tr>
<tr>
<td>ADD_TO_PORTFOLIO(d, u, n, e, p)</td>
<td>Add to the active portfolio the dataset specified by the dir, user, name, expno and prochno.</td>
</tr>
<tr>
<td>ADD_CURDAT_TO_PORTFOLIO</td>
<td>Add current dataset to the active portfolio.</td>
</tr>
<tr>
<td>CLOSE_PORTFOLIO</td>
<td>Close the active portfolio.</td>
</tr>
</tbody>
</table>

#### Layout macros

<table>
<thead>
<tr>
<th>Macro Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAYOUT_ADD</td>
<td>Add object to current layout.</td>
</tr>
<tr>
<td>LAYOUT_ADD_1D_OBJECT</td>
<td>Add 1D object to current layout.</td>
</tr>
<tr>
<td>LAYOUT_ADD_PARAMETERS</td>
<td>Add Parameters object to current layout.</td>
</tr>
<tr>
<td>LAYOUT_BEGIN_FILE</td>
<td>Open layout file.</td>
</tr>
<tr>
<td>LAYOUT_END_FILE</td>
<td>Close layout file.</td>
</tr>
<tr>
<td>LAYOUT_FORMAT</td>
<td>Define layout format.</td>
</tr>
<tr>
<td>LAYOUT_OBJ_1D</td>
<td>Define 1D object.</td>
</tr>
<tr>
<td>LAYOUT_OBJ_PARAMETERS</td>
<td>Define Parameters object.</td>
</tr>
<tr>
<td>LAYOUT_OBJ_TITLE</td>
<td>Define title object.</td>
</tr>
</tbody>
</table>
7.4 Plotting from AU programs

AU programs are mainly used by ICON-NMR automation. They can, however, also be executed from the TOPSPIN command line. Plotting in AU programs is done in form of AU macros. There are macros for plotting the data, handling portfolios and creating layouts. Probably the most important macro is AUTOPLOT, which executes the command `autoplot` and plots the current dataset according to the layout defined by the parameter LAYOUT. A simple AU program for plotting the current dataset is created in the following exercise.

**Exercise 22**

1. Open the 1D dataset exam1d_1H/1/1.
2. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.
3. Enter `layout` on the command line. In the appearing dialog, select the standard layout 1D_H.xwp (if it is not already selected).
4. Enter `edau my_plot_au`
5. In the appearing editor:
   a) enter the following two lines:
   
   ```
   AUTOPLOT
   QUIT
   ```
   b) save and quit the editor.
6. Enter `my_plot_au`
   
   The current dataset will be plotted according to the chosen layout.

Note that this is a trivial example for exercise purposes only. It does exactly the same as the command `autoplot` entered on the command line.

A practically useful example is the Bruker standard AU program `proc_1d`, used for processing and plotting standard 1D experiments. Let’s have a look at this AU program.

**Exercise 23**

1. Open the 1D dataset exam1d_1H/1/1.
2. Select a certain spectral region. To do that, click-hold in the data win-
dow and drag the cursor line along the desired region.

3. Enter `layout` on the command line. In the appearing dialog, select the standard layout `1D_H.xwp` (if it is not already selected).

4. Enter `edau proc_1d`
   Just scroll through the AU program code and note the macro `AUTOPLOT` at the end. Close the editor.

5. Enter `proc_1d` to execute the AU-program.
   The current dataset will be processed and plotted according to the chosen layout.

Now let's create a new AU program using various plot related macros.

Exercise 24

1. Open the 1D dataset `exam1d_1H/1/1`.

2. Enter `wrp 2` and `wrp 3` to create the PROCNO's 2 and 3.

3. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.

4. Enter `layout` on the command line. In the appearing dialog, select the standard layout `1D+1D+1D.xwp`.

5. Enter `edau my_plot_au`

6. In the appearing editor:
   a) Enter the following lines:

   ```
   CREATE_PORTFOLIO("/tmp/myPortfolio.por")  
   ADD_CURDAT_TO_PORTFOLIO IPROCNO  
   ADD_CURDAT_TO_PORTFOLIO IPROCNO  
   ADD_CURDAT_TO_PORTFOLIO IPROCNO  
   CLOSE_PORTFOLIO  
   DPROCNO  
   DPROCNO  
   AUTOPLT_WITH_PORTFOLIO
   ```

1) Use straight quotes because with so called smart quotes the AU program might not compile.
7. Enter *my_plot_au* on the **TOPSPIN** command line.

This AU program will plot the PROCNO’s 1, 2 and 3 on one sheet according to the layout 1D+1+1D.xwp. The plot will also be stored in a Postscript file.

### 7.5 Plotting from AU programs to Postscript or PDF

Data can be plotted from an AU program to a file, e.g. a Postscript or PDF file, by using the respective macros, or arguments.

**Using macros**

The following macros send the plot to a file rather than to the printer:

- **Autoplot_to_file**
  plot the current dataset to a file. Executes the command *autoplot -e*.

- **Autoplot_with_portfolio_to_file**
  plot the dataset(s) in the portfolio created with the macro **create_portfolio** to a file.

The AU program *my_plot_au* in paragraph paragraph 7.4 shows an example of using the second macro.

**Using arguments**

AU programs that contain the regular **autoplot** macro send the plot to the printer. They can additionally send the plot to a file by entering the AU program name with one of the following arguments:

- **a** - store the output in the current dataset PROCNO, in a PDF file named `email_<name>_<expno>_<procno>.pdf`

- **e** - store the output in the current dataset PROCNO, in a Postscript file named `email_<name>_<expno>_<procno>.ps`
Plotting in Automation

\[ h \] - store the output in the users home directory, in a Postscript file named
\[ \text{nrm}_<\text{name}>_<\text{expno}>_<\text{procno}>.ps \]

\[ t \] - store the output in the system TEMP directory, in a Postscript file
named
\[ \text{nrm}_<\text{name}>_<\text{expno}>_<\text{procno}>.ps \]

You can use multiple arguments to send the plot to multiple files. For example, the following command entered on dataset exam1d_1H/1/1:

\[ \text{proc}_1d \ a \ e \]

will process the current 1D dataset and store the plot in the files
\[ \text{email}_\text{exam1d}_1H_1_1.pdf \text{ and email}_\text{exam1d}_1H_1_1.ps. \]

Please note the following:

- storing the plot in a file by using command line arguments is an additional action, i.e. the plot is also send to the printer.
- \[ e \] and \[ a \] are arguments to AU programs that contain the AUTOPLOT macro, whereas \[ -e \] and \[ -a \] are arguments to the \textit{autoplot} command.

### 7.6 Preventing an AU program from plotting

AU programs that contain macros for plotting can be prevented from plotting with the argument \textit{noplot}. This can be useful if you want to use a standard processing AU program for processing only. For example, the command:

\[ \text{proc}_1d \ noplot \]

processes the current 1D dataset but does not plot it.

In TOPSPIN 2.0 and newer, ICON-NMR can be configurated to plot data or not (see ICON-NMR Configuration ’ Master Switches ’ Processing Control).

### 7.7 Setting the target printer

By default, the \textit{autoplot} command uses the printer defined in the layout or, if this does not exist, the system default printer. You can, however, override this with the printer defined by the parameter CURPLOT by using the -
c argument. In AU programs, you can do that with the following statements:

STOREPAR("CURPLOT", "<printername>");
CPR_exec("autoplot -c", WAIT_TERM);

Just use these two statements in your AU program instead of the AUTOPLOT macro.

7.8 Printing individually scaled integral regions (plotx)

TOPSPIN supports printing individually scaled integral regions. This task is performed by the `plotx` command. Each integral region is plotted as a separate 1D Spectrum object. Regions with relatively small peaks are scaled up, with the intensity scaling factor, e.g. x5 or x10, being specified at the lower right of the object (see Figure 7.2).

Figure 7.2

The axis scaling (Hz/cm) is the same for each integral region (object) and

1) Similar to the `plotx` command in TOPSPIN’s predecessor XWIN-NMR.
can be set by the user. The output can be shown in the Plot Editor interface or can be send to the printer. `plotx` requires prior integration (command `int`) and peak picking (command `pp`).

The command `plotx` takes up to four arguments:

```
plotx [<axes scaling>] [auto] [A3] [nointegrals]
```

where:

- `<axes scaling>` is the X-axis scaling factor (default 100 Hz/cm)
- `auto` is a flag indicating to send the output to the printer rather than to the Plot Editor interface.
- `A3` is a flag indicating to use A3 format rather than A4.
- `nointegrals` is a flag to prevent integral labels and trails to be printed.

Here are some examples:

```
plotx
plots each integral region with 100 Hz/cm showing the output in the plot editor interface.

plotx 50
plots each integral region with 50 Hz/cm showing the output in the plot editor interface.

plotx auto
plots each integral region with 100 Hz/cm sending the output to the printer.

plotx 200 auto A3 nointegrals
plots each integral region with 200 Hz/cm sending the output, without integral trails/labels, in A3 format to the printer.

Depending on the number and width of the integral regions, one or more sheets (layouts) are required. Without the `auto` argument, `plotx` opens the Plot Editor showing all layouts. The output depends on your operating system. Under Windows, all layouts are shown, cascaded, in the same Plot Editor window (see Figure 7.3). You can change the window arrangement from the `Window` menu. Under Linux, the different layouts are shown in
separate Plot Editor windows.

`plotx` is actually an AU program. If you are familiar with AU programming, you can modify it to your specific needs. Just enter `edau plotx`, make your changes and store it under a different name.

![Image of separate Plot Editor windows.]

**Figure 7.3**

### 7.9 Creating layouts from AU programs

TOPSPIN 2.0 and newer supports automated layout creation. It allows you to create a plot layouts with an AU program. Various AU macros can be used to create layout objects, i.e. Title, Parameters, 1D spectrum, NMR Text, etc. In the following exercise, we'll write an AU program for creating a simple plot layout and show the result.

**Exercise 25**

1. Open the 1D dataset exam1d_1H/1/1.
2. Enter `edau my_au_layout1`
3. In the appearing editor, enter the following lines:
#include <inc/layout_package>
LAYOUT_FORMAT my_format = LAYOUT_FORMAT_DEFAULTS;
LAYOUT_OBJ_1D my_obj = LAYOUT_1D_DEFAULTS;
LAYOUT_BEGIN_FILE("c:\temp\plot.xwp", my_format);
LAYOUT_ADD_1D_OBJECT(my_obj);
LAYOUT_END_FILE;
QUIT

4. Save and close the editor.
5. Enter `my_au_layout1`
6. Enter `plot -r C:\TEMP\plot.xwp`

The result is shown in Figure 7.4.

Figure 7.4

A list of layout creation AU macros can be found in paragraph 7.3. Note that they all start with LAYOUT_. Detailed information on automatic layout creation and more example AU programs can be found under Help ’ Docs ’.
Programming manuals ’ Plot Layout Programming.
Chapter 8

Reset Actions

8.1 What are Reset Actions

Reset actions are a set of rules, which control the appearance of individual \textit{Spectrum} or \textit{FID} objects, by either using or overruling experiment parameters. They influence:

- the X and Y limits of the displayed region
- the intensity scaling
- the spectrum and integral baseline positions

\textbf{Reset actions are object specific and stored in the layout.}

Reset actions are mainly used in automation to ensure proper plot regions and intensity scaling. They are automatically performed by the command \texttt{autoplot} which is used for plotting in ICON-NMR automation and AU programs. Reset actions can, however, also be applied in interactive plotting by opening the Plot Editor with \texttt{plot -r}.

Reset actions only apply to the NMR objects which hold spectral data, i.e. 1D spectra, 2D Spectra, FID and Stacked Spectra. For all other NMR
objects as well as Standard objects, Reset Actions do not exist (the \texttt{-r} argument has no effect).

### 8.2 Reset actions on 1D spectra

Reset actions play an important role in plotting 1D spectra in automation. They are mainly used to control the plot region and intensity scaling. Let's have a closer look at this in the following exercise.

**Exercise 26**

1. Open dataset exam1d_1H/1/1.
2. Enter \texttt{layout} on the command line. In the appearing dialog, select the standard layout 1D_H.xwp (if it is not already selected).
3. Enter \texttt{plot} to open the Plot Editor interface.
4. Right-click in the \textit{Spectrum} object and choose \textit{Automation} from the popup (see Figure 8.1)

![Figure 8.1](image)

This will open the dialog shown in Figure 8.2.
Reset Actions

It shows all possible Reset actions for the X and Y limits, the intensity scaling and the baseline positions.

*Figure 8.2*

The nature of the Reset Actions are explained below. Let's first make some changes and look at the effect.

5. Change any Reset Actions you like and click *OK* to store them.
6. Right-click in the object and choose *Reset Object* from the popup.
menu (see Figure 8.1) to see the effect of the changes. Depending on what you changed, the plot region, intensity scaling or baseline positions will be adjusted.

Now let’s see how this works.

**Reset Action for the X dimension**

*Don’t change*
No reset action. Keep the X-limits defined in the layout. Useful for, e.g., PROTON spectra with fixed plot limits (e.g. 9 - (-1) ppm).

*Set to minimum/maximum*
Set the X-limits to the minimum /maximum chemical shift, i.e. plot the entire spectrum. Useful for, e.g., heteronuclear spectra with very different plot areas (13C, 15N, ...).

*Set to F1P/F2P*
Set the X-limits to the processing parameters F1P/F2P, i.e. the plot the region displayed in the TOPSPIN data window. Useful for, e.g., automation (F1P/F2P is set in the AU program) or interactive plotting (F1P/F2P is set in the TOPSPIN interface).

**Reset Action for the Y dimension**

*Don’t change*
No reset action. Keep the Y-limits defined in the layout. Useful for, e.g., kinetic experiments (absolute intensity mode).

*Set to minimum/maximum*
Set the Y-limits to the minimum /maximum intensity, i.e. the scaling reference peak is the highest peak in the entire spectrum. Useful for, e.g., DEPT spectra.

*Set to minimum/maximum between Xmin/Xmax*
Set the Y-limits to the minimum /maximum intensity between Xmin/Xmax, i.e. the scaling reference peak is the highest peak in the region defined by the Reset action for the X-direction. Useful for, e.g., automatic plots of small spectral regions.

**Use region file on reset**
Checkbutton to enable/disable the usage of a region file for determining the scaling reference peak.
Reset Actions

- **intrng**
  Use the integral ranges file intrng\(^1\), created by *abs* or interactive integration. Useful for, e.g., interactive plot setup.

- **reg**
  Use the integral ranges file reg\(^1\), created by interactive integration. Useful for, e.g., interactive plot setup.

- **Defined by sreglst**
  Use the scaling regions file \(^2\) defined by the parameter SREGLST. Useful for, e.g., automation to exclude the solvent peak.

**After reset, size of biggest peak (scaling reference peak) is:**

- **% of plot size:** set to use the entire Y-dimension. Useful for, e.g., automatic plot of, e.g. NOEDIFF spectra or for plotting small signals.

- **abs value in cm:** enter the absolute value

- **defined by parameter CY:** set to the value of the parameter CY

**After reset, size of biggest integral is:**

- **abs value in cm:** enter the absolute value

**Base lines**

- **Keep zero line fixed on:** keep the spectrum baseline fixed on the specified percentage of the object bounding box

- **Keep integrals fixed on:** keep the integral baselines fixed on the specified percentage of the object bounding box

The effect Xmin/Xmax and Ymin/Ymax reset action can be seen in the graphical object as the displayed region. The exact limits can be seen in the Object editor. Let’s have a look at these:

7. Right-click in the object and choose *Edit*. The displayed limits are shown in the **Plot** section under the **Graph** pane (see Figure 8.3).

---

1) To see this file: right-click in the TOPSPIN data window and choose *Files*..

2) To see this file, enter **edlist scl** and click the list defined by the parameter SREGLIST.
Exercise 27

1. Open the 1D dataset exam1d_1H/1/1.

2. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.

3. Enter `layout` on the command line. In the appearing dialog, select the standard layout 1D_H+zoom.xwp.

4. Enter `plot`

The layout will contain two `Spectrum` objects with the same spectral region (see Figure 8.4).
Obviously this does not make much sense. So we'll do this again using the Reset Actions.

5. Click *File*’ *Exit* to leave the Plot Editor.

6. Enter `plot -r` to start the Plot Editor with Reset Actions.

Now the layout will show one Spectrum object with the full spectrum and one with the selected region, which is the purpose of this layout (see Figure 8.5).

Note that the Reset Actions are defined in the layout, for each individual object. They can be viewed/set from the Plot Editor interface.

7. Right-click in the lower *Spectrum* object and choose *Automation* from the popup. This will open a dialog showing the Reset Actions of this object. The upper part of this dialog shows the Reset actions for the plot region Xmin/Xmax (see Figure 8.5). Note that for this object it is set to minimum/maximum, i.e. the full spectrum. Click *OK* to close the dialog.
8. Repeat step 7 for the upper *Spectrum* object and note that the Reset Actions for Xmin/Xmax are set to F1P/F2P, i.e. to the zoomed region. Click *OK* to close the dialog.

9. Click *File → Exit* to leave the Plot Editor.

10. Enter *autoplot*

Since *autoplot* performs the Reset Actions, the output will look the same as the output of *plot -r*.

Let’s take another example of using Reset Actions.

**Exercise 28**

1. Open the 1D dataset exam1d_1H/1/1.

2. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.

3. Enter *layout* on the command line. In the appearing dialog, select the standard layout 1D_H.xwp.

4. Enter *plot -r*

5. Right-click in *Spectrum* object and choose *Automation* from the popup. This will open a dialog showing the Reset Actions of this object. Note
that the selected reset action for Ymin/Ymax is *Set to minimum/maximum between Xmin/Xmax*. As such, the scaling reference peak is the highest peak in the plotted region (see the upper part of Figure 8.6).

6. In the *Automation* dialog:
   a) Change the **Reset action for Ymin/Ymax** to *Set to minimum/maximum*
   b) Click **OK**

7. Right-click in *Spectrum* object and choose **Reset Object**.

   See how the Y expansion has changed according to the new settings of Ymin/Ymax. The scaling reference peak is now the highest peak in
the entire spectrum (see the lower part of Figure 8.6).

8. Click *File > Exit* to close the Plot Editor interface. Do not save the layout.

The above example just shows the use of Reset Actions for X and Y expansion. However, Reset Actions are also used for the use of region files, scaling of the biggest peak and position of the spectrum and integral baseline.

### 8.3 Performing Reset actions

Reset actions are usually performed automatically when spectra are plotted during ICON-NMR Automation. They can, however also be performed from the TOPSPIN command line or from the Plot Editor interface.

#### 8.3.1 Reset actions in automation

In automation, plotting is performed by one of the AU macros:

- AUTOPlot
- AUTOPlot_TO_FILE
- AUTOPlot_WITH_PORTFOLIO
- AUTOPlot_WITH_PORTFOLIO_TO_FILE

These macros all execute the command *autoplot*, which automatically performs Reset Actions on all *Spectrum* objects of the current layout. A such, plotting in automation is always performed with Reset Actions.

#### 8.3.2 Reset actions from the command line

Plotting from the command line can be performed with the commands *prnt, plot* and *autoplot*. The command *prnt* simply prints the data window. It does not use a layout, and as such, performs no Reset Actions. For *plot* and *autoplot* it depends on the arguments if Reset Actions are done or not.

Here is what happens:

- *prnt* - no layout involved, so no Reset Actions
- *autoplot* - Reset Actions on all objects of the layout


8.3.3 Reset Actions from the Plot Editor

Reset actions can be performed interactively from the Plot Editor. This is typically used to test the effect of certain Reset Actions, before saving a layout. They can be performed on individual objects or a group of objects.

To perform Reset Actions on one Spectrum object:

+ Right-click in the Spectrum object and choose Reset Object

To perform Reset Actions on all Spectrum objects:

+ Click Edit ’ Reset all objects

To perform Reset Actions on multiple Spectrum objects:

1. Mark the Spectrum objects.
2. Click Edit ’ Reset Marked objects [Ctrl+t]

To get the current dataset and perform Reset Actions on all Spectrum objects:

+ Click TOPSPIN ’ Get Current Data Set + Reset

To get the current dataset, perform Reset Actions on all Spectrum objects and print:

+ Click TOPSPIN ’ Get Current Data Set + Reset + Print

8.4 Reset actions on stacked plots

Reset actions on Stacked Plots are basically the same as on 1D spectra. They apply on all spectra displayed in the stacked plot. Since these spectra may differ in sweep width and/or chemical shift offset, the following rules:

For Reset Action for X = Set to minimum/maximum

- The X-limits are set such that the full sweep width of each spectrum is displayed.
• The reference peak for intensity scaling is the highest peak in all of the spectra.

For **Reset Action for X = Set to F1P/F2P** and **Reset Action for Y is Set to minimum/maximum between Xmax/Xmin**

• The X-limits are set to the values of F1P/F2P of the first spectrum
• The reference peak for intensity scaling is the highest peak in the first spectrum.

The following examples demonstrate this.

**Example 1**

A stacked plot of the following two spectra:

- Spectrum 1: 100 - 50 ppm
- Spectrum 2: 80 - 0 ppm

The highest peak is found in spectrum 2, at 30 ppm.

The **Automation Reset Actions** are set as follows

- **Reset Action for X = Set to minimum/maximum**
- **Reset Action for Y = Set to minimum/maximum between Xmin/Xmax**

**Size of biggest peak is 10 cm**

After Reset, the Stacked Plot object will show:

• The X-axis will run from 100 - 0 ppm
• The Y-axis is such that the peak at 30 ppm in spectrum 2 will be 10 cm

**Example 2**

A stacked plot of the following two spectra:

- Spectrum 1: 100 - 50 ppm, F1P = 95 ppm, F2P = 55 ppm
- Spectrum 2: 80 - 0 ppm, F1P = 35 ppm, F2P = -5 ppm

The highest peak is found in spectrum 2, at 30 ppm. Spectrum 1 contains a somewhat smaller peak at 70 ppm.

The **Automation Reset Actions** are set as follows
Reset Action for X = Set to F1P/F2P

Reset Action for Y = Set to minimum/maximum between Xmin/ Xmax

Size of biggest peak is 10 cm

After Reset, the Stacked Plot object will show:

• The X-axis will run from 95 - 55 ppm
• The Y-axis is such that the peak at 70 ppm in spectrum 1 will be 10 cm

8.5 Reset actions on 2D spectra

Reset actions on 2D spectra are basically the same as on 1D spectra. The difference is that both X and Y limits refer to the spectral regions in the respective directions. The 1D Y-limits and intensity Reset Actions are now used for projections. They can be set separately for the top, bottom, left and right projection. Figure 8.7 shows the default Reset Actions for the layout 2D_inv.xwp, which is the layout of several standard Inverse experiments.
8.6 Reset actions on FIDs

Reset actions on FIDs are basically the same as on 1D spectra, except that the X-limits cannot be set to F1P/F2P and there are no Reset Actions for intensity scaling. Figure 8.8 shows the default FID Reset Actions.
8.7 Reset actions on T1/T2 objects

Limited reset actions can be performed on T1/T2 objects. They only set the X- and Y-limits to Minimum/Maximum. Note that in this case the reset actions can be executed but not set (choosing Automation from the right-click popup menu has no effect).
Before plotting interactively with the Plot Editor, data must be prepared to meet the plot requirement. This includes data processing, integration, etc., as well as defining a plot title and a plot layout. Note that peak picking is automatically performed during Plot Editor startup. In ICON-NMR automation, all information is defined in the Experiments and all preparatory steps are performed automatically.

9.1 1D data

9.1.1 Processing the data

If the current dataset only contains raw data, please use TOPSPIN processing commands like ftf, ef, apk etc. to create processed data. Then use the commands plot or autoplot to print the data.

9.1.2 Defining the plot region

If you want to plot a certain spectral region rather than the full spectrum, you have to define the plot region first. To do that:

+ Click-hold in the data window, drag the cursor line along the desired region and release the mouse.
Note that the command `plot` will not only use the displayed region but also store it in the parameters F1P/F2P.

### 9.1.3 Setting the plot title

In order to show the plot title on the plot, it must be set first. To do that:

+ Enter `edti` on the command line

  or

+ Click the `Title` tab of the data window

enter the plot title and save it by clicking the `title` button. The title is saved in the file `title` in the current processed data directory (PROCNO). The title will appear on the plot if the defined layout contains a Title object. This is the case for most Bruker standard layouts.

### 9.1.4 Defining integrals

Integral traces and integral labels can be plotted as part of an NMR Spectrum object. However, before you can do that, integral ranges must have been determined. If the integrals are displayed in the TOPSPIN data window, this is obviously the case. If they are not displayed, they might not have been determined or they might be selected in the display options (right-click in the data window and choose `Display Options`, to find out).

If the integral ranges have not been determined, do the following:

+ Enter `abs` on the command line for automatic integration

  or

+ Click the `Integral` button for interactive integration

Even if integral ranges have been determined, the will only appear on the plot if they are defined in the plot layout, i.e. if they are enabled in the 1D spectrum object properties (see Figure 5.11). Note that for some Bruker layouts (e.g. 1D_H.xwp) this is the case, whereas for others (e.g.1D_H+noint+ppp.xwp), it is not.
9.1.5 Defining the plot layout

The Plot Editor layout is defined by the parameter LAYOUT. To define the layout, you must set the parameter LAYOUT as follows:

+ Enter \texttt{layout} on the command line

\textit{or}

+ Click the \textit{Procpars} tab and click the \textit{Automation} section

Note that standard 1D layouts names start with 1D, e.g. 1D_H.xwp and 1D_X+int.xwp. If the parameter LAYOUT is not set, the command \texttt{plot} will still work taking the default layout (\textit{Plot1}). \texttt{autoplot}, however, will give an error message if no layout is set.

9.1.6 Plotting the data

After performing the above steps, you are ready to plot the data using the commands \texttt{plot} or \texttt{autoplot}.

Note that if preparatory steps have not been done, plotting will still work but some graphical objects of parts of them might be missing.

9.2 2D data

9.2.1 Processing data

If the current dataset only contains raw data, please use TOPSPIN processing commands like \texttt{ftf}, \texttt{xfb} etc. to create processed data.

9.2.2 Defining the plot layout

Define the layout to be used by setting the parameter LAYOUT. To do that, enter \texttt{layout} on the command line, click the \textit{Procpars} tab. Note that standard 2D layout names start with 2D, e.g. 2D_hom.xwp and 2D_inv.xwp.

9.2.3 Setting the Plot Title

To set the plot title, enter \texttt{edti} on the command line or click the \textit{Title} tab of the data window, enter the plot title and save it by clicking the click the \begin{itemize}
\item[\textbullet] button. See the also paragraph 9.1.3).
9.2.4 Defining projections

To define the projections of a 2D dataset do the following:

1. Click the toolbar button to display the projections (if these are not displayed yet).

2. Right-click in the data window, inside the F1-projection area, choose *External Projection* from the popup and specify the dataset `exam1d_1H/1/1` as external projection. Repeat this action for the F2-projection area.

3. Note that projections must be defined as external datasets. Plot Editor does not display/print internal projections.

9.2.5 Setting the Contour levels

Plot Editor uses the contour levels shown in the data window.

To set the contour levels:

+ Click the button: or enter `edlev` on the command line and set the levels in the appearing dialog.

*or*

+ Click one of the buttons `z`, `f` etc., or press `Alt+PageUp/PageDown`

To store the contour levels:

+ Click the button of the toolbar.

9.2.6 Plotting the data

After performing the above steps, you are ready to plot the data using the commands `plot` or `autoplot`.

Note that if preparatory steps have not been done, plotting will still work but some graphical objects of parts of them might be missing.
Chapter 10
Import/Export Graphics

PLOT EDITOR supports full import and export of graphics. Graphics import into the Plot Editor can be performed in form of EMF files (Windows) or EPSI files (Linux). Graphics can be exported to graphics formats such as EMF, PS, PNG etc. and to the Clipboard. Export can be performed interactively from the Plot Editor interface or, automatically, from the command line or from an AU program.

10.1 Importing graphics

Under Windows, Plot Editor can import graphics in two formats:
- WMF: Windows Metafile format
- EMF: Enhanced Metafile Format

Both formats are scalable without loss of quality.

Under Linux, Plot Editor can import graphics in:
- EPSI: Encapsulated Postscript Interchange format

Import is performed by creating an object containing an imported graphical file or an object with a reference to an external graphics file.
10.1.1 Importing object external graphics

To do that, you have to create a metafile object and connect it to a graphics file. The following exercise demonstrates how to do this.

Exercise 29

1. Start TOPSPIN and open any 1D or 2D dataset.
2. Enter `plot`. The Plot Editor interface will appear.
3. Click the radio button `Standard` at the left of the Plot Editor window.
4. Click the following icon:
   
   ![Meta](image)
   
   Place the cursor in the layout area at the desired position. Click-hold at that position and move the mouse to draw the metafile object.

5. Right-click in the metafile object and choose `Edit` from the popup menu.
6. In the appearing dialog (see Figure 10.1):
   a) Click the `Browse` button.
   b) Select or enter the desired graphics file in the appearing dialog.
   c) Click `OK` to import the graphics and close the dialog.
7. Click `File` > `Save` to store the layout.

Note that the saved layout contains a reference to the graphics file, not the file itself. If you want to use this layout, the graphics file must exist, otherwise the metafile object will be empty.
Instead of browsing for the graphics file (see Figure 10.1), you can also specify the pathname in one of the following ways:

- Specify absolute pathname, e.g.:
  
  C:/TEMP/my_graphics.emf

- Use the ~ character for the user home directory, e.g.:

  ~/graphics/my_graphics.emf

- Use the + character for the dataset PROCNO, e.g.:

  +/my_graphics.emf

Possible problems

The graphics file might include an entire page whereas the actual graphical
object is only a small part of it (see Figure 10.2).

This problem can sometimes be solved as follows:

1. Right-click in the object and choose *Edit* from the popup menu.
2. In the appearing dialog, disable the entry:

   *Always resize graphics to fit in boundaries*

### 10.1.2 Importing object internal graphics

In order to create a layout internal graphics object, you have to copy it from the clipboard. The following exercise demonstrates how to do this.

**Exercise 30**

1. Copy a graphical object from any application to the clipboard. In most applications you can do that by selecting the graphics and pressing *Ctrl+c*.
2. Start TOPSPIN and open any 1D or 2D dataset.
3. Enter `plot`. The Plot Editor interface will appear.

4. Click `Edit` > `Paste` `[Ctrl]+v` to paste the graphics from the clipboard.

5. Click-hold in the graphics object and move the mouse to put it at the desired position.

6. Right-click in the graphics object and choose `Edit` from the popup menu. Note that the graphics (metafile) data are now part of the layout file and will be saved with it (see Figure 10.3). Click `Cancel` to close the dialog.

7. Click `File` > `Save` and store the layout.

10.1.3 Importing text

Just like graphics, text can be imported from a file or from the clipboard.

Importing text from a file

To import text from a text file to a plot layout, you can use the `NMR Text` object. The following exercise shows how to do that.
**Exercise 31**

1. Start TOPSPIN and open any 1D or 2D dataset.
2. Enter `plot`. The Plot Editor interface will appear.
3. Click the icon:
   - and click at the desired position in the layout area to create the text object.
4. Right-click in the text object and choose *Edit* from the popup dialog.
5. In the *Edit* dialog (see Figure 10.4):
   a) Select the *NMR Text* tab
   b) Click the button *Browse*
   c) Select or enter the desired text file in the appearing dialog and click *Open*.
   d) Click *OK* to load the text file and close the *Edit* dialog.

![Figure 10.4](Image.png)
Importing text from the clipboard

To import text from the clipboard, just copy a piece of text from any file or application with `Ctrl+c`. Then paste it to the Plot Editor with `Ctrl+v`. The text will appear in a new text object, which you can then move, resize, edit like any other text object, e.g. the `NMR` object `Title` (see paragraph 5.8.2).

10.2 Exporting Graphics under Windows

`PLOT EDITOR` allows you to export the layout area to various graphics formats like EMF, PS, PDF and PNG as well as copy it to the Clipboard. Exported files can be imported by other applications. Note that EMF files contain high quality graphics but often appear distorted when they are imported in Microsoft applications like Word and Powerpoint. PNG is usually a good choice for these applications. Copying to the Clipboard allows you to copy single objects as opposed to the entire layout area.

PNG format is highly recommended for exporting Plot Editor graphics

PDF can be used to print the graphics on computers on which Plot Editor is not installed.

10.2.1 Exporting a plot from the Plot Editor interface

A plot layout can be viewed, created or modified and then exported from the Plot Editor interface. The following exercise shows how to do that.

Exercise 32

1. Start `TOPSPIN` and open any 1D or 2D dataset.
2. Enter `layout` on the command line. In the appearing dialog, select a suitable layout.
3. Enter `plot`. The Plot Editor interface will appear, showing the chosen layout.
4. Click `File ’ Export`
5. Select or enter the name and type of the export file in the appearing
dialog (see Figure 10.5) and click *Save*.

<table>
<thead>
<tr>
<th>Enhanced Metafile (*.emf)</th>
<th>Postscript File (*.ps)</th>
<th>Acrobat PDF (*.pdf)</th>
<th>JPEG (*.jpg)</th>
<th>PCX mono (*.pcx)</th>
<th>PCX 24 bit color (*.pcx)</th>
<th>Portable Network Graphics (*.png)</th>
<th>TIFF uncompressed (*.tif)</th>
<th>TIFF packed (*.tif)</th>
</tr>
</thead>
</table>

**Figure 10.5**

6. Select or enter the sampling rate in the appearing dialog (see Figure 10.6) \(^1\) and click *OK*.

![File Export](image)

**Figure 10.6**

The default sampling rate is 360.

### 10.2.2 Exporting graphics from the command line

As an alternative to exporting a plot from the Plot Editor interface, you can do this from the TOPSPIN command line with the command `autoplot` using the `-e` option.

**Exercise 33**

1. Start TOPSPIN and open any 1D or 2D dataset.
2. Enter *layout* on the command line. In the appearing dialog, select a suitable layout.

---

\(^1\) For the EMF format, you cannot set the sampling rate, i.e. this dialog does not appear.
3. Enter `autoplot -e C:\TEMP\my_plot.png -x 600` to export the plot to a PNG file with a resolution of 600 dpi.

4. Open the file `my_plot.png` from the Windows Explorer or Linux File Manager to see the exported plot.

Note that the format of the graphics output file is determined by the file extension, which can be `.png`, `.emf`, `.pdf` etc. (see also Figure 10.5).

### 10.2.3 Exporting graphics from an AU program

As an alternative to exporting a plot from the Plot Editor interface or from the TOPSPIN command line, you can do this from an AU program with the `AUTOPLOT_TO_FILE` macro.

**Exercise 34**

1. Start TOPSPIN and open any 1D or 2D dataset.
2. Enter `layout` on the command line. In the appearing dialog, select a suitable layout.
3. Enter `edau my_export_au`
   
   In the appearing editor, enter:
   ```
   AUTOPLOT_TO_FILE("C:/TEMP/my_plot.pdf")
   QUIT
   ```
4. Close the editor saving the AU program.
5. Enter `my_export_au` to execute the AU program.
6. Open the file `my_plot.PDF` from the Windows Explorer or Linux File Manager to see the exported plot.

### 10.2.4 Copying to the Clipboard

**PLOT EDITOR** fully supports the Windows clipboard for graphics and text. Any number of objects in the Plot Editor layout can be copied to the Clipboard and than pasted into other layouts or other applications. Copy & paste via the clipboard is faster and more flexible than exporting and importing the entire layout area.

---

1) Note that the extension indicating the export format must be in lowercase letters
To copy one object to the Clipboard:
   + Right-click the object and choose *Copy*

To copy all objects to the Clipboard:
   1. Press `Ctrl+a`
   2. Click *Edit ’ Copy* or press `Ctrl+c`

Similarly you can copy marked objects to the Clipboard by cutting then from the Plot Editor:
   + Click *Edit ’ Cut* or press `Ctrl+x`

Once you have *copied* or *cut* objects to the clipboard, you can *paste* them:
   • to other PLOT EDITOR layouts
   • to any other applications like Word, Powerpoint etc.

Note that a marked *Text* object, e.g. a *Title* or *Parameters* object, is copied to the clipboard as graphics. In order to copy the object contents as text only, you have to:
   1. Right-click in the *Text* object and choose *Edit* from the popup menu.
   2. Click the *Edit* button in the appearing dialog.
   3. Mark the text in the appearing dialog.
   4. Right-click and choose *Copy* from the popup menu or press `Ctrl+c`.

### 10.2.5 Copying from the Clipboard

Graphics and text can be copied from the Clipboard to the PLOT EDITOR as follows:
   + Click *Edit ’ Paste* or press `Ctrl+v`

If the Clipboard contains a graphics, a Metafile object (under Windows) or EPSI object (Linux) is created. Just click-hold in the object and move the mouse to move the object to the desired position in the layout. Double-click the object to edit its properties.

Note that under Linux, there is no global Clipboard for all application.
10.2.6 Sending a plot by email

Plot Editor allows you to send the current plot graphics by Email.

To do that:

1. Click *File > Send*

   Your default Email program will popup showing a new empty message with your plot added as a EMF file attachment.

2. Just fill out the recipient’s email address, a subject and body text and sent the email.

To enable Email support, you must have installed a *Simple MAPI Client* on your system. This can be:

- *Windows Messaging* package that is provided as part of the Windows setup
- *Outlook Express* which is part of *Microsoft Internet Explorer*. Please note that here the *Simple MAPI Client* functionality must be explicitly enabled in the applications options.
- Any other Email program. Please refer to the related product documentation.

10.2.7 Export formats

Plot layouts can be exported in the following formats:

- **EMF and PS**
  Enhanced Metafile (EMF) and Postscript (EPSI/PS) are vector graphics. They can be rescaled without loss of quality. However, not all graphics applications are able to handle the complex Postscript and/or Metafile structures correctly, which may result in display errors.

- **PDF**
  Acrobat PDF format. Viewers for PDF (like *Acrobat Reader*) are freely available for many different platforms. PDF files are, internally, based on Postscript and can be rescaled without loss of quality.

- **PNG**
  Bitmap (pixel) graphics. Allows excellent, lossless compression.

1) See [www.adobe.com](http://www.adobe.com).
gray pixel, A4 plot: 42 kB). Excellent scaling/rendering in Microsoft Office applications. It can be displayed by word processing and drawing programs, as well as web browsers like *Internet Explorer*, *Mozilla*, and *Konqueror*.

- **PCX, TIFF**
  Bitmap (pixel) graphics. PCX and TIFF support lossless compression.

- **JPEG**
  Bitmap (pixel) graphics. JPEG compression is lossy, creating smaller files.
Chapter 11
Plot Editor under Linux

On a Linux computer, Plot Editor is basically the same as under Windows. Datasets, portfolios and plot layouts are interchangeable between the two platforms. Nevertheless, there are some differences as described in this chapter.

11.1 The menu Window does not exist

Under Linux, Plot Editor can contain one layout window only. As such, the Window menu for arranging layout windows does not exist. Multiple layouts under Linux can still be displayed by opening multiple Plot Editor windows.

11.2 Edit dialogs under Linux

Under Linux, some Plot Editor dialogs differ from the Windows based dialogs shown in this document. Where the dialogs under Windows have Tabs to show different parts of the dialog (see for example Figure 5.10), under Linux all parts of the dialog are shown simultaneously (see Figure 11.1 and internally).
Figure 11.1 Upper part of Edit dialog
11.3 Global Setup

Under Linux, the Global Setup dialog, which can be opened from the Options menu, shows three extra check buttons to show/hide the Status Line, Toolbar and Tips on Startup (see Figure 11.3).
11.4 Printer Setup

Whereas under Windows Plot Editor can simply use the printer(s) installed in the Operating System, under Linux the target printer must be setup once from the Plot Editor.

To setup the printer you have to take the following steps:

1. Click *Options > Printer Setup*
   
The Printer Setup dialog will appear (see Figure 11.4)

2. Check/select the values of the following three settings:
   
   - Printer Type : *PostScript*
   - Print Command : *lpr %s*
   - Preview Command : *gv %s*
These are Bruker defined default values, which are usually correct and configure the system default printer to be used as output device.

3. Set the *Paper Size*, *Offsets* and *Output format* to the desired values.

4. Click *OK*.

Note that the commands `plot -c` and `autoplot -c`, internally extend the print command to `lpr -P <printernname> %s`, where `<printernname>` is the printer defined by the parameter CURPLOT.

Note that you can save the current values as the Default Setup as follows:

+ In the *Printer Setup* dialog: click *File* > *Save As Default*

The next time you open the *Printer Setup* dialog, the user defined defaults will appear, instead of the Bruker defined.
Figure 11.4 Print Setup dialog
11.5 Standard EPSI object

Whereas under Windows, Plot Editor allows you to import Meta file graphics (EMF or WMF), under Linux EPSI format is supported. You can import an EPSI file as follows:

1. Click the radio button **Standard** at the left of the Plot Editor interface
2. Click the **EPSI** icon:
   ![EPSI icon](image)
   and place the cursor at the desired position of the layout area.

3. Double-click the **EPSI** object, click the **Select** button in the section **EPSI Image** of appearing dialog (see Figure 11.5), select the desired EPSI file (usually files with the extension `.eps` or `.epsi`) and click **OK**.

![Edit Display Object dialog](image)

Figure 11.5
11.6 Miscellaneous

Apart from the difference in dialogs and setups there are a few minor aspects to be considered under Linux.

- The right-click popup menu might not work if the NumLock key on your keyboard is activated. Press the NumLock key to deactivate it.
Part III
Questions and Answers
12.1 Questions about the Plot Interface

How do I set the object marker size?
1. Click *Option ‘ Global Setup*
2. Move the slider *Marker* in the dialog *Global Preferences*
3. Click *OK*.

How do I set the Expansion and Offset of the Alt-Expand function?
1. Click *Option ‘ Global Setup*
2. Enter a value in the field *Blowup Expansion*.
3. Enter a value in the field *Blowup Offset*.
4. Click *OK*.

How do I align objects exactly?
1. Click *Option ‘ Layout Setup*
2. Select the desired *Snap-In* distance, e.g. to 0.5 cm, in the appearing
dialog.
3. Click **OK**.

New objects can only be placed to fixed grid positions which allows you to exactly align them. When the **Snap-In** distance is set to **none**, you can smoothly move objects to any position in the layout.

To align existing objects:
1. Double-click in the first object.
2. Click the **Basic** tab.
3. Enter the exact x- and y-position.
4. Repeat step 1 to 3 for each object.

**How do I add integrals and integral labels to a 1D spectrum?**
1. Right-click the *Spectrum* object and choose **1D/2D-Edit** from the popup menu.
2. Enable the entry **Integrals** in the middle of the dialog.
3. Click **Close**.

**How do I add peak labels to a 1D spectrum?**
1. Right-click the *Spectrum* object and choose **1D/2D-Edit** from the popup menu.
2. Enable the entry **Peaks** in the middle of the dialog.
3. Click **Close**.

**How do I save a layout to the dataset PROCNO?**
1. Click **File ’ Save Layout/Portfolio to Dataset**.
2. Select or enter the filename in the **Save** dialog.
3. Click **Save**

**How do I set the number and distance of X and Y Axis Ticks?**
1. Right-click in the *Spectrum* object and choose **Axis Tick Settings**.. from the popup menu.
2. In the appearing dialog:

![Axis Tick Settings](image)

**Figure 12.1**

- a) Click one of the radio buttons *Calculate axis ticks automatically* or *Fixed Settings*.
- b) If you chose *Fixed Settings*: enter the Distance for the axis labels, the # of minor ticks and the # of decimals, for both the X- and Y-axis.
- c) Click *OK* to save the changes and close the dialog.

**How do I print scaling info (ppm/cm and Hz/cm) below the X-axis?**

1. Double-click in the spectrum object.
2. Click the *1D Spectrum* tab.
3. Enable the entry *Show scaling information for X-axis*.
4. Click *OK*

**How do I insert a list (e.g. peak picking or integration results) on a plot, in addition to the title?**

1. Click the *NMR Text* icon and click inside the layout area (to place the NMR Text object).
2. Double-click in the NMR Text object.
3. Click the *NMR Text* tab in the dialog.
4. Enter the pathname of the list file. Usually the file resides in the dataset PROCNO. You can do that by specifying the full dataset
pathname or using the abbreviation +/filename. Alternatively, you can browse for the list file.

5. Click **OK**

**How do I put my company logo on the plot?**

Bruker layouts have the Bruker logo in the upper right corner. You can easily replace this by your own company logo.

1. Enter `layout` on the command line. In the appearing dialog, select the desired layout.
2. Enter `plot` to open the Plot Editor interface.
3. Double-click in the logo object.
4. In the appearing dialog:
5. Click the **Browse** button.
6. Select or enter your company logo graphics file in the appearing dialog.
7. Click **OK** to import the file and close the dialog.
8. Click `File` `Save` and store the layout for later usage, in a directory different from `<tshome>/plot/layouts`.
9. Press `Ctrl+p` to plot the spectrum.

**How do I use the same layouts on all computers, laboratory-wide?**

1. Store your plot layouts on a network folder (Windows share, or NFS-mounted Linux directory).
2. Click **Options` Preferences**.
3. In the appearing **User Preferences** dialog:
   a) Click **Directory Path Names** in the left part of the dialog.
   b) Click the **Change** button for the item **Global search path for plot layouts**.
   c) Enter the Administrator password as requested.
   d) Enter the network folder in the appearing dialog.
   e) Click **OK** to close the dialog.
Questions and Answers

f) Click OK to close the User Preferences dialog.

Step 2 and 3 must be performed on each computer on which you want to plot. After doing that, plot and autoplot will use the layouts in the network folder rather than the layouts of the local TOPSPIN installation.

How do I use my own layouts with Bruker experiments?

1. Modify Bruker layouts or create your own new layouts and save them in a layout directory (different from <tshome>/plot/layouts).
2. Add the new layout directory, to the layout search path (see step 2 and 3 in paragraph).

Now plot and autoplot will use the layouts in the new layout directory rather than the layouts in <tshome>/plot/layouts.

How do I modify the plotx command to my needs?

The command plotx is actually an AU program which can be modified.

1. In the TOPSPIN window, enter edau plotx.
2. Make any modifications. See also paragraph 7.8 and the manuals AU Programming and Plot Layout Programming.
3. Save and compile.

How do I select the parameters that must be listed on the plot?

1. In the TOPSPIN window, enter parplot.
2. Select Acquisition Parameters or Processing Parameters.
3. Move all parameters to be listed to the column Show and all other parameters to the column Hide.
4. Click OK.

Any plot created by plot, autoplot or ICON-NMR will show the selected parameters. For more information enter help parplot.

How do I switch the Startup and Toolbar Tips on/off under Linux?

1. Click Options ’ Global Setup
2. Enable/disable the respective checkboxes.
How do I, under Linux, override the printer defined in the layout?

As under Windows, you can do that by using the commands `plot -c` and `autoplot -c` (or by enabling the respective item in the `print` dialog).

With the `-c` argument, `plot` and `autoplot`, internally convert the print command 1) from:

```
lpr %s
```

into

```
lpr -P <printername> %s -P printername
```

where `<printername>` is the value of the parameter CURPLOT

This works on all CUPS enabled Linux systems (which is the default) because they typically use `lpr %s` as a print command. If your system does not use the `lpr` semantic, please consider using a shell script that extracts the "-P printername" information and translates it to a format you need.

How do I generate multiple plots per dataset in automation?

1. In `IconNmr Configuration`: Go to User Settings - User defined parameters and append the parameter `layout`.

2. In `IconNmr Automation`: For each experiment, set the parameter `layout` to the desired layouts, separated by semi-columns, e.g.:

```
+/1D_H.xwp;+/1D_H+int.xwp
```

Alternatively, you can set the processing parameter LAYOUT to the desired values.

12.2 Questions about plot procedures

How do I position a spectrum at the bottom of the window?

1. Right-click the `Spectrum` object and choose `Automation` from the

1) As set with `Options ’ Printer Setup`
popup menu

2. In the Automation dialog:
   a) Enable **Keep zero line fixed on**
   b) Enter the exact relative position of the spectrum baseline, in the field **% of the box**, e.g. 4.55.
   c) Click **OK** to close the dialog

3. Right-click the **Spectrum** object and choose **Reset Object** from the popup menu.

4. Click **File ’ Save as...** to save the layout for later usage.

**How do I position a spectrum in the middle of the window?**

1. Right-click the spectrum object and choose **Automation** from the popup menu

2. In the Automation dialog:
   a) Enable **Keep zero line fixed on**
   b) Enter the exact relative position of the spectrum baseline, in the field **% of the box**, e.g. 50.
   c) Click **OK** to close the dialog

3. Right-click the spectrum and choose **Reset Object** from the popup menu.

4. Click **File ’ Save as...** to save the layout for later usage.

**How do I plot the entire spectrum**

1. Start **TOPSPIN** and open the dataset to be plotted.

2. Click the button to display the full spectrum

3. Enter **layout** on the command line. In the appearing dialog, select the desired plot layout.

4. Enter **plot**. The Plot Editor interface will appear, showing the layout defined by the parameter LAYOUT. The **Spectrum** object will show the entire spectrum.

5. Click **File ’ Print** to print the spectrum.

Alternatives:
• Enter `prnt`, instead of step 3, 4 and 5, to print the data window as you see it on the screen, without using a plot layout.

• Enter `autoplot -f`, instead of step 4 and 5, to directly send the output to the printer rather than view it first.

• After step 4, right-click the `Spectrum` object in the Plot Editor interface, choose `1D/2D-Edit`, and click the icon:

and click `Close`, to display the entire spectrum. Then do step 5.

How do I plot a certain spectral region.

1. Start TOPSPIN and open the dataset to be plotted.
2. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.
3. Enter `layout` on the command line. In the appearing dialog, select the desired plot layout.
4. Enter `plot`. The Plot Editor interface will appear, showing the layout defined by the parameter LAYOUT. The `Spectrum` object will show the entire spectrum.
5. Click `File Print` to print the spectrum.

Alternatives:

• Enter `prnt`, instead of step 3, 4 and 5, to print the data window as you see it on the screen, without using a plot layout.

• Enter `autoplot -f`, instead of step 4 and 5, to directly send the output to the printer rather than view it first.

• After step 4, right-click the `Spectrum` object in the Plot Editor interface, choose `Edit`, and enter the exact Xmin/Xmax values in the Edit dialog. Then do step 5.

How do I create a Stacked Plot ?

1. Start TOPSPIN and open first dataset of the series of spectra to be plotted.
2. Enter `plot`. The Plot Editor interface will appear, showing the data-
set according to the layout 1D_H.xwp.

3. Select a certain spectral region. To do that, click-hold in the data window and drag the cursor line along the desired region.

4. Click the `Stacked Plot` icon:

   ![Stacked Plot icon](image)

   Place the cursor in the layout area at the desired position. Click-hold and move the mouse to draw the `Stacked Plot` object and release the mouse.

5. Click the `Data` button of the command bar to open the Data Set selector.

6. Click `Edit` in the Data Set Selector dialog to open the Portfolio Editor.

7. In the Portfolio Editor:
   a) Select the additional datasets to be included in the Stacked plot. For each dataset, click the `Append` button to add it to the Portfolio list.
   b) Click `Apply` to load the Portfolio list to the Data Set Selector.

8. Click `OK` to close the Data Set Selector.

9. Right-click the `Stacked Plot` object and choose `Edit` from the popup menu.

10. In the appearing dialog:
   a) Click the `Stacked` tab.
   b) Enter the number of spectra
   c) Enter the horizontal and vertical offset or accept the default values.
   d) If you want the white washed effect (only foreground curves visible), enable the respective `White Washed` checkbox.
   e) Click `OK`.

Note that the White Washed checkbox defines a one time *action on OK*. It is always disabled on opening the edit dialog. To undo the white washed effect, you must do the following.

1. Right-click in the `Stacked Plot` object.
2. Click the `Attributes` button in the `Curve` section.
3. In the appearing dialog, click the `Default` button, then click `OK`.
Note that the standard AU program `stack1d` automatically creates a stacked plot of a series of 1D spectra in consecutive EXPNO’s or PROC-NO’s. For a description of Automation Reset Actions on Stacked Plots, see paragraph 8.4.

**How do I print individually scaled integral regions?**

TOPSPIN supports printing individually scaled integral regions. To do that:

1. Determine the integral regions, automatically with `abs` or interactively.
2. Enter `plotx <scaling factor>`
   
   where scaling factor is the x-axis scaling factor (default 200).

See also paragraph 7.8

**How do I show the full spectrum after Expand?**

1. Right-click in the *Spectrum* object and choose *1D/2D-Edit*.
2. In the appearing dialog, click the following icon:

![Icon](image)

3. Click *Close* to close the dialog

**How do I show the digital signature on the plot without the parameters?**

1. Create a *Parameters* object in the layout area (if it is does not yet exist)
2. Double-click the Parameters object.
3. In the appearing dialog:
   a) Disable the item: *Allow automatic font resize*
   b) Click the *Parameter* tab
   c) Enable the item *Include electronic signature information*
   d) Click *OK*.
4. Resize the object such that only the area of the digital signature is
When I export a spectrum to PDF and zoom in Acrobat Reader the peak lines are coarse and details missing! How do I solve this problem?

PDF files are exported with a default data sampling rate of 360 dpi which is suitable for printing. To see more details you have to increase the export sampling rate.

Automated printing:

1. Enter `autoplot -x <sampling rate> -e <filename>.pdf`
   
   e.g. `autoplot -x 1200 -e my_data.pdf`

Interactive printing:

1. Enter `plot`
2. In the Plot Editor interface:
   a) Click *File ’ Export*
   b) Select or enter file name and the file type PDF in the appearing dialog.
   c) Click *Save*.
   d) Select or enter a sampling rate larger than 360 in the appearing dialog.
   e) Click *OK*.

Note that the file size will increase with increasing sampling rate.

How do I dynamically create plot layouts during automation?

TOPSPIN 2.0 and newer support automated layout creation. You can create AU programs for fully dynamic layout creation using the `edau` command and the AU macros LAYOUT_xxx. (see paragraph 7.3 and 7.9). For a full description of automated layout creations see Topspin *Help ’ Manuals ’ Programming manuals ’ Plot Layout Programming*.

How do I force a 1D Spectrum object to use specific ppm/cm?

1. Right-click in the *Spectrum* object and choose *1D/2D-Edit* from the
popup menu.

2. In the appearing dialog:
   a) Select \textit{ppm} and enter the desired value in the field \textit{per cm}
   b) Click \textit{Use Values}, then click \textit{Close}.

How do I avoid a large (signal) peak to be used for scaling?

Large solvent peaks

For large solvent peaks, there is a standard procedure which is used in most Bruker standard experiments/layouts. To use in your own experiments/layouts do the following:

1. In the TOPSPIN interface, enter \texttt{sreglst} to set the parameter SREGLST. Select the region file, according to the nucleus and solvent used in the experiment. \footnote{Regions file can be edited or new ones created with the command \texttt{edlist scl}.}

2. Enter \texttt{plot} to open the Plot Editor interface.

3. Right-click in the Spectrum object and choose \textit{Automation}.

4. In the Automation dialog:
   a) Enable \textit{Use region file on reset}.
   b) Select \textit{Defined by SREGLST}
   c) Click \textit{OK}

5. Right-click in the Spectrum object and choose \textit{Reset Object} to see the effect.

6. Click \textit{File ’ Print} to plot the spectrum.

7. Click \textit{File ’ Save} to save the layout for later usage.

To use this in automation, read your experiment (parameter set) with \texttt{rpar}, set the parameters SREGLST and LAYOUT to the desired region file and to layout, respectively and store the experiment with \texttt{wpar}. Do this for the experiments to be used in automation.

Large non-solvent peaks

1. In TOPSPIN, enter \texttt{.int} to open the interactive integration mode.
2. Click  to select and then  to delete all integrals.  

3. Click  and define two large integrals, one to the left and one to the right of the large peak, covering the regions to be considered in scaling.

4. Click  and choose *Save Regions To 'reg'*. 

5. Click  to leave integration mode without save.

6. Enter *plot* to open the Plot Editor interface.

7. Right-click in the Spectrum object and choose *Automation*.

8. In the Automation dialog:
   a) Enable *Use region file on reset*.
   b) Select *reg*
   c) Click *OK*

9. Right-click in the Spectrum object and choose *Reset Object* to see the effect.

10. Click *File ’Print* to plot the spectrum.

11. Click *File ’Save* to save the layout for later usage.

---

1) Integrals are only deleted on the display, not on disk.
Chapter 13
Appendix A

13.1 Shortcuts

Frequently used menu or toolbar commands can also be executed with shortcuts. This means the command is executed by pressing a certain key together with a modifier key like Ctrl or Shift or Alt.
<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc</td>
<td>Switch to selection mode</td>
</tr>
<tr>
<td>F1</td>
<td>Open the Plot Editor Manual</td>
</tr>
<tr>
<td>F5</td>
<td>Refresh</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Close the Plot Editor interface</td>
</tr>
<tr>
<td>Ctrl+Shift+F6</td>
<td>Display previous layout</td>
</tr>
<tr>
<td>Ctrl+tab</td>
<td>Display next layout</td>
</tr>
<tr>
<td>delete</td>
<td>Delete the marked objects</td>
</tr>
<tr>
<td>Ctrl+a</td>
<td>Mark all objects</td>
</tr>
<tr>
<td>Ctrl+c</td>
<td>Copy the marked object(s) to the Clipboard</td>
</tr>
<tr>
<td>Ctrl+g</td>
<td>Group the marked objects</td>
</tr>
<tr>
<td>Ctrl+Shift+g</td>
<td>Ungroup the marked object(s)</td>
</tr>
<tr>
<td>Ctrl+i</td>
<td>Open TOPSPIN Command Interface</td>
</tr>
<tr>
<td>Ctrl+l</td>
<td>Lower the marked object(s)</td>
</tr>
<tr>
<td>Ctrl+m</td>
<td>Unmark all objects</td>
</tr>
<tr>
<td>Ctrl+n</td>
<td>Open a new layout</td>
</tr>
<tr>
<td>Ctrl+o</td>
<td>Open an existing layout</td>
</tr>
<tr>
<td>Ctrl+p</td>
<td>Print the current layout</td>
</tr>
<tr>
<td>Ctrl+q</td>
<td>Close the Plot Editor interface (Linux only)</td>
</tr>
<tr>
<td>Ctrl+r</td>
<td>Raise the marked object(s)</td>
</tr>
<tr>
<td>Ctrl+s</td>
<td>Save the current layout</td>
</tr>
<tr>
<td>Ctrl+t</td>
<td>Reset X and Y scaling of the marked objects</td>
</tr>
<tr>
<td>Ctrl+v</td>
<td>Paste the object from the Clipboard</td>
</tr>
<tr>
<td>Ctrl+w</td>
<td>Open the attributes dialog window</td>
</tr>
<tr>
<td>Ctrl+x</td>
<td>Cut the marked object and place it on the Clipboard</td>
</tr>
<tr>
<td>Ctrl+z</td>
<td>Undo the last action</td>
</tr>
</tbody>
</table>

Note that shortcuts might not work when keys like **Num Lock**, **Scroll Lock** or **Caps Lock** are pressed.
14.1 Plot command list

TOPSPIN offers various plot related commands, all of which are discussed in this document. Here is a short list of plot related commands and their functions.

*print [Ctrl+p]*

Open the print dialog, from which you can set various options and start the commands `prnt`, `plot` or `autoplot`.

*prnt*

Print the current dataset as you see it on the screen

*plot*

Open the Plot Editor for viewing, modifying, creating and printing plot layouts.

*autoplot*

Print data according to a Plot Editor layout.

*parplot*
Specify the acquisition and processing parameters that must be listed on the plot.

**plotx**

Print individually scaled integral regions, sending the output to the Plot Editor or to the printer (AU program).

**stack1d**

Create a stack plot of a series of 1D spectra in consecutive EXPNO’s or PROCNO’s (AU program).

### 14.2 Command line arguments for plot

**plot**

Starts the Plot Editor using the same plot limits and intensity scaling (parameter CY) as the TOPSPIN data window.

**plot -c**

Override the plotter in the layout by the plotter defined by the parameter CURPLOT.

**plot -r**

Starts the Plot Editor while performing the Reset Actions for setting the plot limits and intensity scaling of individual *Spectrum* objects.

**plot -n**

Starts the Plot Editor with the plot limits and intensity scaling as it is defined in the layout for each *Spectrum* object. Limits and intensity are not adjusted to the current dataset, nor are Reset Actions performed.

**plot <layout>**

Starts the Plot Editor with the specified layout, e.g. *plot 1D_h+pp.xwp*.

**plot <layout1> <layout2>**

Starts the Plot Editor showing the current dataset in two separate layouts; <layout1> and <layout2>.

**plot -p <portfolio>**
Starts the Plot Editor with the specified portfolio, e.g.:

```
plot C:\pf\mypf.port
```

The Plot Editor can also be started from the Print dialog, which shows the most important print options.

### 14.3 Command line arguments for autoplot

Although command `autoplot` is normally used in automation, in form of the macro AUTOPLLOT, it can be used from the TOPSPIN command line.

- uses the layout defined by the processing parameter LAYOUT
- uses the limits and intensity scaling of TOPSPIN current dataset window performing the Reset Actions
- uses the portfolio defined in the file `portfolio.por` in the current dataset procno, or, if this does not exist, the default portfolio.

`autoplot` supports a number of command line arguments, which can be used e.g. when writing sophisticated AU programs.

- `autoplot -c`
  - Print the data on the plotter defined by the parameter CURPLOT, overriding the plotter in the layout.

- `autoplot -f`
  - Do not perform the Reset Actions.

- `autoplot -n`
  - Use limits and scaling as defined in the layout. Ignore the current dataset limits and scaling. Do not perform Reset Actions.

- `autoplot -e <output_name>.ps`
  - Create e.g. a Postscript file instead of printer output. Use the `-?` argument to see a complete list of supported file formats.

- `autoplot -s setup.prt`
  - Use printer setup file `setup.prt` instead of the printer setup that was saved with the layout (not available in Windows version). A printer setup file can be created from the Plot Editor interface with `[Options]` `Printer Set-`
Autoplot also supports a number of portfolio related command line arguments:

- `autoplot -p portfolio.por`
  Loads the portfolio file `portfolio.por`
- `autoplot -a portfolio.por`
  Like `-p`, but appends to the portfolio instead of overwriting its contents
- `autoplot -d /u/data/...`
  Adds dataset `/u/data/...` to the portfolio
- `autoplot -r /u/data/...`
  Removes dataset `/u/data/...` from the portfolio
- `autoplot -sa`
  Sorts portfolio in ascending order
- `autoplot -sd`
  Sorts portfolio in descending order

`autoplot` can take multiple portfolio arguments. For example:

```
autoplot -p myportfolio.por -sa -r C:/bio/data/guest/nmr/demospect/1/pdata/1
```

plots the data in `myportfolio.por`, except for dataset demospect/1/1, in ascending order. Note that the arguments are evaluated left to right and
their order in which they are specified matters.

### 14.3.2 Other options

- `autoplot -v` Show `autoplot` version number
- `autoplot -h` Show help text
- `autoplot -?` Same as `-h`
- `autoplot --` Explicit end of options. Use this option before specifying a layout file that has a `-` as its first letter.

### 14.4 Parameters used for plotting

**TOPSPIN** defines a large number of acquisition and processing parameters. The processing parameters which are used in relation to plotting are described below.

**LAYOUT** - Plot Editor layout
- takes a filename as value, by convention with the extension `.xwp`
- interpreted by `plot`, `autoplot` and ICON-NMR plotting
- can be set by entering `layout` or `print` or by clicking `Procpars`

**CURPLOT** - target printer
- takes an installed printer as a value
- interpreted by `plot`, `autoplot` and ICON-NMR plotting
- can be set by entering `curplot` or `print` or by clicking `Procpars`

**AUNMP** - the AU program to be used for automated processing and plotting
- takes an AU program name as value
- interpreted by `xaup` and ICON-NMR processing and plotting
- can be set by entering `aunmp` or by clicking `Procpars`

**F1P/F2P** - low/high field limit of the plot region in ppm
- takes a float value (ppm)
- interpreted by `plot -r` and `autoplot` (reset actions)
• set by `plot` and `autoplot -f` (no reset actions)
• can also be set by entering `f1p/f2p` or by clicking `Procpars`

CY - height of the reference peak
• takes a float value (cm)
• interpreted by `plot` and `autoplot -f` (no reset actions)
• interpreted by `plot -r` and `autoplot` if the reset action: **Size of biggest peak** = defined by parameter CY
• can be set by entering `cy` or by clicking `Procpars`

SREGLST - region file used for determining the scaling reference peak
• takes a filename as value, typically `nucleus.solvent`
• interpreted by `plot -r` and `autoplot` if the reset action **Use region file on Reset** = defined by SREGLST
• can be set by entering `sreglst` or by clicking `Procpars`
Index

**Numerics**

1D Spectrum icon 28
1D+1D+1D.xwp layout 48
1D+1D+pp.xwp layout 48
1D/2D-Edit button 58
1D/2D-Edit dialog 66
1D_H.xwp layout 47
2D plot 29
2D projections tab 30
2D_hom.xwp layout 31, 48
2D_inv.xwp layout 48

circle object 29
Clipping window 91
color flow 100, 101
command bar 45, 53, 57
contour levels 29, 31, 99, 100, 170
conventions 10
create
dataset 55, 56, 59, 96, 97
layout 27
object 92
Create Color Flow button 101
crosshair cursor 22
Ctrl key 56, 91, 207
Ctrl+p key 27
Ctrl-n key 59
Ctrl-o key 59
Ctrl-p key 59
Ctrl-s key 59
Ctrl-z key 58
CURPLOT parameter 16, 41, 69, 145, 213
cut object 67
CY parameter 35, 47, 136, 155, 210, 214

**A**

Alt key 56, 91, 207
apk command 167
APKS macro 35
Attributes button 54, 58, 67, 93
au_zg AU program 136
AUNM parameter 136
aunmp command 34
AUNMP parameter 34, 135, 136, 213
automatic font resize 109
Automation menu 38
autoplot command 14, 15, 16, 34, 35, 39, 83, 138, 209, 211
AUTOPlot macro 34, 35, 39
AUTOPlot_TO_FILE macro 41, 179
axis ticks 122, 194, 195

**B**

baseline offsets 36
baseline position 35, 47, 121
Basic tab 26
blowup 64, 193

**C**

Character Map 110
Circle icon 29
Duplicate 68
duplicate object 68, 87

**E**
edau command 35, 39, 136, 203
edc2 command 32, 48, 51, 83
Edit button 58, 101
Edit dialog 66
Edit Directory List 80
edlev command 170
edlist command 204
edp command 46
edti command 168, 169
ef command 167
EF macro 35
electronic signature 112
EPSI 40, 171, 175
esign command 112
Expand icon 24, 31
expansion 36, 47
expansion mode 24
export graphics 39
External Projection 29, 170

**F**
F1P parameter 35, 47, 136, 154, 158, 162, 168, 213
F2P parameter 35, 47, 136, 154, 158, 162, 168, 213
ftf command 167, 169
Full button 56, 58

**G**
Get Values 98
global setup 185, 193, 197
Graph tab 25
Group button 58, 89
group objects 89

**H**
hotpoint 111

**I**
Icon-nmr 34, 35, 111, 125, 129, 135, 136, 138,
141, 144, 151, 160, 167
import graphics 39
intensity scaling 36, 47
Interface 45

**L**
LAYOUT 15
layout area 24, 27, 40, 45, 52, 53, 54, 130, 134,
177, 179
layout command 15, 46
layout definition 45
LAYOUT parameter 15, 28, 34, 46, 47, 123, 125,
126, 136, 138, 140, 141, 169, 199, 200,
211, 213
lower object 68, 91

**M**
mark object 23, 85
menubar 45
Mode field 24
modify a layout 22
move object 23, 88
multiple display 17

**N**
nm command 32
NMR radio button 28, 92, 130
number of decimals 105, 106

**O**
object
definition 46
object-oriented 45
open data 59
overview spectrum 17

**P**
Paper Orientation 16
Paper Size 16
Parameters icon 28
parplot command 197, 209
paste object 67
plot area origin 27
plot command 14, 19, 35, 45, 46, 52, 209
Plot Editor
startup 46
plotx AU program 210
plotx command 145, 146, 197
portfolio 16, 33, 34, 46, 48, 49, 60, 61, 73, 78, 79, 82, 83, 130, 140, 143, 211, 212
default 48
definition 46
Portfolio Editor 33, 48, 49, 73, 75, 78, 81, 107, 201
portfolio.por file 82, 83, 130, 211, 212
portfolios 32
Postscript 211
preview a plot 20
print command 16, 209
printer setup 186
print command 13, 16, 19, 160, 209
proc_1d AU program 34, 39, 136, 141
proc_2dinv AU program 39
proc_2dsym AU program 136
Procpars tab 46
projd command 48, 50, 83
projections 29, 30, 31, 49, 50, 99, 114, 116, 163, 170

Q
Quickstart 13

R
raise object 68, 90
Reference part 43
reset actions 35, 121
reset object 68
Reset Object menu 38
resize object 23
Rotate button 58, 90
rotate object 68, 90
rpar command 138

S
Save
layout 33
save
attributes 95
data 59
directory list 79
layout 27, 29, 31, 59, 61, 129, 130, 132, 138, 175, 194, 196, 208
portfolio 48, 79
printer setup 187
screenshots 9
search path 35, 124, 125, 138, 139, 196, 197
second dataset 48
select
axes 24
grids 24
integrals 24
peaks 24
Shift key 56, 57, 91, 207
Shift modifier key 86
shortcuts 207
signal peak 204
special characters 110
SREGLST parameter 204, 214
stack1d AU program 82, 202, 210
stacked plot 80
Standard radio button 28, 92, 131, 172, 189
status line 32, 35, 45, 53, 68, 75, 76, 78, 185

T
Text tab selected 26
third dataset 48
Title icon 28
toolbar 45, 53, 59
tools area 53

U
Undo button 24, 58, 91
undo last operation 24
Ungroup button 58, 90
ungroup objects 89
Use Values 98
User Preferences 125, 138, 196

W
wrp command 32, 142
WYSIWYG 45

X
xfb command 169
Xmin/Xmax field 26
Z
Zoom 53
Zoom icon 24
Zoom in button 53
Zoom out button 53, 58

Numerics
1D Spectrum icon 34
1D_H.xwp layout 55
1D/2D-Edit button 66
1D/2D-Edit dialog 74
1D+1D+1D.xwp layout 56
1D+1D+pp.xwp layout 56
2D plot 35
2D projections tab 37
2D_hom.xwp layout 37, 56
2D_inv.xwp layout 56

contour levels 35, 38, 107, 108, 178
conventions 10
create
dataset 63, 64, 67, 104, 105
layout 34
object 100
Create Color Flow button 109
crosshair cursor 29
Ctrl key 64, 99, 215
Ctrl+p key 33
Ctrl-n key 67
Ctrl-o key 67
Ctrl-p key 67
Ctrl-s key 67
Ctrl-z key 66
CURPLOT parameter 16, 48, 77, 152, 221
cut object 75
CY parameter 43, 55, 144, 163, 218, 222

A
Alt key 64, 99, 215
apk command 175
APKS macro 41
Attributes button 62, 66, 75, 101
au_zg AU program 144
AUNM parameter 144
auunmp command 41
AUNMP parameter 41, 143, 144, 221
automatic font resize 117
Automation menu 45
autoplot command 14, 15, 16, 40, 41, 43, 46, 91, 146, 217, 219
AUTOPLOT macro 40, 41, 43, 46
AUTOPLOT_TO_FILE macro 48, 187
axis ticks 130, 202, 203

data set handling 79, 80
Data Set Selector 37, 38, 39, 54, 56, 58, 59, 62, 66, 81, 83, 85, 86, 87, 88, 89, 91, 110, 115, 124, 125, 126, 138
Data Set selector 209
Data Set tab 33
dataset
components 19
definition 54
decimals 113, 114
Delete button 30, 66, 95
Delete key 30, 76, 95
delete object 30, 76
directory list 88
Duplicate 76
duplicate object 76, 95

E
edau command 41, 46, 144, 211
edc2 command 38, 56, 59, 91
Edit button 66, 109
Edit dialog 74
Edit Directory List 88
edlev command 178
edlist command 212
edp command 54
edti command 176, 177
ef command 175
EF macro 41
electronic signature 120
EPSI 47, 179, 183
esign command 120
Expand icon 30, 37
expansion 43, 55
expansion mode 30
export graphics 46
External Projection 35, 178

F
F1P parameter 43, 55, 144, 162, 166, 170, 176, 221
F2P parameter 43, 55, 144, 162, 166, 170, 176, 221
Figure 2.4 24
Figure 2.5 25
ftf command 175, 177
Full button 64, 66

G
Get Values 106
global setup 193, 201, 205
Graph tab 31
Group button 66, 97
group objects 97

H
hotpoint 119

I
Icon-nmr 40, 41, 119, 133, 137, 143, 144, 146, 149, 152, 159, 168, 175
import graphics 46
intensity scaling 43, 55
Interface 53

L
LAYOUT 15
layout area 30, 34, 47, 53, 60, 61, 62, 138, 142, 185, 187
layout command 15, 54
layout definition 53
LAYOUT parameter 15, 34, 41, 54, 55, 131, 133, 134, 144, 146, 148, 149, 177, 207, 208, 219, 221
lower object 76, 99

M
mark object 29, 93
menubar 53
Mode field 30
modify a layout 28
move object 29, 96
multiple display 17

N
nm command 38
NMR radio button 34, 100, 138
number of decimals 113, 114

O
object
definition 54
object-oriented 53
open data 67
overview spectrum 17

P
Paper Orientation 16
Paper Size 16
Parameters icon 34
parplot command 205, 217
paste object 75
plot area origin 33
plot command 14, 19, 43, 53, 54, 60, 217
Plot Editor
startup 54
plotx AU program 218
plotx command 153, 154, 205
portfolio 16, 39, 40, 54, 56, 57, 68, 69, 81, 86, 87, 90, 91, 138, 148, 151, 219, 220
default 56
definition 54
Portfolio Editor 39, 56, 57, 81, 83, 86, 89, 115, 209
portfolio.por file 90, 91, 138, 219, 220
portfolios 38
Postscript 219
preview a plot 26
print command 16, 217
printer setup 194
print command 13, 14, 16, 19, 168, 217
proc_1d AU program 40, 41, 46, 144, 149
proc_2dinv AU program 46
proc_2dsym AU program 144
Procpars tab 54
projd command 56, 58, 91
projections 35, 37, 57, 58, 107, 122, 124, 171, 178

Q
Quickstart 13

R
raise object 76, 98
Reference part 51
reset actions 43, 129
reset object 76
Reset Object menu 45
resize object 29
Rotate button 66, 98
rotate object 76, 98
rpar command 146

S
Save
    layout 39
save
    attributes 103
    data 67
    directory list 87
    layout 33, 35, 38, 67, 69, 137, 138, 140, 146, 183, 202, 204, 216
    portfolio 56, 87
    printer setup 195
screenshots 9
search path 41, 132, 133, 146, 147, 204, 205
second dataset 56
select
    axes 30
    grids 30
    integrals 30
    peaks 30
    Shift key 64, 65, 99, 215
    Shift modifier key 94
    shortcuts 215
    signal peak 212
    special characters 118
    SREGLST parameter 212, 222
    stack1d AU program 90, 210, 218
    stacked plot 88
    Standard radio button 35, 100, 139, 180, 197
    status line 39, 41, 53, 61, 76, 83, 84, 86, 193

T
Text tab selected 32
third dataset 56
Title icon 34
toolbar 53, 61, 67
tools area 61

U
Undo button 30, 66, 99
undo last operation 30
Ungroup button 66, 98
ungroup objects 97
Use Values 106
User Preferences 133, 146, 204

W
wrt command 38, 150
WYSIWYG 53

X
xfb command 177
Xmin/Xmax field 32

Z
Zoom 61
Zoom icon 30
Zoom in button 61
Zoom out button 61, 66